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Introduction

Activity-based learning

This book is full of activities for you to do, as well as information for 
you to read. 

These activities will help you learn to find out more information for 
yourself.

Do all the activities. They are the most important part of this book.

Research
Since you have to find out information for yourself, many activities 
in this book calls you to do research using books in the library, the 
internet and other sources such as newspapers and magazines. 

Icons
To guide you, each activity in the book is marked by a symbol or icon 
to show you what kind of activity it is. The icons are as follows:

Fieldwork Activity

Fieldwork icon
Fieldwork means learning outside the classroom 
either in the school compound, the local area or in the 
learner’s home area. It is suitable since it engages the 
learner and makes him/her involved in the learning 
process. Fieldwork can be used in all subjects.

Discussion/Vocabulary Reading

Discussion icon
Some activities require you to discuss an issue with a 
partner or as part of a group. It is similar to group work, 
but usually does not require any writing, although some 
short notes can be written for remembrance.

Computer/Internet Activity

Computer/Internet Activity icon
Some activities require you to use a computer in your 
computer laboratory or elsewhere.
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Listening Activity

Listening Activity icon
The listening activity requires you to carefully listen to 
the teacher or your fellow learner reading a passage, 
poem or extraction on the subject and then answer the 
questions.

Observation Activity

Observation Activity icon
You are expected to observe and write down the results 
from activities including experiments or social settings 
overtime.

Practical Activity

Practical Activity icon 
The hand indicates a practical activity, such as a role 
play on resolving a conflict, taking part in a debate or 
following instructions on a map. These activities will 
help you to learn practical skills which you can use 
when you leave school.

Writing/Research Activity

Writing Activity icon
Some activities require you to write in your exercise 
book or elsewhere.
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Unit
11

Application and Utility Software 
Installation

Key Unit Competence

Understand the functions of operating system; install and use 
application and utility software.

Computer software is defined as a series of instructions that tell the 
computer hardware how to process data.

Computer software is sometimes called computer program. 

There are two main categories: system software and application 
software. Application, utility software and their installation can not 
work alone without operating system. 

1.1	 Operating system (OS)
Operating system is a large and powerful program that controls and 
manages computer hardware and application software. It is the most 
important computer program.

Operating system software runs and manages all the operations 
of the computer. All electronic devices use operating systems to 
work, for example; laptop computers, tablet, desktop computers, 
smartphone, router, etc.

The operating system that runs a laptop or desktop computer is 
commonly called Desktop Operati ng System (DOS). This includes; 
Microsoft Windows  (with versions like  Windows 10 and Windows 
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8,  MacOS (from Apple and is formerly OS X), Chrome OS (designed 
by Google) and Linux (e.g. Ubuntu, Fedora). 

Mobile operating system runs on smartphones, PDAs, Tablet PCs and 
other mobile devices. Examples include Android (manufactured by 
Google Inc.) and iOS (manufactured by Apple) etc.

Server operating system or server OS is installed and runs on servers 
e.g. web servers examples of server OS are: Windows Server, Linux, 
and FreeBSD (Free Berkeley Software Distribution). 

1.2	 Functions of operating system

User
Application 
Software Operating 

System

Computer 
Hardware

Figure 1.1: How instructions flow between operating system, hardware and 
applications.

When the user runs an application, the program sends requests 
to the operating system and the operating system commands the 
hardware to work as required by the user. Most of the work done 
by the operating system is hidden from the user, meaning the user 
does not need all the details going on but just sees the results.

1.	 Booting: The operating system is responsible for completing 
booting process of the computer. Booting is starting or restarting 
the computer. Cold boot starts the computer that has been 
turned off completely whereas warm boot restarts the computer’s 
operating system. 

2.	 The operating system provides an appropriate User interface. 
The interface enables the user to interact with the computer 
software and hardware. The user interface can be Command-line 
interface (CLI) or Graphical user interface (GUI). With CLI, the 
user interacts with OS by typing in commands at the command 
prompt to perform specific tasks. Examples include Disk operating 
system (DOS) such as MS.DOS (Microsoft Disk Operating System).
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C:\Users\S3>

Picture 1.1: Command Line Interface

	 With GUI, the user interacts with OS by using a mouse to access 
windows, icons and menus e.g. Microsoft Windows (8 or 10).

Picture 1.2: Graphical User Interface (with images or icons representing computer 
commands)

3.	 Operating system manages resource allocation to various 
programs. The operating system loads programs in computer’s 
primary memory, runs them and allocates them run-time, memory 
space, processor time, input/output devices and instructions to 
use. 

4.	 Memory management: The OS organises how the primary memory 
is used by different programs through partitioning. Partitioning is 
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the dividing of the primary memory to run different programs in 
different partitions or sections of the hard disk. When the size of 
the primary memory or RAM is not enough, the OS borrows a 
space from the hard disk and adds it to the primary memory or 
RAM. This memory is called Virtual memory or Virtual RAM. It 
enables the OS to run programs which require more memory than 
available RAM in the system, but it is much slower. 

5.	 Manages user’s files. The OS manipulates how files are created, 
stored and retrieved using file system. When you store a file on a 
disk, it is stored in pieces and when you open it, the OS organises 
those pieces together and opens your file. OS also handles tasks 
related to cutting, copying and deleting files and folders.

Note: File system is a method used by the operating system 
to name, store and organise files on a disk. For example 
Windows uses NTFS (New Technology File System).

Mac OS operating system uses a file system called HFS Plus 
or HFS+. HFS is written as Hierarchical File System. Linux 
has many file systems such as Ext 2, Ext 3, Ext 4, XFS, etc.

6.	 Operating system controls input/output peripherals. The 
operating system manages reading from the input peripheral 
devices and writing to all peripheral devices. It controls access 
to all peripherals through small programs called device drivers. 
A device driver is a program that controls how a specific device 
works with specific operating system. Examples are: Printer driver, 
network driver and graphics driver.

7.	 Operating system manages files: Operating System supervises 
the creation, storage, updating and deletion of files to various 
storage devices e.g. hard disk, flash disk, etc.

8.	 Operating system manages backup storage (secondary storage 
or auxiliary storage). Operating system locates and retrieves files 
needed by user from backup storage and monitors how they are 
used. 

9.	 Operating system manages security and access rights of 
computer users. In this case, the operating system monitors 
the creation of passwords, user names or account names on a 
computer. It also keeps record of who accesses the computer, 
the activities done and the resources used. In managing system 
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security, the operating system guarantees that resources are used 
only for programs and users with appropriate authorisation.

10.	 Operating system handles errors as they happen. When the 
computer is used, without user intervention or knowledge. It can 
suggest to the user what to do to correct errors through error 
messages.
There are several different types of operating systems and choice 
of which operating system to use depends mainly on; cost of 
buying the OS, hardware requirements to run the OS and user 
experience. The OS comes with two important components i.e. 
the Shell (which provide interface between the user and the 
operating system itself) and the Kernel (which provide interface 
between hardware and applications).  You can install OS using 
different options among which are; fresh installation (done on a 
new computer or if the existing OS is damaged and cannot work); 
multi-boot installation (done when you install two or more different 
copies of OS on different parts of hard disk) and upgrading (done 
when you replace old version of OS with a new copy of OS e.g. 
replacing windows 7 with windows 10). 

Activity 1.1

1.	 Explain briefly the meaning of ‘operating system’ in the computer 
system. 

2.	 Identify the operating system(s) that is installed in your school 
computers. 

3.	 Discuss any five functions performed by the operating system 
in a computer.

4.	 Give an example of operating system that can be installed on  
each of the following devices:
a)	 PDA
b)	 Laptop computer

5.	 With clear examples discuss the following terms in computer 
system:
a)	 File system
b)	 User interface
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1.3	 Types of license for software
A software license is a legally binding agreement that specifies the 
terms of use for a software. It also defines the rights of the software 
producer and that of the end-user.

There are two types of licenses for software:

	࿤ Open source software
	࿤ Proprietary software

1.3.1	 Open Source License (General Public License or 
GPL)

Open source software is a computer program in which the source 
code is available to the general public for use or modification from its 
original design and free of charge. 
Open source license is a license that allows the software to be freely 
used, modified and shared. This software license is widely used for 
free and guarantees end-users the freedom to run, study, share and 
modify software. 

1.3.2	 Proprietary license
Proprietary software is owned by an individual or company that 
developed it. The source code is kept almost secret, so you cannot 
modify it.

This means that the software is under restrictive copyright and the 
source code is hidden from users. Anybody cannot copy or change 
proprietary software unless permission is sought from owners. Most 
software today is proprietary.

Proprietary license is a software license in which the software 
publisher/owner grants a license to use one or more copies of software, 
but the ownership of those copies remains with the software publisher. 
The user must pay for the license before permission is given to use the 
software.
Note: Copyright refers to the legal right of the owner of intellectual 
property. It is the right to copy meaning that the original creators of the 
products and anyone they give authorisation to are the only ones with 
exclusive rights to reproduce t he work. 
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1.4 	 Download software 
Download software means the transfer/copy of a software through 
the Internet from the remote computer (server) to a local machine or 
computer.

Downloaded software installation files (executable files) are commonly 
used for program installations. 

Activity 1.2

Using a browser installed on your computer, download Google 
Chrome installation file from Internet onto your computer.
Step 1:	 Open your Browser on the computer.

Step 2:	 Use the search engine and type “download Google 
Chrome” installation file in the search book.

Google search box

URL bar

Picture 1.3: Browser window displaying Google Internet searching tool
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Step 3:	 Press Enter key (Return key) on your keyboard. Doing this 
will start the search for the specified item. After a short 
time, the search results display. Scroll to find the best 
result.

Picture 1.4: The browser displays search results

Step 4:	 Click the search result you think is best for you. This 
will take you to the items page. Now click “for Personal 
Computers” the result will be as shown in the picture 
below.

Download link

Picture 1.5: The page for the search item is displayed
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Step 5:	 Click the “Download Chrome” button. 

Note: If you download chrome, it automatically installs 
itself and so you may not see the downloaded file, but an 
already working program.

Always read through 
the terms of service or 
manufacturer’s manual 

for proper use

Picture 1.6: Download screen for Chrome

Step 6:	 Open your downloaded file(s). Do this by clicking on 
the file’s name bar at the bottom of the browser or by 
navigating to the computer’s default download location, 
which is a folder called “Downloads”.

Note: By default, all downloaded software and files are kept in the 
folder called Downloads on your computer from where they are 
transferred to another location of user’s choice.

Some programs take long to download and to install and others 
strictly require Internet connection to complete installation.
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Activity 1.3

Create a folder on your desktop using your first name and use it to 
save all the downloads.

Using installed browser, download the following software 
installation files.

a)	 Avast antivirus	 b)	 Mozilla Firefox 
c)	 VLC media player	 d)	 Adobe reader
e)	 Chess game	 f)	 Skype

1.5	 Installation of software
The term Software Installation means, the process of copying 
installation files of a given program onto hard disk in a format that 
allows the computer to run the program. It means putting a computer 
program on a computer and ready for use.

You should always read the manufacturer’s installation manual to 
correctly install programs. This manual describes all the procedures 
and the necessary system requirements for successful installation. 

System requirements for installing software
	࿤ Processor speed (the higher the speed the better)
	࿤ RAM size
	࿤ Hard disk space
	࿤ Graphics card

E.g. to install Windows 10, the minimum requirements usually include:

Processor	 1 Gigahertz (GHZ) or faster processor or SoC 
(System on Chip or integrated circuit known as a 
chip).

RAM 	 1 Gigabyte (GB) for 32–bit or 2GB for 64-bit

Hard disk space	 16GB for 32-bit OS or 20GB for 64-bit OS

Graphics Card	 DirectX 9 or later with WDDM (Windows Display 
Driver Model) 1.0 driver 

WDDM	 is a graphic driver architecture for video card 
drivers running Microsoft Windows. 
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1.5.1	 Installation of Operating system
Operating system is installed in a separate section of hard disk referred 
to as disk partition. The hard disk is usually divided into multiple 
sections and each section or partition can operate independently of 
the other. Dividing hard disk into partitions is called disk partitioning. 

Before you partition a disk, save or backup important files onto another 
disk because disk partitioning erases all the data on the disk and 
prepares it for new data using a particular file system such as FAT (File 
Allocation Table) or NTFS.

The hard disk is usually partitioned when installing operating system. 
To partition your hard disk, insert in the optical drive a bootable DVD 
containing a desired operating system e.g. Windows 8 or Windows 10.

Note: While installing the OS, determine the type of file system 
you should use. File system is a method used by Operating 
system to keep track of files stored on computer. File systems 
commonly used by operating systems include: FAT32 and NTFS. 
Modern operating systems such as Windows 10 mainly use NTFS 
(New Technology File System). Consider the type of file system 
best supported by OS or application software you want to use.

Since an Operating system has to take control of all other programs 
you will use, it must be installed first before other programs.

Activity 1.4

Provided with Windows 10 installation DVD or flash disk containing 
Windows 10 installation files, perform a fresh installation of 
Windows 10 on your computer.

Step 1:	 Backup all your data on an external storage device such 
as a flash drive or external hard drive. This is because 
clean installation deletes everything on your computer’s 
hard drive. 

Step 2:	 Start your computer and then connect the bootable USB 
flash drive or insert the bootable Windows 10 DVD on 
the PC where you want to install Windows 10.
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Step 3:	 Restart your PC, and then press any key to boot from the 
USB flash drive or the DVD. Press the key after seeing the 
message as shown below.

If you restart your PC and your current version of Windows 
starts, then open a boot menu or change the boot order 
in your computer’s BIOS or UEFI (Unified Extensible 
Firmware Interface) settings so that your computer boots 
from the media.

Note: To open a boot menu or change the boot 
order, press a combination of keys (such as F2, 
F8, F9, F10, F12, Delete, or Esc) as soon as you 
turn on your PC. However, the key (s) you press 
depends on the manufacturer of your computer’s 
motherboard and it is usually displayed immediately 
the computer starts. Check it out.

Once you get the boot menu, select the best boot order 
such as Optical disk drive then press enter key.

Step 4:	 On the first screen for Windows Setup, select your 
language, time, keyboard preferences and then click on 
Next button on lower right.
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Select desired 
options you want 

or just click  
Next

Picture 1.7: Windows setup (first screen) for Language selection

Step 5:	 In the next screen, click on “Install Now” to install 
Windows.

The new OS Windows 10 will start its installation. Make 
sure you don’t turn off your PC.

Picture 1.8: Windows setup (Screen two) to Start Installation
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Step 6:	 In the next screen, you will be asked to provide a 
25-character product key in the space provided. After 
entering it, click Next. However, if you don’t have a 
product key at the moment, click on Skip button so you 
will enter the product key later.

Step 7:	 The next screen is the License Agreement Window. If 
you have time, read through and then check the option 
labelled “I accept the License terms”. afterwards click 
Next button.

Picture 1.9: Windows setup (Screen three) for accepting license terms
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Step 8:	 In the next screen, you will see two options. To perform a 
clean installation, select Custom.

	
Picture 1.10: Windows setup (screen four) for selecting Installation type

Note: Custom is selected to make fresh installation.

Step 9:	 Select the drive on which to install Windows 10. You may 
need to format the drive for clean installation. Select the 
drive and click on Format at the bottom of the window. In 
case you have just installed a new hard disk, you need to 
create a new partition to install Windows.

To create a partition
•	 Select the hard drive and click on “New” button
•	 Allocate the space you want depending on the capacity 

of your hard disk.
•	 Click “Apply” to complete the process.

Note: The system additionally creates a partition 
with name “System Reserved” to ensure that the 
system works fine. Its size usually is 100MB.
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Picture 1.11: Windows Setup screen for partitioning a hard disk

Step 10:	Select partition where you want to install Windows 10 
and click Next button.

At this point, the installation of Windows will start. It 
will take about 25 minutes to complete the installation 
process.

During the installation, your system may reboot two or 
three times but don’t press any key, leave everything to 
work automatically.

Picture 1.12: Windows setup screen for installing windows
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Step 11:	Once the installation is completed, a blue colour screen 
displays.

Click on “Use Custom Settings” button if you want to go 
with default settings. You can also click on “Customize” 
button if you want to customise settings.

Picture 1.13: Windows setting screen

Follow on-screen instructions and a few minutes Windows 
10 will be ready for use.

Note: If you did not enter the 25 character windows key 
above, then go to Settings -> Update & Security -> 
Activation. Enter the key to activate the windows.

Picture 1.14: Windows screen for entering product key
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1.5.2	 Install Microsoft (MS) Office 2016 on selected 
computer(s)

Activity 1.5

You are provided with Office 2016 Installation DVD. Install this 
application on your computer. Follow the steps below.
Step 1:	 Obtain MS Office installation on a DVD, flash disk, 

external hard disk (or download Installation file from the 
Internet.)

Step 2:	 Insert the disc in the optical drive (e.g. DVD Drive)

The installation disc automatically launches setup 
wizard. (If the setup wizard doesn’t start automatically, 
open the disk drive or folder for Office 2016 and double-
click Setup file. See the picture below.

Double click Setup file to start 
installation

Picture 1.15: File Explorer (Windows Explorer) showing Microsoft Office 2016 
folder

When the setup file is double-clicked, it displays the 
Office screen as shown in Picture 1.16.



19

Application and Utility Software Installation

Remember:

To install application software successfully you must use 
an Administrator account, without which installation 
cannot take place. Other types of accounts such as 
standard or limited accounts and Guest accounts do not 
have the privilege to install or uninstall software.
If you normally use limited accounts for doing other 
practical activities, this time you should use an 
administrator account to install Microsoft Office 2016 
and other applications.

Picture 1.16: Office screen

After a short time, the Office installation screen appears 
to show the status of installation process as shown in 
picture 1.17.
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Picture 1.17: Office 2016 installation status

Step 3: Wait as Office installs to complete the installation process. 
Click Close after the installation is complete (see picture 
1.18).

Picture 1.18: Office complete installation screen



21

Application and Utility Software Installation

Step 4:	 Open an office application such as Word 2016. The 
message as shown in picture 1.20 may display on top of 
Office (Word) 2016 Open back stage screen. In case you 
purchased a licensed product, close it and will not show 
again, start using office normally.

If you purchased a non-licensed product, and you have 
the product key, click on “Enter a product key instead” 
(see picture 1.20).

Picture 1.19: Office connection Error screen

The Product key screen displays as shown below. Type in 
your product key which must be 25 characters and then 
click on continue.

Type 
product key 

here - 1

Click 
Continue 

- 2

Picture 1.20: The product key screen
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MS Office 2016 may not require a product key once you purchase 
a licensed copy.

Note: Product key is a specific software-based key 
for a computer program and certifies that the copy of 
the program is original. If you do not have product key, 
you may fail to use the software installed normally or if 
the product key is required before installation you may 
fail to install the software. The location of your product 
key depends on how you got a copy of the software. 

Step 5:	 Afterwards Office installs; click close after installation is 
complete.

Step 6:	 If the activation wizard displays, click “I want to activate 
the software over the Internet” and then follow prompts.

1.5.3	 How to install application software (installing 
skype)

Procedure
Step 1:	 Obtain a disc that contains the software to be installed.  

If you earlier downloaded the software, then check for 
the software from the folder where you save on the 
desktop.

Step 2:	 Insert the disc in the disk drive. 

Step 3:	 Open the disc. Open the folder containg installation 
files.
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Step 4:	 Double click on the Setup file for Skype to install. The 
wizard for installation starts as shown in picture 1.21.

Click I agree- next 
to obtain screen 2 

(picture 1.22)

Picture 1.21: Skype installation wizard (screen 1)

Click continue to 
start installation

Picture 1.22: Skype installation wizard (screen 2)
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Note: Many Application programs require internet connections. 
So ensure Internet is available for proper and complete 
installation.

Picture 1.23: Installation screen for skype

If you are using the latest version of Windows 10, Skype 
is already installed on it. Just sign in with skype name, 
email or phone.

Step 5:	 Repeat step 4 above and install the rest of the software 
you downloaded that includes: Adobe Acrobat Reader, 
Chess game, Avast antivirus and Nero burning software.

Activity 1.6

Locate the software you downloaded in activity 1.3. Perform 
software installation of each of the installation files for;

a)	 Avast antivirus	 b)	 Mozila firefox
c)	 VLC media player	 d)	 Adobe (Acrobat) reader
e)	 Nero burning software
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1.5.4	 Install Antivirus 
This is a utility program used for scanning computer viruses and 
removing them from the computer.

Viruses can corrupt computer data on hard disk, delete most important 
operating system files and can make the system to crash. Always install 
updated antivirus software and ensure you scan your system regularly 
with the program. You can download and install the antivirus you want 
depending on user experience or information from other users like 
Norton, Kaspersky, AVG, McAfee, Avast, etc. Similar steps are used to 
download and install different antiviruses.

Uninstall application software
Take the following steps to uninstall (Google Chrome) an application 
software.

Step 1:	 Right click the start button and select Control Panel. (Or 
type “Control panel” in the Search box at the start and press 
enter).

Right-click Start and 
select Control Panel

Picture 1.24: The Start button shortcut menu
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Step 2:	 In the control panel window that displays (as shown in picture 
1.25) select Uninstall a program under Programs option.

Select Uninstall a program here

Picture 1.25: The Control Panel window

Step 3:	 In the Programs and Features screen, select Google Chrome 
(you can select another program you are sure you do not need 
and uninstall it). Then click on Uninstall tab above programs 
list.

Click Uninstall to  
remove the program -2

Select Google Chrome program 
you want to uninstall- 1

Picture 1.26: Programs and Features installed on computer
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Step 4:	 Wait for the Windows Installer (as shown in picture 1.27) 
to gather all the features of (Google Chrome) program and 
remove them. Lastly close Control Panel.

Picture 1.27: Windows Installer prepares to uninstall the program selected

Note: After uninstalling some applications such as MS Office, 
it requires to restart the computer to completely remove all the 
features. When you see a message prompting you to restart, 
please accept it.

1.6	 Software add-on
This is a piece of software that adds a specific feature or capability 
to an existing software application. A software add-on cannot be run 
independently, it is just a software extension. 

Examples of common  add-ons  are Adobe Flash, QuickTime and 
Silverlight. 

Role of add-ons
	࿤ Interface change: The application can be dynamically extended 

to include new features which have friendly interface suitable for 
different users.

	࿤ Adding features: More features are added to the browser (program) 
to increase its usability.
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Download and install add-ons 

Activity 1.7

Using Mozilla firefox

Carryout a download to add various software extensions to your 
browser.
Step 1:	 Go to the Mozilla home page. You can use 

www.mozilla.org.

Step 2:	 Click Add-ons (First scroll down the page).

Click here for 
Add-ons

Picture 1.28: The Mozilla website
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Step 3:	 On the new page that displays, go to the add-on or 
extension you want to add.

Open menu

Select Add-on extension to 
add to your browser

Picture 1.29: A list of some Firefox extensions

Step 4:	 Click the add-on you want to download. This automatically 
installs on your computer.

Download Helper 

This is a tool used to extract videos and image files from websites 
and save them to your hard drive. As you are surfing the web 
Download Helper can detect that it can do something for you, the 
toolbar icon highlights and a menu allows you to download files by 
simply clicking an item. 

Download file (Video) using add-ons/download helper
Step 5:	 In the new tab for Add-ons Manager, click in the Search 

box at the upper right hand corner of the window. Type in 
the word YouTube and press enter key. 
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Type YouTube here 
and press Enter

Select and click on 
Install button

Picture 1.30: Firefox window displaying the Add-ons Manager tab active

Step 6:	 Click the Install button next to the result “1-click YouTube 
Video Download”.

Step 7:	 Once the installation is complete, wait for a few seconds 
and then restart Firefox.

Step 8:	 Type in the Address bar “www.YouTube.com”. Locate 
your favourite video and click on it.

Step 9: If “I click YouTube video download” is used, to download 
a video on YouTube, there is a red button under Active 
Video download.

If Download Helper is used and there is an active video 
on any website, the icon is active to let you download it, 
see pictures 1.31 and 1.32.
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List of videos. 
Select a video you 

want

Type here, word 
(s) and press 
enter key to 

search for your 
favourite video (s)

Picture 1.31: YouTube displaying some videos you can download or play

Copy the URL for your favourite video.

Step 11:	From Save as dialog box, select location to save your 
video and click Save continue to download the page.
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Active 
Video

Download button to use

Picture 1.32 (a): YouTube showing active video that can be downloaded

Click the Download button below the active video and 
the options it brings, select a suitable format. The save as 
dialog box displays.

Type in filename and click 
Save (3)

Select a format to be used for saving your video (2)

Click Download (1)

You can change 
save location here

Picture 1.32 (b): YouTube showing a video in process of being downloaded
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Step 12:	Once the download is complete, watch the downloaded 
video at any time you want, using location specified.

Note: YouTube has been designed for users who only watch 
and view videos on their website. In case you want to download 
and save the video to your computer, you may have to select 
from a variety of online downloader programs or use YouTube 
downloader page to download the video.

Note: Ad blocker 

This is software extension that reduces the number of unwanted, 
uncalled-for pop up ads which appear on the user’s display in a 
browser. Ad is short for Advertisement. Pop up ads usually appear 
unexpectedly.

Ad block Plus is the most popular ad blocker for Firefox, opera, 
chrome, safari and internet explorer. It blocks banners, pop-ups, 
tracking and some malware.

Why should you remove ads?

There are many reasons why people choose to remove ads. Some 
of the most frequent arguments are: 

	࿤ People do not want to be manipulated by online advertising.
	࿤ Advertising is annoying in most cases.
	࿤ Advertising often uses heavy graphics which slows the page 

loading.
	࿤ Online advertising imposes a security risk for the Internet user, 

as the third-party banner ads may introduce security breaches 
to the site.

How to disable or remove browser plug-ins and add-ons
Internet Explorer, Firefox, and Google Chrome each allow for the 
use of plug-ins and add-ons, which are scripts that supplement the 
functionality of the browser.

For - Mozilla Firefox
In the menu bar, select Tools > add-ons or click the Open menu button 
on the upper right page and select add-ons.
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1.	 In the Add-ons Manager Screen, find the add-on from the list of 
currently loaded add-ons on the right.

2.	 Select it and click on the Disable button at the bottom right.
Windows users may also be able to uninstall add-on files through 
the Control panel.

Activity 1.8

Download and install the following add-ons:
a)	 Media player for YouTube
b)	 Mail Notifier
c)	 Screen Capture

End of Unit 1 Assessment

Theory Questions
1.	 a)	 Define the term Software Installation. 

b)	 Briefly describe the steps for installing an operating 
system.

c)	 Explain the role of operating systems.
2  Apart from fresh installation, explain other choices that are 

available for installing operating system on computer.
3.	 Explain the following terms:	

a)	 File System
b)	 Booting
c)	 Disk partitioning
d)	 Microsoft Office

4.	 Use Internet facility to research and then discuss the role of 
open source applications over proprietary software.

5.	 Open your browser and download the following applications:
a)	 Microsoft Office
b)	 Chess master
c)	 A shampoo burning software
d)	 PDF reader
e)	 Ludo game
f)	 Kerspersky Antivirus
g)	 Adobe Photoshop



35

Application and Utility Software Installation

6.	 Install the following programs you downloaded on to your 
computer:
a)	 Ashampoo burning software
b)	 Adobe Photoshop
c)	 Chess game
d)	 PDF reader
e)	 Mail Notifier (add-on)

7. Uninstall the following software from your computer:
a)	 Acrobat Reader
b)	 Media player for Youtube
c)	 Screen capture



APPLICATION SOFTWARE
Word Processing
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Unit
22

Table of Contents and Mail Merge

Key Unit Competence

Generate a table of contents and use one document to have multiple 
copies for different recipients.

2.1	 Table of Contents (TOC)
A Table of Contents is a piece of information used by readers to quickly 
find or locate what they are looking for in a book, magazine or any 
piece of literature.

Activity 2.1

Creating Table of Contents
Follow the following steps carefully to create a Table of Contents:

Step 1: 	 Start MS Word and then create a new document in which 
you need to add Table of Contents. You will save the 
document as My-TOC.

Now use Microsoft Word and type the following text as it 
appears; then you will use it to create Table of Contents 
and Lists of Tables and figures in activity 2.2 and 2.3.
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The text bellow will be used in learning how to create table of contents:

Information and Communication Technology Syllabus 
ICT Syllabus in Secondary Schools contains a 
number of items of study. One of the interesting 
items in the syllabus is about software. When 
a teacher plans to have an ICT lesson from the 
Computer Laboratory, all learners smile (like a 
smiley face shown on the right) because they are 
going to use computers practically. There is some 
information about software as shown below:

Computer Software

Definition of computer software
Computer software is defined as a series of instructions that tell 
the computer hardware how to process data. Computer software 
is sometimes called computer program. It is divided into two main 
categories; 

	࿤ System software
	࿤ Application software.

About three quarters of what learners study is 
application software. As shown in the figure on the 
right.

System software 
These are computer programs that control the operation of a 
computer and its hardware devices. System software act as an 
interface between the user, application software and computer 
hardware. Modern computers are complex machines having many 
running parts all of which need system software to keep running. 
Systems software also provide general functionality for other 
programs to use, tools to speed up the computer, tools to develop 
new software and programs to keep the user safe from attacks.

System software is divided into:

	࿤ Operating system: For example, Windows 8, Windows 10, 
Linux and many others.

	࿤ Utility programs: For example, Antivirus, Disk defragmenter 
and others.

	࿤ Translator software: For example, Assembler, Interpreters and 
compilers.
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	࿤ Programming languages: For example, machine code, Assembly 
and Java.

The table below summarises system software

Category of system software Some examples 

Operating system Windows 10, Ubuntu, Linux, Mac OS

Utility Software Antivirus, Backup, Disk defragmenter, 

Screen saver, uninstaller

Translators (Language 

translators)

Assemblers, Interpreter, Compilers

Programming languages Low Level 

languages

Machine code, 

Assembly, 

High level 

languages

Java, SQL, Mercury, 

Visual Basic

Application software
These are programs that help end-users to accomplish specific tasks 
using a computer. These programs define what a computer can 
be used for. Most application programs are available as packaged 
software that can be bought and installed on your computer. The 
common categories of application software include: 

Word processing software

Word processing software is the key to learning 
other application programs. On the right is a 
7-point star for Microsoft word.

Spreadsheets software
Management of figures is best learnt from lower 
level with spreadsheets software. This knowledge 
is important in business calculations. We give 
Microsoft excel a six-point star as shown on the 
right.

Presentation software
It is important that learners can convey 
information to particular audience in an 
organised way using a computer program. We 
can now give Microsoft PowerPoint a 5-point 
star. 



40

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

Other applications are equally good and learning the first three 
(above) gives a learner a good foundation for understanding other 
professional applications as given faster. 

	࿤ Graphics and Multimedia software.
	࿤ Computer Aided Design (CAD) software.
	࿤ Database Management Systems.
	࿤ Desktop Publishing.
	࿤ Project Management.
	࿤ Geographic Information Systems.
	࿤ Education software.
	࿤ Entertainment software and many others.

The table below summarises Application software

Application software commonly 

used in schools

Examples 

Word processors Microsoft Word, Abi-Word, Open 

Office Writer

Spreadsheets software Microsoft Excel, Open Office Calc

Presentation software Microsoft PowerPoint, Open 

Office Impress

Geographic Information System (GIS) ArcGIS

Graphics and Multimedia Microsoft Paint, Adobe Photoshop

Web Browsing software Microsoft Edge, Mozilla Firefox, 

Google Chrome

Step 2: 	 Apply Heading Styles to the text that you want to include 
on the Table of Contents (MS Word will use these styles 
to build the TOC automatically).

Note: The objects you see in text were wrapped. To wrap 
them and appear like that, you have to do the following: 

	࿤ Click on shape (the drawing tools automatically display 
under Format tab).

	࿤ Click on Wrap Text in the Arrange group on the Format Tab.
	࿤ In the Wrap text menu, select Tight (you can also test other 

options to see how they work).
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	࿤ Move the picture or shape to the right until all the text 
appears on the left of the shape.

	࿤ Release the mouse button. Justify your paragraph or block 
of text in case of need by clicking the Justify tool located 
under the Paragraph group found under the Home tab.

Procedure to apply heading styles
	࿤ Select text you want to be included in Table of Contents

In our activity select the heading “Information and 
Communication Technology Syllabus” and apply Heading1 
style. Do this by selecting Heading1 style from the Styles group 
on the Home tab. Repeat action above for heading “Computer 
Software”.

Select text- (1)

Click Heading 1 - (2)Apply bold (3) 
– Optional-

Picture 2.1: Applying a heading style onto a selected heading 

Bold your title. Repeat the procedure on subsequent titles using 
heading 2 in styles group and bold command in the font group 
on the Home tab:

The titles to apply heading 2 in the text are:
	· Definition of computer software
	· System software
	· Application software

Apply heading 3 style to text headings below:
	· Operating system
	· Utility programs
	· Translator software
	· Programming languages
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	· Word processing software
	· Spreadsheets software
	· Presentation software

Repeat this step for every text heading you think should be in 
your TOC.

At this stage insert page numbers. Align right page numbers in 
the footer using 1, 2, 3 number format.

Step 3:	 Generate an automatic Table of Contents for the document 
at the beginning of your document. 

To create Table of contents, do the following below: 
Creating table of Contents

	࿤ Click where you want to insert the Table of contents (usually at 
the beginning of the document).

	࿤ Click References tab > Table of Contents, and then choose 
Automatic Table 1 style from the list (See picture 2.2).

Note: If you use a Manual Table of Contents style, Word 
won’t use your headings to create a TOC and won’t update 
it automatically. If you opt for manual method, then everything 
has to be done manually.

When created, you can format or customise your TOC by 
changing font, number of heading levels, etc.  A TOC can 
also be created in any other location in your document but it 
is most suitable at the beginning of your document. 
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Select 
Automatic 
Table 1 or 
Automatic 
Table 2 to 

create a TOC 
automatically.

Update table button

Use manual 
Table and 
Word will  

create it but 
with titles you 
may not need.  
But Just edit 

them.

Click here to 
delete table  
of contents.

1

2

Picture 2.2: Styles for creating table of contents e.g. automatic table 1
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The Table of contents that results from activity 2.1 is shown in 
picture 2.3.

When the TOC is 
selected, “Update 

Table” button 
displays here

Picture 2.3: Document showing Table of Contents at the beginning of the 
document

Activity 2.2

Open My-TOC file and perform the following activities:
a)	 Insert a page break at the end of the document.
b)	 Type the heading ‘Computer Hardware’. 
c)	 Generate a list of computer hardware available in your computer 

laboratory on the following categories:
	· Input Hardware
	· Output hardware
	· Processing hardware
	· Storage hardware

d)	 Apply heading 1 style on the new heading and heading 2 style 
on the sub headings.

e)	 Update your Table of Contents (follow the steps given).
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Update Table of Contents
If you add or remove some headings or information from the TOC in 
your document, you can update quickly using the following procedure:

Step 1:	 On the References tab, in the Table of Contents group, click 
Update Table (See picture 2.2). You can also click “Update 
Table” button in the selected Table of Contents (See picture 
2.3).

Step 2:	 In the Update Table of Contents dialog box that displays, 
select “Update entire table”. The new table of contents 
displays.

Picture 2.4: The Update Table of Contents dialog box

When the TOC as shown in picture 2.3 is updated, the new 
Table of contents reflecting changes/updates you have made 
may appear as shown below.

Picture 2.5: The Updated Table of Contents
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Delete Table of Contents
Step 1:	 On the References tab, in the Table of Contents group, click 

Table of Contents. 

Step 2:	 From the Table of Contents menu click Remove Table of 
Contents (See picture 2.2). The table of contents automatically 
disappears from its original location.

Customise Table of Contents
Step 1:	 On the Table of Contents menu, select Custom Table of 

Contents. The Table of Contents dialog box displays as shown 
below.

Step 2:	 Select the tab leader you need, number of levels and other 
options.

Step 3:	 Click on OK to save changes you need in the TOC.

Select a line  
style for pointing 
to page numbers

Change number 
of levels from 

here

Picture 2.6: Table of Contents dialog box

2.2	 List of tables and list of figures
List of tables and figures is used to keep information organised and 
provide easy access to a specific element needed in the document, for 
example a table or particular figure such as a drawing or photo, etc.
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Creating a list of tables and list of figures

Activity 2.3

Open My-TOC document. Just below the Table of Contents:  
a)	 Create a list of tables in the document.
b)	 Create a list of figures in the document.
c)	 Save the document as List of Figures. 
Follow the procedure below to generate a list of Tables (Table of 
Figures);

a)	 Creating a List of Tables

Step 1: 	 Add Captions to every Table in the document using 
procedure given below:

	࿤ First select a Table on to which you need a caption. 
	࿤ Click “Insert Caption” command on References tab. 

(See picture 2.7 below).
	࿤ Edit table caption and click OK. (See picture 2.8).

Repeat the procedure for all the tables in the document.

Click on Insert Caption – 3

Select Table -1

Click on References 
Tab- 2Caption

Picture 2.7: The steps used to insert Captions on Tables
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Picture 2.8: Caption dialog box

Repeat step 1 for all other tables in the document.

Use the following text for Table 1 and 2 as table captions:

Table 1: Summary of system software

Table 2: Summary Table for application software

Step 2:	 Click where you want to insert the Table of Figures.

Step 3:	 On References Tab in the Captions group, click on Insert 
Table of Figures to build the table.

Step 4:   In the Table of figures dialog box (as displayed in picture  
2.9), select the caption label as “Table” and click OK.
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Click references tab (1)
Click Table of Figures (2)

Adjust table 
formatting

Select Table (3)

Click OK (4)

Click Options for 
more options

Picture 2.9: MS Word window displaying Table of Figures dialog box

The resulting list of tables is shown in picture 2.10.

You may have to type and format this text
of System Software

Picture 2.10: A list of tables is displayed
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The resulting list of tables appears as shown below.
Optional steps you may take before clicking OK

Step 5:	 Adjust Table’s formatting such as setting whether to show 
page numbers or changing the style of tab leader. You can 
use a preset style from “Formats” drop down menu. In 
case you want to customise the style, leave it set to “From 
Template”.

Step 6:	 Click “Modify” and click again “Modify” in the style dialog 
box to customise the style of the table. You can change 
the table’s font, size and other settings in the two dialog 
boxes. Then click OK.

Modify Style 
dialog box.

Style 
dialog 
box.

Picture 2.11: MS Word window displaying dialog boxes for modifying Table of 
Figures

Step 7:	 Click “Options” in the Table of Figures dialog box. 

Check ‘Style’ and select style used for your figure labels 
to build table based on text style rather than data taken 
on insert caption. If you used insert caption you can skip 
this step.
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Picture 2.12: Table of Figures Options dialog box

Using the modify style dialog box, if font size is 12, bold 
and underline styles are used on our list of tables, and a 
table leader is also changed, the list of tables will appear 
as shown below.

of System Software..........

Picture 2.13: The modified List of Tables

b)	 Creating a List of Figures
Step 1: 	 Repeat steps 1 in (a) above (creating a List of Tables). In 

this case add captions for all the figures. See procedure 
in the picture below (picture 2.14).

Computer software is defined as a series of instructions that tell the computer hardware how to process
data. Computer software is sometimes called computer program. It is divided into two main categories.

Laboratory, every learner smiles (like a smiley face shown below) because he/she is going to use a
computer practically. There is some information about software here for us that begins with:

Definition of computer software

•	 System software
•	 Application software

Figure 1: Most learners show smiling faces at the words “Go to ICT lab”

Picture 2.14: The steps for inserting captions for figures
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Step 2:	 Repeat step 2 of part (a) i.e. (step 2 in creating a List of 
Tables). 

Step 3:	 Repeat step 3, however in the Table of Figures dialog box, 
select Figure.

Step 4:	 Click OK.

The resulting table of figures may appear as shown in picture 
2.15.

You may have to type 
and format these 
headings before 
inserting Lists of 

Figures

Picture 2.15: Table of Contents and List of Tables and Figures

2.3	 Mail merge 
A mail merge is the process that produces personalised letters by 
combining a database of names and addresses with a formal letter 
created in a word processor.
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Activity 2.4

a)	 Create the letter below in Microsoft Word, that will invite 
parents to their meeting at GS Bumbogo School. Save the letter 
as “Parents Meeting”. Follow other instructions after this letter. 

GS BUMBOGO
RWANDA

22nd May 2018

The Parent of .......................
Class ..................................
Status .................................

Dear Sir/Madam,

RE: PARENTS’ MEETING SCHEDULED FOR FRIDAY 27TH 
JULY 2018

You are cordially invited to attend the Parents’ meeting without 
fail. The meeting will start at exactly 9:00am in the Main Hall with 
thanksgiving prayers to be led by Reverend Alexander Gahima. The 
agenda for the meeting shall be given to you on arrival.

Issues to discuss are very crucial for the well-being of your child at 
school. Endeavor to come with fees balance amounting to <<Fees 
Balance>>. Or else your child shall be sent back home for the same.

Yours faithfully,

HEAD TEACHER

c.c.	 Parents’ & Teachers’ Chairman
c.c.	 BOG Chairman

b)	 Use mail merge feature to generate letters for the following 
parents in the table below.

Name Class Status Fees Balance (Francs)

Gatete Alexander S3 Boarding 15,000

Mugisha Francis S2 Day 8,500

Kwizera Isabella S4 Boarding 14,500

Table 2.1: Address information about Parents (Recipients)
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Creating a mail merge document
Step 1:	 Create a letter which you will send to various persons; 

similar to the one shown on screen in picture 2.16, save it as 
‘parents meeting’.

Click Start Mail Merge 
and on the menu select 

Letters (2)

Create a 
letter (1)Location where fields 

shall be inserted

Picture 2.16: Word document showing an invitation letter to parents

Step 2:	 On the Mailings Tab, click the Start Mail Merge button and 
then select Letters in the menu. 

Step 3:	 Click on the Select Recipients button which is next and in the 
list that appears select Type a New List. The New Address 
List box appears.
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New Address 
List dialog box

Click Select 
Recipients button and 
then Click Type a New 

List or click ‘use an 
existing list’ in case you 

have it

Picture 2.17: “Select Recipients” menu on Mailings tab and the “New Address List” 
dialog box 

Step 4:	 In the New Address List, click Customise Columns. The 
Customise Address List appears to enable you customise the 
fields. (See picture 2.18).

Click here to customise fieldnames (4)

Select a field and click 
Add to add it in the list.

Select 
a field 

and click 
Delete to 
delete it

Select a field  
and click 

Rename to 
change its  

name

Click OK if you have reduced 
the fields to a number you want

Picture 2.18: The Customise Address List dialog box displayed on top of, ‘New 
Address List’ dialog box 
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Note: You do not need all the fields that come with the program, 
so you can customise them by clicking on the Customise Columns 
as shown in picture 2.18.

Referring to the data in table 2.1, the customised fields could appear 
as shown in picture 2.19:

Customised 
Fields 

Click OK to replace the 
default fields (5)

Picture 2.19: The Customise Address List dialog box showing the customised 
columns to be used

Step 5:	 After customising your fields, click OK. Then start entering in 
your data i.e. Recipients list.

Step 6:	 Click OK after entering Recipients list. You will be prompted 
to save the file (the Data source). 

Recipients 
data

Click OK to save the list (6)

Gatete

Picture 2.20: The New Address List dialog box showing Recipients data you may 
need
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Step 7:	 The Save Address List dialog box will display to enable you 
save the data file. Type in the file name as “parents” and 
select suitable location, then click Save button.

Step 8:	 Click on Edit Recipients list on the Mailings tab, in case you 
want to edit some Recipients (or you can ignore this step). 
See picture 2.21.

Step 9:	 a)	 Click a location in the main document (Letter) where 
you want to insert the first merge field.

b)	 Click on the Insert Merge Field button, a drop down list 
of fields used will appear, click on the appropriate field 
to be inserted in the cursor position.

c)	 Repeat the above step until all fields in the data file 
are inserted in the document (Letter) in appropriate 
positions.

d)	 Preview results using the Preview Results group 
buttons.

(8) 9(d)

9(b)
Newly inserted 

merge fields

10 (a)
GS Bumbo

22nd May 2018

PARENTS MEETING SCHEDULED FOR FRIDAY 22nd May 2018

Reverend Alexander Gahima. The agenda

Picture 2.21: The created parents letter showing the newly inserted fields

Step 10:	See picture 2.21:

a)	 Click on Finish & Merge button in the Finish group; 
select Send Email Messages—to send merged 
documents as Emails; or select Print Documents—to 
send merged documents directly to the printer to be 
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printed or select ‘Edit individual documents’ to edit 
and print copies after merging them.

b)	 Now select Edit individual documents, the Merge to 
New Document dialog box will display. Select All and 
click OK.

Picture 2.22: The Merge to New Document dialog box form where you select 
records to merge

c)	 The merged document will appear with a temporary 
name (Letters1); Save the document using a new 
name or location.

d)	 Print your document when you need.

Activity 2.5

1.	 Open Microsoft Word and make mailings tab active. Study your 
screen and then compare it with buttons you see in picture  
2.23.

Picture 2.23: The Ribbon showing Mailings tab buttons

2.	 Using picture 2.23 above; identify the buttons used to perform 
the following activities:
a)	 To delete or add more names and addresses.
b)	 Display items you create using mail merge.
c)	 To see the letters before you merge.
d)	 To insert merge fields at the cursor position.
e)	 To send merged letters as mail or print them directly on 

the printer.
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3. 	Mr. Gatete is a Secretary of Biscuit Trading Company Ltd. 
His company intends to invite its shareholders for the Annual 
General Meeting (AGM) this year.
The content of the letter is to be similar to all shareholders 
except for each shareholder’s personal details and titles.

Mr. Gatete has prepared the letter below to be sent to various 
shareholders.

BISCUIT TRADING COMPANY LIMITED
P.O. BOX 1777, KIGALI

06/05/2018

TO:	 [title] [shareholder’s name]
	 P.O. Box [address]
	 Tel: [telephone contact]

Dear Sir/Madam,

RE: ANNUAL GENERAL MEETING SCHEDULED FOR 
FRIDAY 24TH MAY 2018

You are cordially invited to attend the AGM without fail on the 
date indicated above starting at 10:00am. In this meeting we 
shall elect new office bearers. You are expected to pay a non-
refundable amount of [fee] RFs to cater for elections. Agenda 
for the meeting is attached here on.

Yours faithfully,

GATETE JOHN
COMPANY SECRETARY

c.c.	 Managing Director
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Title Shareholder’s 
name

Telephone 
contact

Address Fee (RFs)

Mr. Dr. Ngabo P. 0998674006 590, Kigali 18,000

Mr. Rev. Ingabire S 0417560437 320, Karongi 16,000

Rev. Dr. Bugingo B. 0768054354 3101, Rubavu 15,000

Mrs. Gatete F. 0429086543 7012, Rwamagana 14,000

Mr. Br. Mugisha C. 0237980565 769, Gicumbi 15,000

Table 2.2: List of shareholders to receive letters

Required
a)	 Type the letter as it appears and save it as Biscuit letter. 

Include a Header as your name.
b)	 Use mail merge features in Microsoft word to create the 

table above, save it in your folder as shareholders.
c)	 Link the table to the letter and generate letters for various 

shareholders. Save the new generated file as Biscuit-
Data.

Activity 2.6

1.	 Ms. Mutesi Mary is the head of ICT in Maranyundo Academy. 
She is organising an ICT learners’ seminar at her school. She 
intends to send letters to ICT teachers of various schools 
requesting for their learners to attend this seminar in September 
2018. The content for the letter is the same for all schools 
except School names, ICT teachers and other details.
A copy of the letter to be sent to schools. 

a)	 Type the letter and save it as ICT seminar.
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MARANYUNDO ACADEMY
P.O. BOX 234567, RWAMAGANA.

15-JULY-2018

TO: 	 <ICT Teacher’s Name>
	 ICT Department
	 <School’s Name>
	 <School Address>

Dear <Title>,

RE: INVITATION TO ATTEND ICT SEMINAR AT SCHOOL 
ON 29th SEPT 2018

The school through its ICT department has organised the 
ICT seminar at the school on the day indicated above. The 
seminar will be learner centred and will be attended by many 
influential ICT academicians and experts from RDB/ICT, REB 
and University of Rwanda (UR).

The seminar is aimed at enabling our learners understand 
current global concerns in relation to ICT and at the same 
time equipping them with ICT skills and knowledge for 
enabling them to sit for the coming National Examinations in 
November this year. 

The participation fee for each learner from your school is 
<Participation Fee>Francs only. In addition, learners must 
come with their own refreshments or can individually order 
for food from our school canteen at <Ordering Fee>Rwanda 
Francs.

We shall be very grateful for your positive response.

Yours faithfully,

MUTESI MARY
HEAD ICT DEPARTMENT

c.c.	 Headmaster
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Title School 
Name

School Address ICT Teacher’s Name Fee Lunch

Madam Kigali 
Parents 
School 

P.O. Box 3020, 
Kigali, Rwanda.

Ms. Mutoni Peace 3,000 2,000

Sir Kagarama 
SS

P.O. Box 1010, 
Kigali.

Mr. Ngabo Desire 3,500 2,500

Sir Nyamata 
High School

P.O. Box 123, 
Bugesera.

Mr. Mugisha Noah 4,000 2,800

Madam FAWE Girls 
SS

P.O. Box 9090, 
Kigali.

Mrs. Mutesi Desia 4,500 2,000

Table 2.3: Details required from different schools

Required
(i)	 Indent the body of the letter left and right by “0.5”.
(ii)	 Apply single line spacing on each paragraph of the body.
(iii)	 Put a spacing of 12pt before and after each paragraph. 
(iv)	 Apply a bold Heading1 style to the subject for the letter 

with font size of “15.5” and dashed underline.
(v)	 Insert a text watermark of 2018 and save the changes.
(vi)	 Using a mail merge feature create the table above and 

save it as “ICT-Schools” in your folder.
(vii)	 Use a suitable word processing feature to merge the table 

to the letter (ICT-seminar) in order to generate individual 
letters to be sent to various schools.

(viii)	 Save the resulting file in your folder as “ICT-Letters”.
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Suggested answers for each of the letters required in Activity 
2.6 is displayed in picture 2.24 below.

Temporary name given to merged letters

Status bar indicates 
four letters have been 

produced and the 
third letter is displayed 

on screen

learner

4,000

2,800

Picture 2.24:  Appearance of Mr. Mugisha Noah’s letter, one of the four letters 
produced in the activity

2.4	 Organise, print and view shortcuts
Before you print your document, you should preview your document 
and specify which pages you want to print. 

Activity 2.7

Open ICT-Letters file you created, organise and print one copy of 
the letter for Mr. Ngabo Desire and 2 copies of the letter for Mrs. 
Mutesi Desia.

Follow the procedure given below to print the required document.

Steps to preview your document
1.	 On the File menu/tab click Print.
2.	 To preview each page, click the forward and backward arrows 

at the bottom of the page.
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3.	 If the text is too small to read, use the Zoom Slider at the 
bottom of the page to enlarge it.

4.	 Enter the number of copies, to print. (see picture 2.25).
5.	 Under Printer, select a printer to use (in case you frequently 

change printers). 
6.	 Under Settings, select options you need i.e. select Print Current 

Page.
7.	 Click on Print button to produce a hardcopy of the document. 

(See the picture shown below).

Click Print, to send 
file to printer (g)

Type the number of 
copies for print (d)

Select the printer to 
use (e)

Select Print 
Current Page (f)

Change 
orientation to 

landscape

Choose Zoom slider 
to enlarge text (c)

Preview each page  
with arrows (b)

Click Page Setup to change 
page margins, orientation, 

paper size, etc. (a)

Picture 2.25: All in one place, you can see how your document will look like 
when printed, set your print options and print the file with the print dialog box 
for Word 2016

Note: Before you click on Print, ensure that the printer you 
select is connected to your computer and switched on. 
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View Shortcuts
In case you need to use view shortcuts to see your document in 
different ways, click a desired view button on the lower right of the 
document. See picture 2.26.

Read Mode Print Layout

Web Layout

Picture 2.26: View shortcuts

2.5	 Protect your document
Use passwords to prevent other people from opening or modifying 
your documents. However, if you use a password and forget it, Word 
processors like Microsoft Word cannot retrieve the forgotten passwords. 
There are two methods to protect a document with password.

Steps to protect your document with a password

Method 1
1.	 Create or open an existing document. Click the File tab. The 

Backstage view opens. 
2.	 In the Backstage view, click Info (see picture 2.27). 
3.	 Click Protect Document. See picture below for Protect Document 

options.
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2

3

4

ICT – Letters - Word

Picture 2.27: Part of Backstage view for Office Word 2016 showing Info options for 
protecting a document

Meaning of various options
	· Mark as Final: make the document read-only. 
	· Encrypt with Password: set a password for the document. 
	· Restrict Editing: control what types of changes that can be 

made to the document.
	· Restrict Permission by People: use a Windows Live ID to 

restrict permissions. 
	· Add a Digital Signature: add a visible or invisible digital 

signature.
4.	 Click ‘Encrypt with Password’. 
5.	 In the Encrypt Document dialog box that displays (as shown on 

picture 2.28), type in the desired password for your document and 
click OK.
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Picture 2.28: Encrypt Document dialog box

6.	 Retype the password again in the dialog box to confirm it and click 
OK. 
Now, you have protected your document with a password.

Method 2 
1.	 Create or open an existing document for which you want to apply 

a password.
2.	 Click File Tab; on the backstage view that displays, click Save As.
3.	 The Save As backstage view displays Save locations, click Browse. 

See picture 2.29.

Click browse to get  
‘Save As’ dialog box (3)

Picture 2.29: The Backstage view showing Save locations

4.	 The Save As dialog box displays, click Tools drop down arrow (See 
picture 2.30)

5.	 Click General Options (See picture 2.30).
6.	 In the dialog box that appears, type in password to open the 

document. Retype the password and click OK. 
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Click Tools (4)

Click General 
Options (5)

Picture 2.30: Save As dialog box 
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Type in password 
you will use 

to open your 
document (6)

This is optional. 
You can use a 
password that 

restricts others 
from modifying 
your document

This is optional. You can make your 
document a read only without using 

a password.

Picture 2.31: General Options for creating a password in a document

End of Unit 2 Assessment

1.	 Use Microsoft Word, typeset the following document and save 
it as ‘Certificate of Appreciation’. This document is a certificate 
and should have a page border as shown.
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Ecole Des Sciences De Byimana

Ruhango District,

Southern Province, Rwanda

ICT CLUB
Certificate of Appreciation

This is to certify and acknowledge that

…………………………………………………………………..

has worked hard for the ICT club of the school as a club

…………………………………………………………………….

for Academic year ……………………………………

Your efforts shall always be treasured.

“Science, conscience and Excellence”

___________________	 __________________

	 Club Patron	 Headmaster

Other Instructions
a)	 Use 1.5 line spacing for your work and no space after 

each paragraph.
b)	 Make the following changes to the title:

(i)	 Change the name of the school to Stencil bold font 
face, font size 26 and dark blue colour.

(ii)	 Change the second line to font size 16 and bold.
(iii)	 Change the third line to font size 14 and bold.

c)	 Leave enough space between “Southern Province”, 
Rwanda and ICT Club to accommodate a suitable graphic 
(good image) that will work like your school badge.
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d)	 Underline the heading, “Certificate of Appreciation” 
change it to size 20 and colour dark red. Apply a double 
strikethrough. 

e)	 Use blue font colour for signatories in font size 15. 
f)	 Apply dark red colour to page border.
g)	 Ensure that your work fits on one page of your document 

Centre all text. Format the rest of the text as you wish 
correctly.

h)	 The certificates are to be awarded to the following 
members. Create a data source and save it as ‘data file’

Name Post Academic year

Gahima Micheal Treasurer 2016/2017

Kwizera Francis President 2015/2016

Mutesi Catherine Vice President 2016/2017

Ingabire Scovia Secretary 2017/2018

Gaju Paul Spiritual Minister 2016/2017

Bugingo Isabella Welfare Minister 2015/2016

Giramata Princess Schools Relations Minister 2016/2017

Table 2.4: Details for every member who will receive certificates

i)	 Using a word processing facility, merge the fields above 
to the certificate ( place fields in appropriate positions).
Change the colour of the merged fields in red bold colour 
in your main document. 

j)	 Merge the document and the certificate such that each 
member of the club in the data source has a complete 
certificate for printing.

k)	 Name the new file as ICT certificates with a password 
as, ‘joint1001’. Print a copy of the new document and 
close the file.

2.	 Explain the meaning of the word Formal letter and explain how 
it differs from the database of names and addresses?
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3.	 Open a blank document and in it create the following items:
a)	 Type two brief paragraphs about the history of your 

school. Add a suitable picture such as a clip after.
b)	 Type five points about why you joined your school, the 

good about your school and the bad about your school. 
Insert one picture related to computers. Provide a suitable 
heading.

c)	 Insert a new page in your document. Type a heading 
“Science Teachers”. A brief information about science 
subjects such as physics, chemistry. Create a table with 
science teachers and the subjects they teach. Include a 
suitable picture on the page.

d)	 Type a list of Arts Teachers in a table, with a suitable 
heading on a new page. Type a brief information about 
Arts subjects.

e)	 Create a list of Sports activities in your school with brief  
information related to your school. Provide a suitable 
heading that should be on a new page. Insert two pictures 
related to sports listed.

f)	 Insert a new page in your document and create a list of 
favourite sports stars in your country and on International 
level. Use two column table.

g)	 Generate reason(s) why you should not change your 
school. Do this on a fresh page.

h)	 Save your file as ‘Love4-myschool’.

Instructions
	· Generate a Table of Contents for your document.
	· Create a List of Tables for the document.
	· Create a list of Figures you have added in your document.
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Unit
33

Charts and Advanced Objects

Key unit competence

Present data graphically and use different objects in a document. 

3.1	 Charts 
A chart is a diagram or object used to display numerical information in 
details. A chart can also be called a graph. 

Data in a chart is represented by symbols, such as bars in a bar chart, 
lines in a line chart, or slices in a pie chart.

3.1.1	 Role of charts
	࿤ Charts are used to summarise and display information in an easy 

manner to understand.
	࿤ Charts act as useful Tools for conveying financial information.
	࿤ They are used to make patterns and trends in numerical order 

much easier to see.
	࿤ Charts facilitate data analysis.

3.1.2	 Types of charts
There are several types of charts used to display data. The most popular 
types include among others the following:

A.	 Bar Chart (Bar graph)
A bar chart is a graphic representation of data with horizontal bars 
or objects. Bar charts usually display horizontal bars or objects 
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going across the chart vertically, with the values displayed at the 
bottom of the chart. 

Picture 3.1: Bar Chart

B.	 Column Chart
A column chart is a graphic representation of data with vertical 
bars or objects. Column charts display  vertical  bars (categories) 
going across the chart horizontally (along the horizontal axis), with 
the values organised along the vertical axis (on the left side of the 
chart).

Chart Overview 

Y axis title

Value axis (y-axis)

Picture 3.2:	 Appearance of a column chart with major parts of a chart named
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C.	 Line Chart (Line Graph)
A line chart is a graphic representation of data plotted using a series 
of lines. Line charts display lines going across the chart horizontally, 
with the values axis being displayed on the vertical axis (left side 
of the chart).

Picture 3.3: Line Chart

D.	 Pie Chart
Pie chart is a circular chart sliced into sections; each section 
represents a percentage of the whole. Pie charts do not display 
horizontal and vertical axes as other charts. 

Picture 3.4: A Pie Chart
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3.2	 To create a chart or graph 
Use the steps given below to create a graph. All the charts already 
shown above were created using similar data as in the ones below. Use 
this data to create these charts as they are in Microsoft Word. Save the 
file as ‘Common charts’.

Favourite Food Number of learners

Posho 75

Sweet potatoes 45

Cassava 58

Irish potatoes 77

Rice 115

Bananas 65

Table 3.1: Different foods enjoyed by different learners

Step 1:	 Prepare the data that you need to make the chart (this data 
can be on paper or in a book). 

Step 2:	 Start Microsoft Word and then click where you want to place 
the chart.

Note: First create table data in Microsoft Word, but this 
is an option you may ignore.

Step 3: 	 On the Insert tab, in the Illustrations group click Chart.

Picture 3.5: The Insert tab showing Chart button

Step 4:	 In the Insert Chart dialog box (that displays as shown in 
picture 3.6), select the type of chart that you want on the left 
side, then select the chart sub type and finally click OK.
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Step 5:	 The Chart remains selected and Chart Tools display (on 
Design, Layout and Format tabs). Use Chart Tools to modify 
your chart the way you want.

C
ha
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ou

 s
el

ec
t 

fr
om

Select  
from here 
the chart  

sub-types 

Selected chart

Picture 3.6: The Insert Chart dialog box. When you rest a mouse pointer over a 
chart type, screen tip displays its name

Step 6:	 Replace the sample data (edit data) by clicking on a cell and 
then typing the data that you want.

Note: To delete a column or row data, right click on column 
letter e.g. column D or row number e.g. row 5. Then select 
delete. 



80

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

Picture 3.7: A newly inserted chart with a Data sheet above it

The resulting chart for our data in table 3.1 will appear as shown 
below

Column Chart showing learners’ favourite foods

Picture 3.8: A column chart representing data in table 3.1
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Activity 3.1

1.	 S.3 class has a total of 120 learners. The class teacher carried 
out a data survey to find out how many learners regularly eat 
meat, pork, chicken or fish at home. The data below in table 
3.2 was collected.

Sauce Number of learners

Meat 75
Chicken 45

Fish 58
Pork 77
Beans 115
Cow Peas 65

Table 3.2: Data collected about different sauces taken by S3 learners

Instructions
a)	 Open Microsoft Word and create the table 3.2 above as it 

appears. 
b)	 Use the data given in table and create:

(i)	 A clustered bar chart on page 1 just below table
(ii)	 Pie Chart on page 2 (with data callouts).

c) 	 Apply Chart Titles and Axis Titles in b (i) and b(ii) above.
d)	 Save changes to your file and save it as ‘Sauces’.

2.	 a)	 The picture below is displaying chart Tools. Use it to 
answer the questions that follow.
(i)	 Name the tab that is active. Identify two buttons 

displayed by this tab.

Picture 3.9: Ribbon displaying Chart Tools on Design tab

(ii)	 Identify how many tabs display Chart Tools. State 
the use of any one button on each tab.
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b)	 Study the Chart Tools on the Design tab in picture 3.9. 
Identify the name of the button used to: 
(i)	 Change from one chart type to another
(ii)	 Add titles to axes and add/remove legend.

c)	 Which type of chart might have been selected according 
to picture 3.9?

d)	 Which button on design tab can be used to quickly apply 
axis labels or titles?

3.	 a)	 Picture 3.10 below shows another set of Chart Tools. 
Study the picture. Which tab is displaying chat tools?

Picture 3.10: Ribbon displaying Chart Tools

b)	 Identify the button used to:
(i)	 Increase or reduce chart width.
(ii)	 Apply shape effects e.g 3-D Rotation.
(iii)	 Apply a fill colour.
(iv)	 Change the appearance of a selected area of chart.

3.3	 Formatting an object and chart
Formatting an object and chart means to change the appearance of 
object and chart to look nice. A chart is an object in a document. A 
chart can be formatted to look attractive to the user. To format a chart, 
different features or buttons are used to make these changes. Most of 
the buttons are located on format tab under Chart Tools as shown in 
picture 3.9.

To format a chart
Step 1:	 Select a chart you want to format.

Step 2:	 Click Format tab under Chart Tools and select a formatting 
button you want. The changes immediately take effect. 
Example:
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To apply Word Art styles on your Chart
a)	 Select a chart or chart element or a particular data series.
b)	 Click Format tab under Chart Tools.
c)	 In the WordArt Styles group, click Quick Styles and select a 

style you want (or use Text fill and or Text outline drop-down 
arrows and select desired colours you want). Refer to picture 
3.8 or 3.9. 

Alternatively perform (a) to (b) above and then use Shape styles 
group buttons/commands i.e. select from Shape Fill and Shape 
Outline drop-down lists. 

Adjust chart size
a)	 Select a chart or object you want to resize.
b)	 Click Format tab under Chart Tools.
c)	 In the Size group type or scroll in to adjust the Shape Height 

and Shape Width of the chart (Refer to picture 3.9).

To format an object
Follow the same steps as those used to format a chart.

Activity 3.2

1.	 a)	 Open MS Word, create and display Table 3.3 on a 
3-D clustered column chart. Save the file as ‘House 
competitions’.

House Football (%) Volleyball (%) Netball  (%)

Gatete 88 65 56

Ngabo 78 90 70

Gaju 45 85 75

Table 3.3: Performance results from Learners’ House competitions in 
Riviera SS last year

b)	 Include a chart title and axis titles.
c)	 Copy the chart and paste it on page 2 and page 3.
d)	 Change the chart type on page 2 to a 3-D pie chart and 

use a suitable chart style. Apply style 3 of pie charts.
e)	 Change the chart on page 3 into a line graph.
f)	 Page your work and save changes.
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Activity 3.3

The following table was prepared by Director of Studies of GS 
Nyarusange pertaining to extra lessons covered by 10 teachers for 
the 4th week of the term. Values are in minutes. 

Name of teacher Mon Tue Wed Thu Fri Sat

Gatete Noah 40 20 80 45 65 90

Rukundo Micheal 100 120 20 45 20 80

Giramata Alex 30 20 15 50 30 120

Mugisha Ethan 50 30 40 60 20 50

Kwizera Olive 120 80 10 15 30 80

Mutesi Grace 70 90 20 20 30 90

Ngabo Pacifique 30 20 40 30 45 100

Mahoro Stanslas 40 15 30 40 50 110

Mutoni Carol 20 20 50 40 70 140

Keza Tania 15 90 100 50 80 180

Table 3.4: Teachers’ extra lessons in minutes

a)	 Typeset the table above as it appears in the new document 
and save it as ‘Overtime’.

b)	 Bold all column headings.
c)	 Centre all the figures in your table.
d)	 Sort the data as A-Z to the names of teachers.
e)	 Insert the heading at the top of your table as “Teachers’ 

Daily Overtime in GS Nyarusange”.
f)	 Create a 3-D stacked column graph for all teachers for 

Mon, Tue and Wed. Place the graph on page 2.
g)	 Create a line graph for the first five teachers (in ascending 

order) for Mon to Sat. Place this chart on page 3.
h)	 Create a pie chart for Mon and Sat for all teachers. Place 

the chart on page 3 below the line graph above in (g). 

3.4	 Add objects from file
An object is something that you can see.  In Word, processing 
objects can be inserted from other files already created, for example; 
documents, workbooks, presentations, PDF and so on.
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3.4.1	 To add object from file
Step 1:	 On the Insert tab, click Object command from the text group.

Picture 3.11:  Office ribbon displaying the Object command from the Text group on 
the Insert tab

Click 
Browse 
button to 
look for 
the file 
with an 

object to 
insert

Click this option to display 
the file as an icon

Picture 3.12: Object dialog box for creating an object from file
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Select a file 
containing an 

object

Alternatively, type here a file name to search open folder

Picture 3.13: Browse dialog box (for searching files containing objects)

3.5	 Add objects
In word processing, you can add different types of objects created 
with other programs such as MS Excel, Presentation, and Equation 
applications in a document.  

3.5.1	 To add Microsoft Excel Worksheet as an object in 
a document (or another type of document)

Step 1:	 Create a new document or open an existing document where 
you want to insert an object.

Step 2:	 Click where you want to insert the object.

Step 3:	 On the Insert tab in the Text group, click Object button. The 
Object dialog box appears. See picture 3.12.

Step 4:	 In the Object Type list, scroll and select the type of object 
you want i.e. Microsoft Excel Worksheet. (You can display the 
object as an icon if desired by ticking the “Display as Icon” 
check box. See the picture 3.14.



87

Charts and Advanced Objects

Description for selected object

Select 
Object type 
from here

Picture 3.14: Object dialog box for creating a new object in a document

End of Unit 3 Assessment

1.	 Data given in table 3.5 shows learners performance in 4 
subjects. Use this data to generate on separate page(s):
a)	 A 3-D Clustered column chart showing all the learners’ 

performance in percentages. Change chart colours and 
the style you want.

b)	 A stacked line chart for all learners.
c)	 A pie chart representing the performance of learners in 

ICT. Use a desired chart style and colour.
d)	 Apply page numbers in the Footer and your name and 

class in the Header.
e)	 Save your file as your ‘Name-Class’.
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Name English Math ICT Physics

Gahima Isaac 78 87 76 98

Teta Princess 90 90 98 55

Uwimana Isabella 85 65 54 76

Kwizera Steven 67 34 76 83

Gaju Sharon 33 12 84 42

Uwera Janet 56 45 91 61

Ngabo Vincent 21 87 43 54

Gisa John 54 54 65 84

Rugero Amos 83 32 83 95

Kundwa Grace 74 54 93 74

Table 3.5: Learners performance in 4 basic subjects 

2.	 Type the following data in Microsoft Word and Save as ‘Learning 
ICT’.

Learning ICT in Rwanda 

ICT syllabus for Rwanda is very interesting. There are many 
topics that were added for purposes of improving and enhancing 
the skills of learners. Thanks for our Government, a caring 
mother for all Rwandan children, taking charge of our future 
livelihood.

There are many topics and units that we learn on different 
levels gradually from lower secondary.

The following topics are learnt right from S1 to S3
	࿤ ICT Fundamentals
	࿤ Safety and security
	࿤ Word processing
	࿤ GIS
	࿤ Computer Network and Communication
	࿤ Scratch Programming for Juniors

At S.2 level Spreadsheet software is added to equip learners 
with basics of managing numerical data with a computer 
program.
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At S3 level more topics are added to build learners with more 
skills in using graphics and multimedia presentation. They 
include:

	࿤ Presentation
	࿤ Graphics and Multimedia

Required

a)	 Justify your document and save it with a name, ‘ICT in 
Rwanda’.

b)	 Insert Sauces file you created in unit 3 as object- icon 
(you can open from here) at the end of the text you typed 
above.

c)	 Add a bitmap Image and Microsoft Excel Worksheet as 
objects at the beginning of your text.

d)	 Insert an equation as “a = (b2 + c2)” below the image.
e)	 Save changes to your file.
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Unit
44

ArcGIS

Key unit competence

Query a map using selections (attribute and location). Create a 
map layout and insert map elements. Use advanced symbology 
and labeling. Print, export and send a map. 

4.1	 Introduction
The most effective selection method one can use to select features in 
a layer is to select features using an attribute query.

4.2	 Querying data/information (Query 
methods III)

4.2.1	 Selecting features by attribute 
One of the selection methods you can use to select features in a layer 
is to select features using an attribute query.

Activity 4.1

Which parcels of Cyiri Cell belong to Birambo Village? The attribute 
query to use is from Picture 4.1;

	࿤ “Village”:  Name of attribute field.
	࿤ “=”: Relationship between attribute field and value (operator).
	࿤ ‘’Birambo’’: Name of value.
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Picture 4.1: Attributes data in ArchMap

Method 1:
Step 1:	 Click Selection > Select By Attributes to open the Select By 

Attributes dialog box.

Picture 4.2: Select By Attributes dialog box
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Step 2:	 Choose the layer to perform the selection against.

Step 3:	 Specify the selection method.

Step 4:	 Enter a query expression.

See Building a query expression for information on the syntax 
of a query.

Step 5:	 Validate your query expression by clicking Verify.

Step 6:	 Click OK or Apply to execute your selection expression and 
work with the selection results.

Step 7:	 Optionally, you can save your query expression for later reuse 
before closing this dialog box.

	
		

		

862 parcels belong to Birambo Village

Picture 4.3: Attributes table
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Method 2
Step 1:	 Click Selection > Select By location.

Picture 4.4: Select By Location dialog box

Step 2:
Constructing a location query 

	࿤ Target layer: Parcels 
	࿤ Spatial relationship: Intersect 
	࿤ Source layer: Wetland 

4.2.2	 Select by location 

Buffering features 
	࿤ What neighbourhood is affected by 10m river buffer? 
	࿤ Open Arc catalogue.
	࿤ Analysis tool.
	࿤ Proximity.
	࿤ Buffer- a dialogue box is open.  
	࿤ In the Input Feature put River. 
	࿤ Output feature class—browse to your data storage and give the 

name. 
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	࿤ Linear Unit: 10 – select Meters. 
	࿤ Leave other tabs as default.
	࿤ OK.

Step 1

	

	 	 		
		

		
Picture 4.5: Accessing Buffer feature

	

		

		
Picture 4.6: Buffer dialog box
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Picture 4.7: Accessing Select by Location in ArchMap

	

		
		

		
Picture 4.8: Select By Location dialog box
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Picture 4.9: Cyeya - parcels - Target layer

Overlaying features 
	࿤ Open ArcCatalogue. 
	࿤ Analysis tool. 
	࿤ Overlay. 
	࿤ Union- a dialogue box is open.  
	࿤ In the Input Feature put Polygons to unite.  
	࿤ Output Feature class -browse to your data storage and give the 

name. 
	࿤ Leave other tab as default.
	࿤ Ok.

	

·	  	 Ok			
		

		
		
		

		
									PolygonA							 								PolygonB			 		 				Intersection			
		

Picture 4.10: (a) Union dialog box
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·	  	 Ok			
		

		
		
		

		
									PolygonA							 								PolygonB			 		 				Intersection			
		

Polygon A Polygon B Intersection

Picture 4.10: (b) Input Features - polygons

	

		
		
		

Picture 4.11: Intersect dialog box

	࿤ Explore other functions in ArcToolbox 

Activity 4.2

Using ArcGIS, create an administration map of Rwanda, the 
map should present provinces, districts and lakes.

Use the steps below

Step 1:	 Start ArcGIS Pro.

Step 2:	 Open an empty map.

Step 3:	 Add new data or file.

Click to add data to your map

Picture 4.12: New ArcMap file (where you can add new data or map)
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Step 4:	 On the Open page, under Open, click Computer and 
click Browse .

Note: That the folder that contains data to use must 
be connected to ArcGIS.

Click on Add, it  
will be added on 

your map (2)Select Province (1)

Picture 4.13: Add Data dialog box

The following result will be prompted to you

Province 
layer 

created

Picture 4.14: Province layer
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4.3	 Display of a layer (II)

4.3.1	 Symbolise layer
Step 5:	 If you want to change colour of the layer, double click on the 

colour, this window will open. 

Border 
width

Choose any 
colour

Choose colour of 
layer colour e.g. Blue

Picture 4.15: Symbol Selector dialog box

Step 6: Add Districts layer.

Repeat step 3 and 4.

Picture 4.16: Add Data dialog box for adding districts to the map behind
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Below screen will be displayed

Picture 4.17: Districts layer added

Step 7: To change all Districts layer colour, do the same as step 5.

Picture 4.18: Colours on Districts changed or removed

Step 8: Add lakes layer.
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Repeat step 3 and 4

Picture 4.19: Lakes added to the map

4.3.2	 Add and remove label of layer

Activity 4.3

1.	 Add province labels and districts labels to the map of Rwanda.
2.	 Remove the labels you have added in Number (1) above.
Use the following steps.

Step 1: Right click on the layer, (province).

Picture 4.20: Province layer right-clicked and properties is selected
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Step 2: 	 Click on Properties, the layer properties dialog box below 
displays.

Must be selected (2)

Click on labels (1)

Select 
province (3)

Apply changes (5)It is used to format label (4)

Picture 4.21: Layer properties dialog box. Province (Eastern) is selected

Step 3: 	 Click on Labels Tab. Perform actions 1-5 in dialog box 
above. After following steps in picture above, the results 
are shown in picture 4.23.

Picture 4.22: Provinces labels
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Step 4: Add labels on Districts layer. Right click Districts Layer.

Picture 4.23: Properties selected from Shortcut menu for District layer

Step 5:	 Select Labels Tab, as shown below.

Select District Name (1)

Click Apply and Close dialog box (2)

Picture 4.24: Layer Properties dialog box. Labels Tab selected
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After performing actions 1 and 2 with the Layer properties box 
above, the result will be as shown below:

Picture 4.25: Map of Rwanda with Districts Labels added

Remove labels
To remove labels on a layer, follow the steps given below;

Step 1: Right click on layer, e.g Districts then select properties.

Unselect this 
feature (1)

Click OK (2)

Picture 4.26: Layer Properties dialog box showing how you remove labels

Step 2: Click OK at the bottom of layer properties dialog box.



106

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

Activity 4.4

a)	 Using the Activity 4.3, remove labels on provinces and then 
add labels on lakes.

b)	 Add rivers layer and apply labels on it.

4.4	 Map layout
The basic 4 elements that a map should have: title, legend, scale, 
date, author, orientation and text. We will show how to insert them in 
a map as an activity. Follow the steps given on each element.

4.4.1	 Insert Legend
Using the map of Rwanda we used in previous activities, follow steps 
given below to insert a legend.

Step 1:	 Change from 
data view to 
Layer out view. 
Use view button 
or view menu 
on the lower 
left side of 
the Arch map 
window.

Data View

Layer out View

Picture 4.27: Main View buttons

Step 2:	 Click on Insert 
menu, then 
Choose Legend. 

Picture 4.28: Inserting a legend
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Follow the instruction given by ArcGIS, Then after click OK.

Picture 4.29: A map with a legend

4.4.2	 Insert Orientation 
Step 1:	 Click Insert menu.

Step 2:	 Choose  North Arrow

Pick your selection 
and click OK

Picture 4.30: North Arrow Selector
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Step 3: 	 Select how to use, then Click OK

Picture 4.31: A map with a compass

4.4.3	 Insert Scale 
Step 1:	 Repeat step 1 and 2, above (under Insert orientation).

Step 2:	 Select Scale bar.

Step 3:	 Scale Bar dialog box will be displayed, then choose the scale 
you want to use, then click OK.

Picture 4.32: Scale Bar Selector dialog box
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Step 4:	 A map with scale is displayed as shown below.

Scale

Picture 4.33: A map with scale

4.4.4	 Insert Text 
There are several kinds of text you can insert in a map. Text can be 
meaningful words, characters or numbers placed on a map. To add 
text, follow steps given below:

Step 1:	 Click Insert menu, point to Dynamic text.

Picture 4.34: Inserting Text in ArchMap
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Step 2:	 Select text category you want to insert e.g Author, Document 
Name, etc.

4.4.5	 Insert Title
Step 1:	 Click on Insert menu.

Step 2:	 Select Title.

Step 3:	 Type text as title in the dialog box that displays.

UGANDA

DRC

Picture 4.35: A map with Text And Title
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4.5	 Use Page and Print Setup Menu
The purpose of page and print setup is to organise your map ready for 
printing.

Activity 4.5

Perform a page and print setup of the map you added in the 
previous Activity (4.3). Follow the steps below:

Step 1: 	 Navigate to File > Page and Print Setup.

Choose this 
option

Picture 4.36: Accessing Page and Print Setup from File menu

Step 2:	 Select the printer.

Step 3:	 Select the Printer Paper size and orientation for the 
map. See the link in the Related Information section for 
information on setting up a custom page size.
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Select a printer (1)

Select a printer paper size (2)

Check here (3)

Select Orientation

Check OK (4)

Picture 4.37: Page and Print setup dialog box

Step 4:	 Check, if the map has already been created, on ‘Scale 
map elements proportionally to changes in map size’ at 
the bottom of Print and Print Setup dialog box.

Step 5:	 Select ‘Use Printer Paper Settings’. This grays out the 
bottom section, Map page size, because the map is now 
using the Printer paper size and orientation settings.

Step 6:	 Click OK.
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4.6	 Save and send a map
To save a map is to store it for future references using a specific name 
and location on a storage device. To save or export a map is to prepare 
the map in format that can allow it to be easily moved or exported from 
one computer to another.

Save a map
Follow steps below:

Step 1:	 Click File menu and select “Save As...”

Click on Save As

Click Print to access 
print dialog box for 

printing a map

Picture 4.38: Saving a map
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Step 2:  Choose the location and the name of the map.

Location where 
map is saved

Map name

ArcMap Document

Picture 4.39: Save As dialog box for saving a map

Export a map
Prepare to send your map by following the steps given below:

Step 1:	 Click on File menu then click on Export Map
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Click here

Picture 4.40: Accessing Export Map from File menu

Step 2:	 In the Export Map dialog box, type the file name and select 
the file format.

Type file name

Select File Format

Picture 4.41: Export Map dialog box
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End of Unit 4 Assessment

1.	 Given Rwanda administrative boundaries data ,open a new 
map document and add the following data on the map:
a)	 Provinces
b)	 Districts
c)	 Sectors
d)	 Rivers
e)	 National parks

Then do the following:
(i)	 Add label to each layer.
(ii)	 Insert legend, scale and orientation.
(iii)	 Insert map title, author and date.
(iv)	 Export the map in pdf file and send it to your 

teacher’s email.
2.	 Given the map of Kigali city, open the new map and add the 

following data.
	· City divisions.
	· Roads.

Then perform the following:
(i)	 Add a label to each layer.
(ii)	 Insert a map title, author and date.
(iii)	 Export the map in .jpg. file format.
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Unit
55

Charts and Objects in Spreadsheets

Key Unit Competence

Use Charts and Objects in a spreadsheet, use different techniques 
to organise a printable datasheet.

5.1	 Charts (Graphs) 
A chart is a graphical representation of numerical data. It is a sheet of 
information in form of a table, graph, diagram or object. 

Charts enable users to see results of data in detail, interpret and predict 
current and future data in a much easier way.

5.1.1	 Uses of charts
	࿤ Used to summarise numerical information.
	࿤ View relationships between different variables e.g. Price against 

Sales volume.
	࿤ Detect trends overtime and make forecasts.
	࿤ Search for patterns among a large amount of figures.

Note: In unit 3, we looked at how we create charts in MS 
Word and this means you already know something about 
charts. Like in MS Word, a chart is created almost the same 
way in MS Excel but the difference is in steps you take to 
create it.
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5.1.2 	 Types of charts
There are several types of charts used to present data pictorially. The 
charts mainly include; column, bar pie, line and scatter graphs. 

Activity 5.1

You are given the following data to enter in Microsoft Excel. Save 
the data as ‘ICT marks’. Use the data to create a column, bar, pie, 
line and scatter charts. (Follow steps for creating a chart in section 
5.2).

Name ICT Marks English Marks

Gahima Isaac 75 98

Teta Princess 93 55

Kundwa Isabella 85 76

Giramata Steven 67 83

Gaju Sharon 33 42

Mahoro Janet 56 61

Bugingo Vincent 31 54

Gatete John 54 84

Murekatete Annet 87 45

Ingabire Grace 78 74

Table 5.1: ICT Marks from Learners’ exercise

1.	 Column chart: A column chart displays data as vertical bars. 
If the data in table 5.1 above is entered in spreadsheet and a 
column chart created for ICT marks, it may appear as shown in 
picture 5.1.

0
20
40
60
80

100

ICT Marks

Picture 5.1: Column chart
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2.	 Bar chart: A bar chart represents data mainly as horizontal bars or 
objects.
When the data in table 5.1 is used in MS Excel to create a chart, a 
bar chart for ICT marks may appear as shown in picture 5.2.

0 20 40 60 80 100

Gahima Isaac

Teta Princess

Kundwa Isabella

Giramata Steven

Gaju Sharon

Mahoro Janet

Bugingo Vincent

Gatete John

Murekatete Annet

Ingabire Grace

ICT Marks

Picture 5.2: Bar chart

Difference between column and bar charts
A bar chart represents data using horizontal objects but a column 
chart uses vertical objects. 

Similarity between column and bar charts
Both bar and column charts represent data using bars or columns 
to compare items. The length of each bar or column is proportional 
to the data that it represents. This means that a bar or column 
corresponding to a value of 100 would be twice as long as one 
corresponding to value of 50. 

3.	 Line chart (line graph)
A line chart is a  graphic  representation of  data plotted using a 
series of lines. 

If the data in table 5.1 is used to create a line chart, it would 
appear as shown in picture 5.3.
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Picture 5.3: A line chart

4.	 Pie chart
Pie chart is a circular chart sliced into sections; each section 
represents a percentage of the whole. Pie charts do not display 
horizontal and vertical axes as other charts. 

If the data in table 5.1 is used to create a pie chart, it would appear 
as shown in picture 5.4.

Picture 5.4: A pie chart
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5.	 Scatter chart /graph
A scatterplot is graph of plotted points showing the relationship 
between two sets of data. 

A scatter (XY) plot is a graph used to plot the data points for two 
variables. Each scatterplot has a horizontal axis (x-axis) and a 
vertical axis (y-axis). One variable is plotted on each axis.

If English marks are added to Table 5.1 to have two variables, then 
the scatter plot would appear as shown in picture 5.5.

ICT and English Marks

Picture 5.5: A scatter plot

5.2	 To create a chart in Microsoft Excel
There are several charts you can create and the common ones are; bar, 
pie, column and line charts. Common charts are illustrations that are 
frequently used to represent data in figures.

To create a chart follow the steps given below;

Step 1:	 Create or open an existing workbook with well-prepared 
numerical data. In this case open a file ICT marks.

Step 2:	 Select all the cell data you need to be represented in the 
chart (including all the labels and titles).

If the data is not nearby to each other, press Ctrl as you select 
other pieces of data.

Step 3:	 On the Insert tab, in the Charts group, click on the chart type 
you want (example is Column) and then click on the sub type 
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desired from the list that displays (example is 3-D Clustered 
column).

Dialog box Launcher

Picture 5.6: Charts group of buttons on the Insert tab

Step 4:	 The new chart displays automatically as a floating object 
(embedded chart) in your data.

Using table 5.1, we create a 3-D column chart, and it appears 
as shown in picture 5.7. 

3D-column chart
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Picture 5.7: Resulting column chart created from selected numerical data

a)	 If you want the chart to remain in the sheet as object, 
drag it to appropriate position below or on the right of 
the data. You can also resize it. 

b)	 If you want the chart to be on a separate sheet do the 
following:
(i)	 On the Design tab (under Chart Tools), in the 

Location group at the right, click on the Move 
Chart button.
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Click to change your  
chart location

Apply different colours to your chart

Picture 5.8: Chart tools on the Design tab

(ii)	 In the Move Chart dialog box that displays as 
shown below, choose where you want the chart 
to be placed and click OK.

Note: Once you select data for charting, press F11 to 
place the chart on a separate sheet or press Alt + F1 to 
place it as an object in the sheet.

Select New 
sheet and then 

type a new 
name for the 

sheet (1)

Click Ok (2)

Picture 5.9: Move Chart dialog box with options for the placement of created chart

Step 5:	 The new chart will display on its page as shown in picture 
5.10(a). Label your chart by applying chart title, x-axis title 
and y-axis title.
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Gahima  
Isaac

Akimana 
Princess

Uwimana 
Isabella

Ngombwa 
Steven

Butera 
Sharon

Malisaba 
Janet

Ntwali 
John

Rugero 
Amos

Niwobyose 
Grace

Dusabimana 
Vincent

Picture 5.10 (a):  Quick Layout menu with Layout 9 selected to apply to the chart

5.2.1	 How to apply a predefined chart layout to your 
chart

Use the steps given below to apply chart layouts on the charts (column, 
bar and line charts) you created in Activity 5.1.

Step 1:	 Select the chart/graph.

Step 2:	 On Design tab, in the Chart Layouts group, click Quick 
Layouts button. On the list of layouts, select Layout 9 (or you 
can select any other desired).

Step 3:	 Replace the default text in the x-axis, y-axis titles and Chart 
title with learners’ names, marks in percentages and a chart 
showing learners performance in ICT, respectively.

Note: For the chart to be easier to understand, titles 
must be added i.e. chart title and axis titles.

If the column chart in Activity 5.1 is changed to a 3-D column chart and 
labelled, it appears as shown in the screenshot. See picture 5.10(b).
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Gahima  
Isaac

Teta  
Princess

Kundwa 
Isabella

Giramata 
Steven

Gaju 
Sharon

Mahoro 
Janet

Bugingo 
Vincent

Gatete  
John

Murekatete 
Annet

Ingabire 
Grace

Picture 5.10 (b): A labelled 3-D column chart on a separate sheet

Activity 5.2

1.	 Organise the following data in Microsoft Excel.

Month Mean Temperature (oC) Mean Rainfall (mm)

January 5.6 3.5
February 7.2 7.5
March 7.5 7.2
April 9.5 8.9
May 13.8 12.5

June 16.5 25.9
July 17.5 28.6
August 17.9 29.7
September 18.7 32.8
October 18.9 35.2
November 19 9.5
December 19.2 5.3

Table 5.2: Rain – temperatures Data
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a)	 Create a 3-D line chart to display information in table 
5.2.

b)	 Apply labels and title on your chart. Save your work as  
‘Rain-temperatures’ and print your work.

2.	 The data in table 5.3 shows Animal data between the years; 
1991 and 2000. Enter the following data using Microsoft 
Excel.

Year Sheep Cattle Goats Pigs

YR 1991 29,505 48,575 85,950 121,056

YR 1992 35,850 55,679 98,750 132,980

YR 1993 48,599 67,692 105,670 157,091

YR 1994 1,345 5,431 9,257 4,690

YR 1995 2,984 9,429 15,790 6,900

YR 1996 3,695 10,764 21,052 10,950

YR 1997 4,675 13,075 32,109 15,070

YR 1998 5,250 15,872 39,027 25,900

YR 1999 5,664 18,546 45,830 35,092

YR 2000 6,679 23,005 56,049 38,950

Lowest number

Highest number

Average number

Table 5.3: Animal data

a)	 Copy the information above onto sheet 2 and then include 
one decimal place on all the figures.

b)	 Apply a suitable border on all the data.
c)	 Determine the lowest, highest and average livestock for 

each category given.
d)	 Use appropriate range of data series to represent the data 

for the year 1991 on a pie chart . Place your chart on a  
separate sheet and name the sheet YR1991.

e)	 Represent the data for the years; 1991, 1992, 1993, 
1994, 1995, 1996 and 2000 on a 3D- column chart.
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5.2.2	 How to apply a predefined chart style
A style is a format clearly created which you can use to improve 
appearance of your chart. Follow the steps below, using the chart you 
created in Activity 5.1.

Step 1:	 Click in the Chart that you want to apply a style. The Chart 
Tools will display.

•	 On the Design tab, in the Chart Styles group, click the 
chart style you want to use.

If a chart style is applied to picture 5.1 we created in Activity 5.1, the 
results are shown in picture 5.11. 

A Chart Showing Learners’ Performance in ICT

Picture 5.11: A chart on which a style has been applied

5.2.3	 Creating a combination chart
A combination chart contains data series plotted using more than one 
type of chart.

We are going to group to use the data below to create a combination 
chart.
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Day Temp Sales

Monday 15.2 12000

Tuesday 17.4 32500

Wednesday 14.9 18500

Thursday 16.2 32000

Friday 19.5 40000

Saturday 25.1 52500

Sunday 22.4 41500

Table 5.4: Data about Sale unit versus Temperature of the day

Steps to create a combination chart
Step 1:	 Create a chart containing all the data you want.

Start by entering the data in spreadsheet software and save it as Comb.

Select Change Series 
Chart Type

Picture 5.12: Data is entered and selected (a) and a line chart showing desired 
data series right clicked (b)

Step 2:	 Right click on the data series you want in the chart.

Step 3:	 Select the Change Series Chart Type from the shortcut menu.

Step 4:	 Select a different chart type and then observe the changes.
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Choose a 
chart type 

for each data 
series and a 
secondary 

axis if 
required

Click OK to display the chart

Combination 
chart with a 

secondary axis

Combo is selected

Check to apply secondary axis

Picture 5.13: A Custom combination chart

Note: When a combination chart is created, it is important you 
apply two vertical scales.

5.2.4	 Change chart type
We are going to use ICT marks file to change chart type. Begin by 
opening the column chart as picture 5.10(b) and follow the steps 
given below.

Step 1:	 Select the chart you want to change.

Step 2:	 On the Design tab in the Type group, click Change Chart 
Type.

You can also right click the chart and select Change Chart 
Type.

Step 3:	 In the Change Chart Type dialog box that displays, select the 
chart type and sub type you want.
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Select a chart 
sub type

Select a 
chart type

Picture 5.14: Change Chart Type dialog box

Step 4:	 Click OK.

In case you select a Bar Chart, the resulting chart will appear as shown 
in picture 5.15. 

Ingabire Grace

Murekatete Annet

Giramata Steven

Kundwa Isabella

Teta Princess

Gahima Isaac

ICT Marks

Marks in percentages

0 20 40 60 80 100

Gatete John

Bugingo Vincent

Mahoro  Janet

Gaju Sharon

A chart showing Learner’s performance in ICT

Le
ar

ne
rs

’ N
am

es

Picture 5.15: Chart type changed from column to bar chart
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Activity 5.3

Create the following data in Microsoft Excel as it is and save it as 
Exam Results. The figures are in percentage pass at credit level.

Ordinary Level Examinations Results for 2016

Subject Boys Girls

Biology 36.6 30.49

Physics 29.8 22.27

Chemistry 32.5 23.4

ICT 36 38.9

Geography 19 29.2

Mathematics 28.79 25.6

Kiswahili 38 38.3

Kinyarwanda 27.7 28

Business Studies 26 26

English 33 38

Table 5.5: Ordinary Level examinations data

a)	 Set the number of decimal places to 1.
b)	 Create a 3D-clustered column chart on a separate sheet to 

display the data given in the table above. Name the sheet as 
‘3D results’.

c)	 Apply a chart layout that includes all titles to your chart.
d)	 Format the plot area to a pattern fill having a yellow (50%)

colour in the foreground and white in the background. 
e)	 Change the fill colour for Data Series ‘Boys’ to purple and ‘Girls’ 

to a gradient fill with a red colour and black colour.

5.3	 Formatting chart
To format a chart is to change the appearance of a chart so as it looks 
attractive. You can format chart background colours and patterns, 
legend, axis and labels. Now open ICT marks file to get a saved bar 
chart, as shown in picture 5.15.
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Follow the steps below to format chart
Step 1:	 Create or open an existing chart in MS Excel.

Step 2:	 Click or select any part of the chart e.g. Chart Area, legend, 
horizontal axis or horizontal axis title, vertical axis or vertical 
axis title, data series, etc.

colour

Picture 5.16: A chart whose area has been formatted

Step 3:	 On Format tab, in the Current Selection group click Format 
Selection. The task pane displays (on the right of Excel 
window) showing Chart Options to format Chart Area. The 
task pane displays Chart Options depending on the part you 
have selected. 

This title denotes part of the 
chart that has been selected

Effects

Fill & Line 
selected

Size & 
Properties

Click Fill and then select the type 
of fill to apply on the chart area e.g. 

gradient fill, pattern fill, etc

Click border to select a line style, 
gradient line, solid line or automatic

Picture 5.17: Format options for formatting Chart Area

Alternatively, you can format a chart quickly by right clicking 
on any part of the chart you want to format. In the Shortcut 
menu, select Fill Colour or Line colour you want.
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Click Format 
Plot Area to 

display the Task 
pane to format  

it

Change Chart 
element to 
format from 

here

Chart Area

Plot Area

Picture 5.18: Plot Area of a column chart right-clicked to display shortcut menu

5.4	 Format cell data as a table
Cell data is any piece of data you want to format as a table contained 
within spreadsheet cells.

Steps to format cell data as table
Step 1:	 Select the spreadsheet data you want to format as table or 

click in it (must be nearby each other). In this case, open 
Comb file.

Step 2:	 On the Home tab, in the Styles group, click Format as Table 
drop down list and select a desired table style from the list.

Select a 
desired 
table 

design (3)

Select data (1)

Click 
Format as 
Table (2)

Selected 
design

Picture 5.19: Selected data to be formatted as a table using inbuilt table designs
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Step 3:	 Format as Table dialog box appear, click OK.

Picture 5.20: Format as Table dialog box

Step 4:	 Table Tools display on the Design tab. Use Table tools to 
modify your table as desired. 

Picture 5.21: Data in comb file formatted as table

5.5	 Printable datasheet
Before you print a worksheet, it is important that you set a print area. 
Printing is the action of producing a hardcopy information using a 
printing machine such as a printer or printing press. Page setup options 
control the layout of a printed sheet and therefore must be used before 
a worksheet is printed. Page setup options include; margins, headers 
and footers.

5.5.1	 To set page margins
Use the data given in Comb file and use it to set page margins. Follow 
the following steps.
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Step 1:	 On the Page Layout tab, in the Page Setup group, click 
Margins and in the menu select “Custom Margins”.

Picture 5.22: Part of MS Excel window showing how to access Custom Margins on 
Page Layout tab

Step 2:	 In the Page Setup dialog box for Margins, increase or reduce 
the margins and click OK.

Click to insert header/
footer

Type new values to set 
page margins, (at Top, 
Bottom, Left or Right 
of the page). You can 
also change Header 
and Footer values

Click Print to display 
Print dialog box

Click Print Preview 
to see how the  

sheet will appear  
when printed

Picture 5.23: Page Setup dialog box displaying features for changing page margins
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5.5.2	 Set headers and footers
A header is information printed at the top of every page and footer is 
information printed at the bottom of every page. Headers are suitable 
for Company names, page titles; footers are good for page numbers 
and printout dates or times. 

Note: Headers and footers are not displayed on the worksheet in 
normal view.

On ordinary worksheets you can Insert header/footer by clicking on 
Insert tab, in the Text group, click Header/Footer. Automatically the 
cursor goes in the centre of the header.

Insert header/footer (for chart sheet)
Follow the steps given below to insert header and footer.

Step 1:	 On the Page Layout tab, in the Page Setup group, click dialog 
box Launcher.

Step 2:	 In the Page Setup dialog box that displays, click on Header/
Footer tab.

Step 3:	 Click on Custom Header to insert your header or Custom 
Footer to insert footer.

Step 4:	 Click in the Left section, Centre section, or Right section 
box, and then click the buttons to insert the header or footer 
information that you want in that section.

Dialog box Launcher

Picture 5.24: Page Layout tab displaying Page setup group of commands

The page setup dialog box is shown in picture 5.16, if you click either 
Custom Header or Custom Footer, the Header or Footer dialog box 
displays. To add or change the header or footer text, type additional 
text or edit the existing text in the Left section, Centre section, or 
Right section box. 



139

Charts and Objects in Spreadsheets

Currently used  
header

Click to access a list 
of inbuilt Footers

Click on this button 
and type in custom 
Footer information 

you want

Click Print to get print settings 
for printing your worksheet

Click custom header and type 
header information either left, 

centre or right aline.

Picture 5.25: Page Setup dialog box displaying Header/Footer options

When you click on Custom Header or Custom Footer you get a Header 
and Footer dialog box respectively. When you use these dialog boxes, 
you can position your text or object in the left, centre or right section of 
the page in the header and footer. 

Get screen tips  
here to know the 
names of these 

buttons. Just point 
at each.

 Read this text and  
learn more on how to 

use this dialog box

Use this button to apply page numbers

Use these buttons 
to apply date and 

time

Picture 5.26: Footer dialog box with footer text in centre section
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Header/Footers are displayed only in Page Layout view and on the 
printed pages. You can insert headers or footers in Page Layout view 
where you can see them, or you can use the Page Setup dialog box if 
you want to insert headers or footers for more than one worksheet at 
the same time. 

For other sheet types, such as chart sheets, you can insert headers and 
footers only by using the Page Setup dialog box. 

Click to print 
worksheet

Type in the number 
of copies to print

Print Preview
Shows actual 
appearance  
before print.

Select a printer 
to use if more 

than one printer 
is available or if 

you often change 
printers

Footer information

Change print 
setting from 

here

Zoom to page

Picture 5.27: The Back Stage View showing options for printing a worksheet

In Microsoft Excel 2016, when you want to print or get a print preview, 
you always get the same screen similar to the one in the picture above. 
On File tab, click Print or press Ctrl + P on keyboard. 

The following important commands are available in the screen
Zoom: Magnifies the page to actual size. This button is located on the 
lower right.

Print: Sends a copy of the worksheet to the default printer.
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Page Setup: Displays page setup dialog box.

5.5.3	 Print area 
This is one or more ranges of cells that you designate to print when 
you don’t want to print the entire worksheet. This means only the print 
area set is printed.

A worksheet can have multiple print areas. Each print area will print 
as a separate page. 

To define or specify the print area
Use the steps given below to specify print area. Use data give below.

Step 1:	 Create or open an existing worksheet.

Step 2:	 Select the cells you want, define as print area (data range).

Step 3:	 On the Page Layout tab, in the Page Setup group, click Print 
Area, and then click Set Print Area.

Picture 5.28: Part of MS Excel window showing how to set Print Area from Page 
Layout tab

Note: A line around the data marks the print area. When 
you save a worksheet the print area is also saved. 

Use the same steps given above to add and clear the 
print area. 
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5.5.4	 Printing a Chart
If you want to quickly print the chart which is part of the data, select/
click it and press Ctrl + P on keyboard. Click print button to print 
using default printer.

If the chart is on a separate sheet; select Print on the File tab, then 
click print button to print from default printer.

End of Unit 5 Assessment

1.	 A business consultancy firm advertises in the local newspaper 
and it spends different amounts of money on advertising and 
records the number of appointments booked from different 
adverts as shown in table below.

Required
Produce a scatter graph (with smooth lines and markers) from 
the data given in table below to see any correlation between the 
amount spent on adverts and the appointments booked. 

Amount spent on adverts in 
(Rwanda Francs)

Number of appointments 
booked

15,000 47

25,000 48

35,000 60

50,000 65

85,000 100

120,000 180

150,000 200

250,000 420

Table 5.6: Business data on consultancy firm

Label and save your graph as ‘business’.
Print your graph.
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2.	 Use a suitable spreadsheet software on your computer and 
enter the following data beginning from cell A1 on sheet1. Save 
the file as Results.

A B C D E F G

1 Name English Science Math Social 
Studies

Total Average 

2 Gatete Isaac 78 98 87 76

3 Teta Princess 90 55 90 98

4 Keza Isabella 85 76 65 54

5 Bugingo Stephen 67 83 34 76

6 Ingabire Sharon 33 42 12 84

7 Mutesi Janet 56 61 45 91

8 Kwizera Vincent 21 54 87 43

9 Gisa John 54 84 54 65

10 Giramata Amos 83 95 32 83

11 Mugisha Grace 74 74 54 93

12

Table 5.7: Data on examination results

Required
a)	 Create a 2D-clustered column chart to represent learners’ 

performance in Science and Social Studies. Label your 
chart correctly on a separate sheet. Name the Sheet as 
2ESS. Format your chart appropriately.

b)	 Create a 3D-clustered column chart to represent all 
learners’ performance in the four subjects. Place your 
chart on a separate sheet you name as ‘Comparison’. 
Format your chart as desired.

c)	 Use a suitable formula to calculate the total marks and 
average marks in the total column and average column 
respectively. Represent the total and average marks on a 
stacked line chart. Place the chart as an object on sheet2. 

d)	 Create a pie chart as an object on sheet3 to represent the 
performance of learners in Math only.
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3.	 Mrs Gaju has a wholesale shop selling Mineral water. The shop 
is located in one of the suburbs of Kigali City. Last week she 
decided to record track of how many bottles of mineral water 
she sells versus the noon temperature of that day. The figures 
for 7 days are as shown below: 

Mineral water vs Temperature

Temperature °C Mineral water (Rwanda Francs)

15.2 1200

17.4 3250

14.9 1850

16.2 3200

19.5 4000

25.1 5250

22.4 4150

Table 5.8: Data on Gaju’s sales

a)	 Organise the data in a spreadsheet and save it as Gaju sales.
b)	 Create a combination chart (temperature with a column chart 

and sales on a line chart). Apply different vertical scale for 
sales, a chart on a separate sheet. Name sheet as ‘mineral 
water’.

c)	 Apply titles or otherwise use a suitable Quick layout on your 
chart that can make it more organised.

d)	 Insert header as your Names and footer as Page numbers.
e)	 Print your charts on separate sheets that contain suitable 

headers.
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Unit
66

Presentation

Key Unit Competence

Prepare and make a presentation.

6.1	 Presentation 
A presentation is an organised report or message prepared as a talk 
before audience, with the help of a computer program. Examples of 
programs/software which you can use to create presentations include 
among others the following: Microsoft PowerPoint, Harvard Graphics, 
Corel Presentations, Open Office .org Impress, Lotus Freelance 
Graphics, Kingsoft Presentations, etc.

Presentation software is a program used to create slide shows for 
presentation on screen to an audience. Presentation program/software 
can supplement or at times can replace use of visual aids like handouts, 
chalkboards, posters, etc. 

6.1.1	 Role of presentation applications
	࿤ Conveying information about an important issue such as disease 

control measures.
	࿤ Introducing a new idea for business.
	࿤ Reporting progress using charts or graphs.
	࿤ Training by demonstrating how it is done by using screen recorder 

or animation programs.
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6.1.2	 Working with (Microsoft) PowerPoint presentation
Microsoft PowerPoint is a presentation graphics software commonly 
used when you plan to give a talk as a presentation. The purpose of 
the talk may be to inform, create awareness, present strategies or to 
sell a product or service. PowerPoint presentations can be done on 
computer screen if the audience is very small. If the audience is large 
the computer can be connected to a projector that projects the image 
onto a large screen/wall.

Using PowerPoint, you can create speakers’ notes or handouts for 
conveying information to the audience.

When using Microsoft PowerPoint, the data file you create is known as 
a Presentation. Each presentation is made up of one or more slides. In 
the case of this unit PowerPoint 2016 is going to be used.

6.1.3	 Launching Microsoft PowerPoint presentation
Step 1:	 Click Start button and select All apps

Shortcuts for 
PowerPoint 2016. 

Select a desired icon

Picture 6.1: The Start menu for Windows 10 showing PowerPoint 2016 selected
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Step 2:	 Scroll down and select PowerPoint 2016 (or click Microsoft 
Office and then select Microsoft PowerPoint).

Alternatively click in the Search box on Taskbar, type in 
PowerPoint 2016 and press enter key on your keyboard.

Program name is displayed 
as number 1 in the list

Name of the program 
typed in the search box 

on Taskbar

Picture 6.2: The Search box 

Step 3:	 The Presentation Gallery displays as shown below. Select the 
Blank Presentation with a new slide, to begin from scratch.

Select Blank 
Presentation 
to begin from 

scratchSelect your recently 
created file from here

Picture 6.3: The presentation Gallery
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Slide title 
placeholder

Slide subtitle / 
body content 
placeholder

Picture 6.4:	 MS PowerPoint Window with blank presentation 

Step 4:	 You can now add text, pictures or objects to the slide(s) to 
enhance its appeal. Afterwards save your presentation.

Activity 6.1

Create and save a presentation with microsoft power point.

6.1.4	 Saving a presentation
When you open MS Powerpoint by default you have created a 
presentation. In this case add pieces of data e.g. level of sanitation in 
your school.

Follow steps below to save a presentation

Step 1:	 On the File tab, click Save As to get the backstage view for 
Save As. See picture 6.6.

Step 2:	 Select a location or browse a location to save your file. The 
Save As dialog box displays, (as shown in picture 6.6).

Step 3:	 Type in the desired file name (see picture 6.7) and then click 
Save.
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Note: By default, PowerPoint 2016 save files in the 
PowerPoint Presentation (.pptx) file format. To save in 
another file format, click on the Save As type list and 
select the file format you want. 

Click Browse to select a 
particular location on the 
computer to save your file.

Locations 
previously 
used to 

save files on 
computer 

(you can also 
use them to 
save files)

Picture 6.5: The Save As Backstage view

Note: Access quickly the Save As Backstage view by pressing 
Ctrl + S on keyboard or clicking Save button on the Quick 
Access Toolbar.

Save 
button undo Redo 

Start from beginning (F5)
(For Slide shows)

Picture 6.6: The Quick Access Toolbar showing frequently used commands
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Type file name in 
the file name box

Change your 
view from here

Click Save to save your file  
in a specified location

Destination folder
Sc
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Picture 6.7: The Save As dialog box

Step 5:	 Close the application window or file created.

6.1.5	 Opening an existing presentation

Activity 6.2

Open an existing presentation you saved previously Activity 6.1 or 
open any other presentation earlier created.

Follow the steps given below to open an existing presentation.

Step 1:	 Start Microsoft PowerPoint program.

Step 2:	 On the File tab, click Open. The Open Backstage view opens. 
See picture 6.8.
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Recently opened files. If 
your file is listed here, click on 

it to open

Click Browse to find your file on 
the computer from a location e.g. 

Documents or external drive

Teta Carol

Picture 6.8: The Open Backstage view, showing recently opened files and locations 
to find your file

Step 3:	 Select a location where your file is located or browse in folder 
to find the file. In the Open dialog box , in the File name box, 
type the name of the file you want to open (or scroll, locate 
and double click on the file).
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Step 4:	 Click Open button and the file will open.

Click Open to open a selected file

Click on a file you 
want to open or 
type file name in 
the File name 

box
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Picture 6.9: The Open file dialog box

Note: After starting PowerPoint, you can quickly access the open 
Backstage View by pressing Ctrl + O on the keyboard. 

Other methods for opening an existing presentation
Step 1:	 Click Start button.

Step 2:	 In the Search box, type the file name and press ‘Enter’ key on 
keyboard.



155

Presentation

Type a filename here 
in the Search box

The file name typed displays as 
number (1) in the list. Click on  
it or press enter key to open it

Picture 6.10: The Desktop showing a filename typed in Search box on the Start
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6.2	 Components of presentation 
environment

Microsoft PowerPoint 2016 has a number of tools, panes, buttons, 
bars, etc which help the user achieve his/her task. The window below 
shows different components of PowerPoint 2016environment:

Drawing tools on Format tab automatically 
appear when you click in or draw a  
textbox or shape; use these tools to  

format textbox, shapes or arrange shapes

Vertical Scroll Bar

Body content

Slide title

Slide pane

Click to display Notes Pane 

Slide navigation 
pane

Maximise button (makes window fill the whole screen).

Close button (closes the presentation).

Save button.

Quick access toolbar.

View buttons 
Change to slide sorter or slide show from here 

Apply Shadow to heading from here 

C
lic

k 
he

re
 t

o 
cr

ea
te

 a
 n

ew
 s

lid
e

Choose Slide Layout 
from here 1

1

2

3

4

2

4

3

• Ikinyarwanda

• Geography

Picture 6.11: MS PowerPoint window showing main features
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6.3	 Slides
A slide is a single page of information in a presentation created with 
programs such as PowerPoint or Corel Presentation. A presentation is 
made up of one or several slides.

Activity 6.3

Rwanda Government has made a significant progress in protecting 
the environment. Create a presentation about Environmental 
Protection in Rwanda and save the presentation as “Nature-
protect”.

Note: We shall use this presentation later to learn many features 
of a Microsoft PowerPoint presentation.

Use the following steps to create the presentation
Step 1: 	 Open a blank presentation.

The presentation opens with only one slide

Picture 6.12: A blank presentation

Step 2: 	 Type the title as Environmental protection in Rwanda.

Step 3: 	 Type the  sub title as Environmental Protection is the 
practice of protecting natural environment to benefit 
humans and environment itself. 

Save your presentation as “Nature-protect”.
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Environmental protection is the practice of protecting natural
environment to benefit humans and environment itself in Rwanda.

Picture 6.13: A presentation where data has been added on the first slide

6.3.1	 Insert a new slide
After working on the first slide, you need more slides to complete your 
presentation. Open the file Nature-protect that you have created. 

To get new slides, do the following: 

On Home tab, click New Slide button (or just press Ctrl + M on 
keyboard). See picture 6.14. Add the following data on the new slide.

Click white 
button to add 

a new slide

A new slide 
inserted and  
is selected

Picture 6.14: A presentation with a new slide
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Add the following data to the new slide (Slide 2): Add title as “Rwanda 
Environmental Problems”. Add bulleted text as shown below.

	࿤ Land degradation
	࿤ Deforestation
	࿤ Wetland and biodiversity loss
	࿤ Natural causes 
	࿤ Man-made disaster 
	࿤ Reduction of water resources
	࿤ Human settlements 

Note: since we are using a Presentation program, we are not 
supposed to write details on points. Details are explained when 
giving the presentation to your audience. 

Add the following slides in your presentation
Slide 3:	 Title as “Causes of Environmental Problems in Rwanda”. 

Text in bullet style as; 
	· Population growth and pressure on land
	· Declining resources 
	· Over exploitation of natural resources 
	· Land scarcity 

Slide 4:	 Title as “Rwanda Environmental Management Authority 
(REMA)”. 
Text as;
	· REMA is Government organ responsible for execution of 

environment related policies and laws in Rwanda. 
	· REMA designs policies and procedures used to conserve 

natural resources, preserving the state of current 
environment and where possible reversing its degradation.

Slide 5: 	Title as “How to protect environment in Rwanda”. 
Text as;
	· Harvest rain water and conserve all waters for proper use
	· Use biodegradable items and practice re-using packaging 

products.
	· Join with others in cleaning wells, roads, beaches or riversides
	· Plant native trees plus flowers that bees like
	· Raise awareness of threats to nature
	· Use alternative source of energy other than wood
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Slide 6:	 Title as “Rwanda Environmental Features” 
Text as;
	· Natural environment e.g. relief, climate, vegetation
	· Natural resources and biodiversity 

	¤ Soil and subsoil e.g. mineral deposits like gold 
exploited on small scale

	¤ Wetlands such as lakes, rivers
	¤ Forests and protected areas
	¤ Biodiversity i.e. plant and animal species that need 

protection
	¤ Energy resources such as wood fuel, plant residues 

and biomass.
	· Human environment e.g. human settlements.

6.3.2	 To cut or copy and then paste slides
Use the open file, Nature-protect to cut or copy slide(s). Follow the 
steps given below.

Step 1:	 In the Slide Navigation Pane, click on the slide you want to 
cut or copy. In this case select slide 6 or right click on it as 
shown in picture 6.15.

Step 2:	 On the Home tab, in the Clipboard group, click Cut or Copy 
button.

C
lic

k 
Pa

st
e 

bu
tt

on
 - 

3

Select cut command -2

Selected slide 6 is 
right-clicked -1

Picture 6.15: A developed presentation showing how you access shortcut menu to 
cut/copy a slide
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Step 3:	 Click in the destination place and then on the Home tab in 
the Clipboard group, click Paste button.

In our activity right click below slide 6 and then select paste.

To copy and paste a slide
Repeat steps 1 above and in the shortcut menu select copy. Lastly click 
in the destination point and choose paste from the shortcut menu. 

Note: When you cut a slide it disappears from its original location 
and goes to the clipboard, but when you copy a slide, a copy of it 
remains and another copy is taken to the clipboard.

6.3.3 Apply design theme in a presentation
By using the file “Nature-protect”, we are going to apply a design 
theme to our presentation using the steps given below.

Step 1:	 Click on the Design tab.

Step 2:	 From the Themes group select a theme you want. (See picture 
6.16)

Select a Theme 
Variant you want for 

selected theme - 2
Select slide size 

(Optional)

Selected Theme 
-Facet - 1

Picture 6.16: A presentation where a (Design) Theme has been applied

Step 3: 	 Select a Theme Variant in case you need it and then save 
changes to your presentation. A theme variant is a set of 
colors that will appear in a theme.
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6.4	 Objects
An object is something that you can see or touch.In Presentation 
software such as Microsoft PowerPoint, the shape of an object can be 
drawn or inserted from another source.

There are several objects that you can insert in presentation software. 
These include: Textbox, Images, Table, Clip Art, Word Art, Smart Art, 
Shapes, Charts and Media Clips.

6.4.1	 Textbox 
This is a box in the program from where the user can type or edit text, 
dates or numbers. A textbox can be drawn and used to place text in a 
particular location you want in your presentation. 

There is a difference between text placeholder and textbox. A place 
holder, is a predefined part of slide where information can be inserted.
You cannot insert a text placeholder in a slide since it is part of the 
layout for your slide and exists when you insert a new slide but textbox 
need to be inserted manually.

Activity 6.4

Open “Nature-protect” file. Add Textbox in the upper middle part 
of slide 1 and type in your names. Repeat the same action for all 
the slides in the presentation. Follow the steps given below for 
Inserting textbox:

Step 1:	 On the Insert tab, click Textbox command from the Text 
group. The pointer changes to upside down cross.

Click Textbox 
button (1)

Draw Textbox 
and add text (2)

Picture 6.17: A presentation where a textbox is added in the upper middle of 
the slide
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Step 2:	 Move the pointer to the location where you need to draw 
the textbox and then draw it. Automatically the insertion 
point appears in the textbox to indicate where text will 
appear when you type it.

Step 3:	 Type in your information (i.e. your names) in the textbox. 
If you move the textbox in another place, the text will 
move together with the textbox.

6.4.2	 Images 
An image is the actual picture or mental picture of something. Adding 
pictures can make your presentation more interesting and attractive. 

You can insert a picture from a file on your computer onto any slide.

Activity 6.5

Open the file Nature-protect. In it add a suitable picture on the 
lower middle of each slide from your computer or another location. 
The picture may be the same or different. Save the changes to your 
presentation.

To insert a picture in a presentation
Select a slide where you need a picture. In this case select  slide 1 
in Nature-protect file to add a picture.

Step 1:	 Select the Insert tab, then click the Pictures command in 
the Images group.

Picture 6.18: The ribbon showing pictures button selected on the Insert tab
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Step 2:	 Insert Picture dialog box will appear. Locate from your 
PC and select a desired image file, then click Insert.

Picture 6.19: Insert Picture dialog box showing pictures on the PC that can be 
added to a slide

Step 3:	 The picture will display on the currently selected slide. 
Repeat step 1 and step 2 for the rest of the insertions. 
Alternatively copy the picture and then right-click on each 
and every slide as you select paste.

inserted Picture 

Picture 6.20: A slide presentation where a picture is added in the lower middle 
of the slide
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Note: You can also click the Pictures command in the 
slide placeholder to insert images (for new slides).

Pictures 
command

Picture 6.21: Slide placeholder showing some commands (e.g. pictures) to 
insert objects on a slide

6.4.3	 Inserting online pictures (Clip Art)
In case you don’t have a desired picture on your computer, you can 
find a suitable picture online and then add it to your presentation. In 
PowerPoint 2016, Online pictures are used instead of ClipArt that exist 
in earlier versions of the program.

Activity 6.6

Open “Nature-protect” file and add 2 suitable online pictures on a 
new slide (slide 7).
Use the following steps to add online pictures to Nature-protect 
presentation;

Step 1:	 Insert a new slide after the last slide.

Step 2:	 On the Insert tab, in the Images group, click Online 
Pictures command.

Picture 6.22: The ribbon showing selected Online Pictures command on the 
Insert tab
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Step 3:	 The Insert Pictures dialog box will appear as shown 
below.

Picture 6.23: The Insert Online Pictures dialog box

Step 4:	 Choose Bing Image Search.

Step 5:	 Press the enter key. Your search results will appear in the 
dialog box.

Picture 6.24: The Online search results
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Step 6:	 Select the desired image, then click Insert.

Step 7:	 The image will appear on the currently selected slide.

Picture 6.25: A new slide with an online picture

You can also select Online Pictures command in a placeholder to 
insert online images

Picture 6.26: Slide placeholder showing commands (e.g. online pictures) to 
insert objects on a slide

6.4.3.1	 Moving and resizing pictures/images
Once a picture is inserted, it may require you to move it in a different 
location on the slide or change its size.
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6.4.3.2	 To move a picture
Click and drag to move a picture to a new location you want on a slide. 
See picture 6.27.

6.4.3.3	 To delete a picture
Select the picture and then press backspace or delete key on your 
keyboard.

6.4.3.4	 Resizing picture
Follow the steps below:

Step 1: 	 Click on the picture. The picture will display selection circles 
as shown in picture 6.27.

Step 2: 	On the Format tab, click on Shape height and or Shape 
Width using existing arrows.

Resizing 
buttons

Picture 6.27: A slide with a picture moved and resized to small size

Note: Alternatively, after clicking on the picture, point to one of 
the selection circles until the pointer changes to double pointed 
arrow. Then click and drag outwards to increase size; or inwards 
to reduce the size.
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6.4.4 	 Table 
A table is made of rows and columns. A row is a space between 
two horizontal lines in a table while a column is a space between 
vertical line. Data or information can be arranged using these rows 
and columns.

Methods
a)	 Create and format a table within a presentation. 
b)	 Import a table from Word or a group of cells from Excel spreadsheet.

6.4.4.1	 Method 1: Create and format a table in MS PowerPoint
Use the steps given below to create the table: Open the “Nature-
protect” file.

Step 1:	 Select the slide that you want to add a table to. In this case 
add a new slide after last slide.

Step 2:	 On the Insert tab, select Table.

Select the number of rows 
and columns you want  

from here

Picture 6.28: Table command on Insert tab displaying options for inserting a table
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Step 3:	 In the Insert Table dialog box displays.

Note: Either use a mouse to select the number of rows 
and columns you want or Select Insert Table and enter 
the number in Number of columns field and Number 
of rows field. Lastly click OK.

Type in numbers and 
then click OK

Picture 6.29: Insert Table dialog box

Activity 6.7

Open “Nature-protect” presentation file and create the table given 
below on slide 8.

In our activity we are going to add the following data on the 
new slide 8.

Learners were given assessment tests about environmental 
protection. The following is part of S3 learners’ marks obtained in 
2 tests.

Name Test1 Test2

Mahoro Annet 67 78

Gaju Sharon 45 56

Ingabire Scovia 87 80

Gahima Steven 95 100

Bugingo Vincent 59 70
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Save changes to your file. The new slide in your presentation may 
appear as shown below.

Picture 6.30: The presentation displaying a slide where a table has been 
added.

Step 4:	 To add text to the table cells, click a cell and then enter your 
text. Afterwards click outside the table.

6.4.4.2	 Method 2. Copy table
Use the steps below to import a table from Ms Word to Ms PowerPoint:

Step 1:	 Open a Word document containing a table you want to copy. 

Step 2:	 On the Layout tab (Table Tools) in the Table group, click 
Select and then click on Select Table.

Step 3:	 On the Home tab in the Clipboard group, select Copy.

Step 4:	 Click on your PowerPoint Presentation, select a slide where 
you want to copy the table to. On Home tab, in the Clipboard 
group, click on Paste.

Note: Using the method above, you can copy and paste 
a table from one office application or file to another.
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6.4.5 	 WordArt
Word art is a text with a special design or look. It is an object that you 
can move, resize or rotate within the document. Word art is applied 
to text to appear in a unique form such as a circle, curve or oval; use 
word art.

6.4.5.1	 Insert Word art
Follow steps given below for adding word art in Nature-protect slide. 
Start by opening the file.

Step 1:	 Select the slide where you want to insert a WordArt.

Step 2:	 Click on the Insert tab and then click on the WordArt button 
in the Text group. A gallery of WordArt styles is displayed as 
shown in picture 6.31:

WordArt Gallery 

Picture 6.31: WordArt button on the Insert tab of the Ribbon displaying WordArt 
Gallery

Step 3:	 Select a WordArt style you want to use. The WordArt textbox 
will be inserted on the slide as shown in picture 6.32.
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The Format tab with 
drawing tools for WordArt

WordArt 
Textbox 

Apply any of these WordArt formats 
you want apply to text

Picture 6.32: A slide with WordArt textbox added

Step 4: 	 Move the WordArt in suitable location. And then delete the 
original text and textbox.

Step 5: 	 Repeat steps 1-4 and apply a desired WordArt to all slide 
titles. Slide 1 in our presentation may appear as shown in 
picture 6.33.

Picture 6.33: A slide presentation where WordArt is applied on slide title
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Step 6:	 Click on the WordArt textbox and then type the desired text.

6.4.6	 SmartArt
SmartArt is a picture used to communicate information in many 
different ways. It is an option that allows the user to create diagrams 
easily.

Create a SmartArt graphic and add text to it
Use the steps given below to insert a SmartArt graphic to your 
presentation.

Step 1:	 Open “Nature-protect” file presentation and insert a new slide 
(slide 9) where you need a SmartArt. You can also create 
new presentation. 

Step 2:	 On the Insert tab, in the Illustrations group, click SmartArt.

Picture 6.34: The SmartArt command in the Illustrations group selected on the 
Insert tab

Note: Alternatively insert a SmartArt using the SmartArt 
Graphic button in the content holder, as shown in picture 
6.35.

SmartArt Graphic 
button

Picture 6.35: Content placeholder on a new slide
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Step 3:	 In the Choose a Smart Graphic dialog box that displays, click 
the type and layout that you want. In our case, we are going 
to create a hierachy of officers in our school.

Select a sub type of SmartArt 
graphic you want

Select a 
type of 

SmartArt 
graphic

Picture 6.36: Choose a SmartArt Graphic dialog box

Step 4:	 Enter your text by either: 
Clicking in the text pane (left) and then type your text or 
clicking directly in the Smart Graphic and type the desired 
text. Afterwards save your file.

Text 
pane

Environment 
office

Environment office

Picture 6.37: MS PowerPoint Window showing a Smart Graphic-Organisation Chart 
on a slide
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6.4.7 	 Shapes 
A shape is an outline form of an object. In office applications such as 
Microsoft PowerPoint, you can add shapes such as boxes, circles and 
arrows to your slide. 

6.4.7.1	 Insert a shape
Use the steps given below and insert any type of shape you want. 
Open Nature-protect file or create a new presentation. In the opened 
file, create a new slide for your shape(s) as slide 10.

Step 1:	 Click on Insert tab.

Step 2:	 Click Shapes from the Illustrations group.

Categories 
of shapes to 
choose from

Picture 6.38: Part of PowerPoint 2016 window showing Shapes from the Insert tab

Step 3:	 Select a shape such as a rectangle and then click and drag to 
draw the shape in the desired place. 

After drawing a shape, you can add text, bullets and 
numbering to them. You can also change their fill, outline 
and other effects on the Format tab.
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Picture 6.39: A slide where shapes are added. Textboxes are used add 
accompanying text.

6.4.8	 A chart
This is a pictorial representation of numerical data. There many charts 
that can be created on a slide, but common charts frequently used are: 
column charts, line charts and pie charts. Using the knowledge from 
previous units of creating a chart, let’s add a column chart in Nature-
protect file.

Using the data in the table we inserted on slide 8 of Nature-protect 
presentation, let’s create a column chart.

Step 1:	 Insert a new slide (Title and content layout) as slide 11.

Step 2:	 Click the Chart button in the content holder to generate a 
column chart. Alternatively use Insert tab and click Chart 
button in the Illustrations group.
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Chart button

Picture 6.40: Content holder showing various icons for various objects you can 
insert including chart

Step 3:	 The column chart appears together with its data sheet that 
you should edit to suit your chart.

Change this data and replace 
it with table data on slide 8

Default chart

Data sheet

Picture 6.41: A default column chart displayed together with data sheet that need 
editing
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Step 4:	 Edit data sheet by replacing default data with your data. The 
resulting chart is shown in picture below if table data on slide 
8 is used for charting. 

Picture 6.42: A slide with 3D column chart on showing marks from tests

6.4.9	 Media clips
Media clip is a small segment of an electronic media either an audio 
clip or a video clip.

6.4.9.1	 Audio clip

To insert audio clip, follow the steps given below.
Step 1:	 In Normal view, select the slide where you want to insert an 

audio clip.

Step 2:	 On the Insert tab, in the Media group, click arrow under 
Audio, and then click Audio on My PC.
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Picture 6.43: Media group buttons displaying Audio menu. Audio on My PC is 
selected

Step 3:	 In the Insert Audio dialog box, select a folder containing the 
audio you want and then select the audio file.

Step 4:	 Click on Insert button to insert the audio. (See picture 6.44).

Select a drive or folder 
containing your audio 

file (1)

Selected 
audio file

Select an 
audio file (2)

Click Insert (3)

Picture 6.44: Insert Audio dialog box

Step 5:	 The slide where audio has been inserted will have a graphic 
as shown in picture 6.45. Play using the media buttons 
displayed.
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Only this part will display in a normal 
view slide but when you click on it, the 

part below displays

Increase or 
reduce volume

Click to play or to stop

Picture 6.45: Audio media clip

6.4.9.2	 Video clip
There are two ways to insert video i.e. by linking and by embedding a 
video directly from your PC into your presentation.

	࿤ Embedded videos are appropriate but tend to increase the size of 
your presentation.

	࿤ Linked videos keep your presentation smaller in size, because 
links can easily break, copy the video into the same folder as your 
presentation and create the link from there. 

a)	 Embed a video clip
To insert a Video clip by embedding it, follow the steps given below.
Step 1:	 In Normal view, select the slide where you want to insert 

video clip.

Step 2:	 On the Insert tab, in the Media group, click arrow under 
Video, and then click Video on My PC.

Picture 6.46: Media group buttons displaying video menu. Video on My PC is 
selected
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Step 3:	 In the Insert Video box, click the video that you want 
from a specific folder.

Step 4:	 Click Insert.

Click Insert (3)

Select the 
video (2) Selected video

Select 
a folder  

with 
videos 

(1)

Picture 6.47: Insert Video dialog box

A slide with an embedded video will have the graphic as shown in 
picture 6.48.

Picture 6.48: Video graphic for an embedded video may appear as shown above
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b)	 Link a video

To link to a video on your PC follow the steps given below
Step 1:	 Follow steps 1 to 2 above (for embedding video clip).

Step 2:	 In the Insert Video dialog box, click the file that you want 
to link to.

Step 3:	 Click the down arrow next to the Insert button, and then 
click Link to File. 

6.5	 Formatting a slide
To format a slide is to change the appearance of the slide and or its 
contents. To make these changes, open “Nature-protect” file and use 
the following steps:

Step 1:	 Select text to apply a font. Font changes font size, colour, 
style, Shadow, etc.) from the Home tab. Apply bold, size 24, 
red, shadow on all slide titles and size 18 plus shadow to the 
other text.

Picture 6.49: A slide where formats have been applied to title and subtitle
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Step 2:	 Change background

To change the background click on the Design tab, then                  
in customize group click on Format Background button. 
Follow the steps as shown in the picture 6.50 and save 
change to your file.

Select one 
option e.g. 

Pattern Fill (2)

Click 
Format 

Background 
(1)

Select 
desired 
option 

(3)

Select colour (4)Click Apply to All (5)

Picture 6.50: A presentation where a design background has been applied to all 
slides

Step 3:	 Change slide layout

In case you need to insert a special type of information on a 
slide, you need to change its layout. You do this by selecting 
a suitable layout from the list of layouts in the Slides group 
found on the home tab of the menu bar. 

In the Nature-protect file, insert a new slide after the last 
slide and then apply a 2-column slide layout. Type in the 
names of 4 teachers on the left and suitable picture on the 
right; who are involved in environmental education at your 
school. The slide may appear as shown in picture 6.51.



185

Presentation

Selected 
layout

Picture 6.51: A slide where a two Content layout has been used

6.6	 Animation of a presentation
Animations are presentation features that give motion or life to text 
or objects in the slide show. Animation effects can be added to text 
or graphic objects and if well applied, can bring excitement and 
increase the audience ability to understand your message. If they are 
not used well, can bring frustration and confuse the message you are 
communicating. 

6.6.1	 Applying animations to text or objects in a 
presentation

Activity 6.8

Open Nature-protect presentation and apply animations to all text 
and pictures. Apply a suitable transition effect and run the slide show.

Use the following steps to apply animations you want.

Step 1:	 Select text or object you want to animate.

Step 2:	 On the Animations tab, in the Animations group, select one 
animation you want e.g. Fade, Fly, etc.
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Step 3:	 Apply Timing to animation, that is, in the Timing group, 
increase or reduce the duration or delay of the animation. 
See picture 6.52.

Note: To apply Custom Animation, use the Advanced 
Animation group as shown in the picture below.

Click preview to see how 
the animation works Change direction of animation

Selected animation

Picture 6.52: The ribbon with Animations tab active. Fly-In Animation is selected 
from Animation group

6.6.2	 Apply a slide transition effect in a presentation
Open the file Nature-protect. Use the following steps to apply a slide 
transition.

Step 1:	 Click on the Transitions tab.

Step 2:	 Select a transition effect of your choice from the Transition 
to This slide group.

Time between 
slides

Select audio sound

Type in duration for transition

Picture 6.53: The ribbon with Transitions tab active, and push transitions effect 
selected

Step 3:	 Click Apply to All in the timing group so that the transition 
selected is used by all the slides. Doing this will save you 
time of selecting different transitions for each slide in the 
presentation.
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Step 4:	 Click Preview in preview group to see how the selected 
transition works.

Step 5:	 Save the changes to your file by pressing Ctrl + S on keyboard.

6.7 	 Presentation views
When a PowerPoint presentation is being shown to an audience it 
may have different looks referred to as views. The ribbon below shows 
different views available in PowerPoint 2016.

Picture 6.54: The Ribbon displaying View tab commands that includes 
Presentation Views and Master Views

Steps to access all presentation views together

On View tab in the Presentation Views group, click a presentation 
view e.g. Notes Page.

See picture 6.55. You can also access the main presentation views 
by clicking on the respective buttons on the right of status bar (before 
zoom). The views used for creating and editing a presentation are:

(i)	 Normal View: It is the main working window in the presentation. 
Every slide is shown full size on the screen.

Normal View 
button

Picture 6.55: A presentation in Normal View. The slide pane is the major working window
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(ii)	 Slide Sorter View: This is a window that displays miniature (small) 
versions of all your slides, arranged in horizontal rows. This view 
is very useful when you want to duplicate, delete, hide or reorder 
slides.

Slide Sorter button

Picture 6.56: A presentation in Slide Sorter View

(iii)	Notes Page View: This is located under Slide pane. It shows a 
smaller version of a slide with an area below for adding speaker’s 
notes. Each slide is created on its own notes page. The speaker 
can print these pages out to use as a reference while making his/
her presentation. The notes do not show on the screen during the 
presentation.
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Notes are 
displayed below 

the slide

Data on slide

Picture 6.57: MS PowerPoint window showing slide 5 in Notes Page View

(iv)	Reading View: In this view a slide is shown in full screen mode 
like it is to slide show view. This difference is that in Reading View 
you can still see the title bar and status bar at the top and at the 
bottom of the window respectively.

Picture 6.58: A slide in Reading View
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(v)	 Master Views: Master Views are the main slides that store 
information about the presentation including background, colour, 
fonts, effects, placeholder sizes and positions.
By using Master views, you can make universal slide changes to 
every slide, notes page or handout associated with your presentation. 
These views include:

a)	 Slide Master: When you make a change on the slide master, 
it replicates on all the slide layouts and slides. The slide 
layouts can receive all the formatting, position and common 
elements from slide master but you can also edit individual 
slide layouts to differ from the master slide. Any change you 
make to a slide layout affects only the slides based on that 
particular layout.

Slide Master

Text 
placeholder 

for ‘Body 
element’

Footers 
(includes Date 
and Time, Slide 
numbers and 
footer text

Slide Layouts

‘Title 
placeholder’ 

For ‘Title 
element’

Picture 6.59: Slide Master view

Note: It is important to make modifications to your slide master 
and slide layouts before adding slides to your presentations. 
This makes items on the slides to conform to slide master 
design.
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b)	 Handout Master: A handout is a document that you can 
print from within a PowerPoint presentation. You can have 
1 up to 9 slides on a handout page. A handout is created 
to be printed out. The appearance of a printed handout is 
determined by the handout master.
To access handout master, click View tab on the Ribbon and 
select Handout Master from Master Views group.

Select the number of 
slides per handout

Picture 6.60: MS PowerPoint 2016 window displaying the Handout Master View

c)	 Notes Master:  Each slide in your presentation could have 
notes associated with it and these placed in the Notes Pane 
area. If you want to modify and print these notes, you make 
use of the Notes Master.
To access Notes Master: On the View tab, click Notes Master 
in the Master Views.



192

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

Number placeholder

Header placeholder

Date placeholder

Slide 

Notes Background

Notes area (same 
notes in the Notes pane 

of normal view

Footer placeholder

Slide show button

Picture 6.61: Notes Master View

Slide show
This is a window that fills the whole screen when it runs. It displays 
any animations or transitions added to the slide in the presentation. 
Each page of a PowerPoint presentation is called a slide and the default 
orientation of the slide is in landscape layout. 

Slide shows  can contain eye-catching text, bulleted lists, charts, 
graphic objects or be completely covered by a single picture, as in 
a photo album.
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Picture 6.62: Slide show filling the whole screen

End of Unit 6 Assessment

1.	 Computer viruses are some of the biggest limitations faced by 
computer users all over the world. As a computer learner, you 
have been tasked to educate computer users about this threat.
Create 6 slides which you are going to use during the presentation 
to your audience following the guidelines below:

Slide 1: Should include the title and definition of Computer 
virus, your name as presenter and school.

Slide 2: Should include symptoms of viruses on a computer 
system. Add an audio clip on this slide.

Slide 3: Should include the damage made by viruses in a 
computer and its accessories.

Slide 4:  Should include ways through which viruses spread to 
computers.
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Slide 5: Should include the precautions of preventing viruses 
from entering the computer.

Slide 6: Should include ways to treatment of computer viruses.

Each slide should have the following additional information:

a)	 Relevant message needed to convey the required 
information.

b)	 Apply bold and shadow effects to all slide titles.
c)	 Your name, class and slide number as Footer of each 

slide and on the Handouts.
d)	 Use minimal but relevant effects (animation and transition) 

to make the presentation entertaining.
e)	 Search for a suitable online picture about computer 

viruses and insert it at the top right hand side of each 
slide using the Slide Master. Save presentation as Virus.

2.	 Create a presentation of six slides on the topic of Impact of 
computers to Rwandans which will be used to conduct ICT 
lesson in S3 class.
a)	 (i)	 Slide 1 should have the title of the topic, definition 

of term computer and Name of presenter (as 
Wordart).

(ii)	 Slide 2 should have the advantages of computers 
to Rwanda people. Link a suitable video clip on this 
slide.

(iii)	 Slide 3 should have the disadvantages of computers 
to Rwanda people.

(iv)	 Slide 4 should have uses of computers in Rwanda.
(v)	 Slide 5 should have list of hardware and software or 

programs used in your school in form of a 2-column 
table.

(vi)	 Slide 6 should have a column chart about number 
of computers used by different classes in your 
school. Use the data in the table below to create a 
3D column chart.
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Class Number of computers used

S1 120

S2 150

S3 210

S4 90

S5 75

S6 50

Note: Provide a suitable chart title, axis titles and slide title.

b)	 Apply minimum animations in your presentation.
c)	 Insert relevant picture on the master slide in the lower left 

of each slide. (Use view tab, then slide master, click the 
first slide in the list, insert clip in correct place and close 
the master view).

d)	 Insert your name and class as footer on both the slides 
and Notes and Handouts page.

e)	 Use a suitable background design of your choice.
f)	 Insert slide number on all slides.
g)	 Make your slide to run automatically after 3 seconds.
h)	 Save your work as Today’s Computer.

3.	 a)	 Create a presentation about Deforestation in Rwanda 
following the procedure below:
•	 On the first slide: Topic and definition
•	 On the second slide: Importance of Deforestation
•	 On the third slide: Disadvantages of Deforestation
•	 On the fourth slide: Areas most affected by Deforestation 

in Rwanda
•	 On the fifth slide: Methods used to reduce Deforestation.

b)	 Save the presentation as Deforestation.
c)	 Insert a header as ‘your name and class on the Handout.
d)	 Change the background of all the slides to an appropriate 

format of your choice.
e)	 Set a slide transition of your choice, with transition time 

of 6 seconds. Apply an audio sound from your PC on a 
slide of your choice.

f)	 Set animation of your choice for all slide titles and other 
parts of the slides.
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g)	 Make use of relevant graphics or pictures, from your PC 
or Internet.

h)	 Insert a summary table slide between the last slide and 
second last slide with the following data.
Level of Deforestation

Year Developing Countries Developed Countries

1950 Very low Very high

1970 Low High

1990 High Low

2010 Very high Very low

Make use of the Notes pane to add speakers notes.

i)	 Save and print your work as a handout.



APPLICATION SOFTWARE
Graphics and Multimedia
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Unit
77

Introduction to Computer graphics

Key unit competence

Create graphics using basic graphic elements and edit predefined 
graphics.

7.1	 Introduction
Sketch something on paper (a man or a house). Changing what you 
draw can be easy or hard: you can erase pencil or charcoal marks 
easily enough, and you can scrape off oil paints and redo them with 
no trouble; but altering watercolours or permanent markers, swapping 
colours or resizing your picture is more complicated. 

That’s why it is more efficient to draw a picture on a computer screen 
and what you have is a piece of digital information (your picture is 
stored as a series of numbers). Change the numbers and you can 
change the picture, in the blink of an eye or even quicker. It’s easy 
to shift your picture around the screen, scale it up or down, rotate it, 
swap the colours, and transform it in all kinds of other ways. Once it’s 
finished, you can save it, incorporate it into a text document, print it 
out, upload it to a web page, or email it to a client or work colleague, 
all because it’s digital information. 
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7.2	 Definition

7.2.1	 Computer graphics
This is the use of a computer and specialised programs to produce 
and manipulate images.

The purpose of creating computer graphics is mainly for: Animation, 
business presentation and scientific research. 

There are two very different ways of drawing digital images on a 
computer screen, known as raster and vector graphics. 

7.2.2	 Bitmap/ Raster graphics
A bitmap (or raster graphic) is a digital image composed of a matrix 
of dots. A bitmap graphic is composed of many tiny parts, called 
pixels, which are often many different colours. It is possible to edit 
each individual pixel.

When you take a photograph using a digital camera or scan an 
image from a magazine, you are creating a bitmap graphic.

Since the computer has to store information about every single 
pixel in the image, the file size of a bitmap graphic is often quite 
large. When you resize a bitmap graphic, it tends to lose quality.

7.2.3	 Vector graphics
Vector graphics are graphics stored and drawn with instructions 
rather than grids of pixels. Vector images are mathematical 
calculations from one point to another that form lines and shapes. 
If you zoom into a vector graphic it will always look the same.

7.2.4	 Comparing Raster graphics and Vector graphics

Vector graphics Raster (Bitmap) graphics

Mathematical calculations that form 
shapes.

Pixel-based.

Vector programs best for creating 
logos, drawings and illustrations, 
technical drawings. For images that 
will be applied to physical products.

Raster programs best for editing 
photos and creating continuous tone 
images with soft colour blends.

Can be scaled to any size without 
losing quality.

Do not scale up optimally - Image 
must be created/scanned at the 
desired usage size or larger.
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Resolution-independent: Can be 
printed at any size/resolution.

Large dimensions & detailed images 
equal large file size .

A large dimension vector graphic 
maintains a small file size.

It is more difficult to print raster 
images using a limited amount of 
spot colours.

Number of colours can be easily 
increased or reduced to adjust 
printing budget.

Some processes cannot use raster 
formats.

Vector art can be used for many 
processes and easily rasterised to be 
used for all processes.

Depending on the complexity of the 
image, conversion to vector may be 
time consuming.

Table 7.1: Comparison table between vector graphics and raster graphics

7.2.5	 Resolution
Resolution is the total number of pixels that make an image. In 
general, the more pixels used when capturing an image, the sharper 
the stored image is. This is called resolution, it is measured in dots 
per inch (dpi). 

7.2.6	 2-Dimensional computer graphics 
2-Dimensional computer graphics are mainly used in applications 
that were originally developed upon traditional printing and drawing 
technologies. In those applications, the two-dimensional image is 
not just a representation of a real-world object, but an independent 
artifact with added semantic value. Two-dimensional (2D) models 
are therefore preferred because they give more direct control of the 
image than 3D computer graphics, whose approach is more similar 
to photography than to typography. 2D images are in an x-y plane.

7.2.7	 3-Dimensional computer graphics
3D graphics, compared to 2D graphics, are graphics that use a 
three-dimensional representation of geometric data. For the purpose 
of performance, this is stored in the computer. This includes images 
that may be for later display or for real-time viewing.
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7.2.8	 Core elements of computer graphics
	· Modelling is the process of developing a mathematical 

representation of any three-dimensional surface (3D) of an 
object (either living or non-living) via specialised software. The 
product is called a 3D model.

	· Rendering  is the process of converting automatically 3D wire 
frame models into 2D images with 3D photorealistic effects or 
non-photorealistic rendering on a computer. 

	· Animation a process that uses computer generated images to 
create  animated  scenes. An  animated  scene starts with one 
picture, which is referred to a frame.

	· Interaction  is a technique of using a physical input/output 
device to perform a broad task in a human-computer dialogue.

7.3	 Graphic file format

7.3.1	 Definition
Graphic images are stored digitally using a small number of 
standardised graphic file formats such as: 

	࿤ BMP: Limited file format that is not suitable for use in prepress. It 
is a file extension for Bitmap file.

	࿤ GIF: Graphic Interchange Format mainly used for internet graphics.
	࿤ JPEG: Joint Photographic Experts Group which is used for internet 

graphics, photos, etc.
	࿤ TIFF: Tag Image File Format a popular and versatile bitmap file 

format.
	࿤ PNG: Portable Network Graphics.

7.4	 Areas of graphics use
Graphics are visual elements often used to point readers and viewers 
to particular information. They are also used to supplement text in an 
effort to aid readers in their understanding of a particular concept or 
make the concept more clear or interesting.

	࿤ Entertainment: Animated pictures, audio – videos, and TV shows, 
Computer games. 

	࿤ Advertisement: Graphics are among the primary ways of advertising 
the sale of goods or service e.g. creating logos.
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	࿤ Book illustrations: To produce illustrations which summarise various 
kinds of data. E.g. it is used to illustrate themes and concepts such 
as human anatomy in Biology and diagrams in mathematics.

	࿤ Magazines: Magazines contain graphic materials in abundance to 
attract readers.

	࿤ Education: As learning and teaching aid.
	࿤ Computing designing computer games, web sites.

7.5	 Graphics software
Graphics software are better at creating and manipulating bitmaps or 
vector graphics.

7.5.1	 Bitmap/Raster graphics software
This software includes Microsoft Paint and Adobe Photoshop.

Microsoft Paint
A paint program is a software graphics program that allows the user to 
draw or paint bitmapped images on a computer. 

Adobe Photoshop
This is a professional software used in photography, design and 
video editing. It is a program that can edit images of any type. It was 
developed by Adobe systems. Photoshop is mainly a raster graphics 
editor. Photoshop is used in a similar way as Paint but in a more 
professional style. More information about Adobe is provided at the 
end of the unit.

Vector graphics software
Vector graphics software commonly used include: Adobe Illustrator, 
Adobe FreeHand, CorelDraw, Paintshop Pro.

7.5.2	 Microsoft Paint
Windows operating system comes with a basic, easy-to-use image 
creation program called Microsoft Paint which is a  basic raster 
graphics program capable of creating, opening, and basic editing of 
image files, including BMP, JPG, GIF, and PNG. The default bitmap file 
type for Paint is BMP.
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Activity 7.1

Launch MS Paint program on your computer
Follow these steps to open Ms Paint:

	· Click the start button, all programs.
	· From windows accessories, choose Paint.

The following window appears.

Canvas

Picture 7.1: Microsoft paint at start (Showing white canvas)

Understand the canvas
When Paint launches, you’ll see a white “canvas” appear on the screen. 
Imagine this canvas as a piece of paper for you to draw or write on. 
You can adjust the size of the canvas before you start creating your 
masterpiece.
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7.6	 Basic graphic elements (with MS 
Paint)

Select 
Options

Eraser 

Ba
ck

gr
ou

nd
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ol
ou

r

Magnify 

Colour 
picker

Lines and 
shapes

Fill 
Options

Outline 
Options

Line/Brush size

Pencil Brush OptionsText 

Picture 7.2: MS Paint with its Ribbons showing graphics elements

7.6.1	 Line and curve tools
Using the already open paint program, you are going to locate and use 
the following tools;

Line
	· Click the Straight Line tool, then choose a colour 

from the palette. 
	· Click anywhere in your canvas. 
	· While holding down the mouse button, drag the 

mouse away in any direction. 
	· Release the button when the line is as long as you 

want it to be. 
Curved line
	· Click the Curve icon (a squiggly line). 
	· Draw a line as you would with the straight line 

tool. 
	· When you lift your finger from the mouse button, 

click somewhere on the line and drag it in any 
direction. 

	· The straight line you drew will curve in that 
direction.

	

– Click the Straight Line tool, then choose a color from 
the palette.  

– Click anywhere in your canvas.  
– While holding down the mouse button, drag the mouse 

away from that first click in any direction.  
– Release the button when the line is as long as you want 

it to be.  
Curved line  
– Click the Curve icon (a squiggly line).  
– Draw a line as you would with the straight line tool.  
– When you lift your finger from the mouse button, click 

somewhere on the line and drag it in any direction.  
– The straight line you drew will curve in that direction. 

	

Picture 7.3 (a): Part of 
MS Paint showing line 
and curve tools
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7.6.2	 Paintbrush tool

Picture 7.3 (b): Paint brush tool 
highlighted

The Paintbrush is more versatile than 
the Pencil, as you can choose different 
brush “tips” for more unique lines. 

	· Click the down-arrow beneath 
“Brushes” and

	· Choose one of the brush tips. 
You can adjust the size of each brush 
tip by clicking the “Size” icon.

	

The Paintbrush is more versatile than the Pencil, as 

you can choose different brush “tips” for more 

unique lines.  

– Click the down-arrow beneath “Brushes” and 

–  Choose one of the brush tips.  

You can adjust the size of each brush tip by 

clicking the “Size” icon. 

	

7.6.3	 Pencil tool

Picture 7.3 (c): Pencil tool highlighted

The pencil is a freehand drawing tool, 
much like an actual pencil. The width 
of the line can be adjusted by clicking 
the Size menu and selecting a different 
line width. 

	· To draw, simply press the mouse 
button as you move the mouse on 
the canvas.	

The pencil is a freehand drawing tool, much 

like an actual pencil. The width of the line can 

be adjusted by clicking the Size menu and 

selecting a different line width.  

– To draw, simply press the mouse button as 

you move the mouse on the canvas.	

7.6.4	 Spray can

Picture 7.3 (d): Airbrush highlighted	

This	tool	works	similarly	to	the	Paintbrush	tool,	but	

the	look	is	more	in	line	with	that	of	can	of	spray	paint.	

This	tool	is	located	in	the	“Brushes”	menu.	

	
– Click the icon that looks like a can of spray paint. 

– Draw as you would the pencil or brush tools 

	

This tool works similarly to the 
Paintbrush tool, but the look is more in 
line with that of spraycan paint. This 
tool is located in the “Brushes” menu.

	· Click the icon that looks like a can 
of spray paint.

	· Draw as you would do with the 
pencil or brush tools.
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7.6.5	 Shapes (circles, ovals, squares, rectangles, etc. )

Picture 7.3 (e): Shapes 
that can be drawn in MS 
Paint
	

Select any shape from the toolbar to draw that shape. Once you’ve 
chosen a shape, you’ll notice some options for the shape’s appearance. 

– Click the “Outline” and “Fill” menus to view your options. 
– Select your preferred outline and fill options, then click the canvas 

where you’d like to place your shape.  
– Hold down the mouse button as you drag the cursor to enlarge the 

shape. Let go of the mouse button when you reach the desired shape 
size.  

– If you chose a shape with an outline, the color of the outline will be 
the current foreground color. If your shape has a solid filling, the fill 
color will be the background color. 
	

Select any shape from the toolbar to draw that 
shape. Once you’ve chosen a shape, you’ll notice 
some options for the shape’s appearance.

	· Click the “Outline” and “Fill” menus to view 
your options.

	· Select your preferred outline and fill options, 
then click the canvas where you’d like to place 
your shape. 

	· Hold down the mouse button as you drag the 
cursor to enlarge the shape. Let go of the mouse 
button when you reach the desired shape size. 

	· If you choose a shape with an outline, the colour 
of the outline will be the current foreground 
colour. If your shape has a solid filling, the fill 
colour will be the background colour.

7.6.6	 Fill tool

Picture 7.3 (f): Fill tool 
button-highlighted

	

Also known as the “Paint Bucket,” the Fill tool will paint an 
entire defined area with a single color.  

– Click the icon that looks like a spilling paint bucket, then 
choose a color from the palette. Now, click the canvas to 
fill it with the color you selected. 

– The Fill tool will fill the space between all closed lines. 
Try creating a square or circle with the shape tool in one 
color, then use the Fill tool to change the color of just 
that shape. 
	

Also known as the “Paint Bucket,” the Fill tool will 
paint an entire defined area with a single colour. 

	· Click the icon that looks like a spilling paint 
bucket, then choose a colour from the palette. 
Now, click the canvas to fill it with the colour 
you selected.

	· The Fill tool will fill the space between all 
closed lines. Create a square or circle with the 
shape tool in one colour, then use the Fill tool 
to change their inside colour.

Activity 7.2

Use an ellipse tool to create a basketball with a suitable background.
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7.6.7	 Ellipse tool

To get a round shape that has a black outline and an orange interior, 
use the following steps:

Step 1:	 Choose the Ellipse tool.

Step 2:	 In the Fill options area, choose ▼ then select Solid colour. 

This will set foreground colour for the outside, and set 
background colour for the inside.

Step 3:	 Click the foreground Colour box, and then click black to set 
the foreground colour.

Step 4:	 Click the background Colour box, and then click orange to set 
the background colour.

Step 5:	 Click and hold the left mouse button and drag the mouse to 
form the oval. 

Picture 7.4: Circle shape drawn and filled with colour

Tip: To make it perfectly round, hold down the Shift key as you drag 
the mouse.

Step 6: 	 Use line tool.

	· Now choose the Line tool, 
	· Then set size, and draw the vertical /horizontal lines, by dragging 

the mouse.
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Picture 7.5: Lines are drawn in circle to make 4 quarters

Tip: To make the lines perfectly straight, hold down the Shift key 
as you drag.

Step 7:	 Curve tool.

	· Now, choose the Curve tool.
	· Draw a straight line to the left of your vertical line.
	· Click in the middle of the new line and drag it toward the vertical 

line to curve it.

IMPORTANT: To lock in the new shape, click on some other tool, 
like the selection tool.
	· Now, choose the Curve tool again.
	· Draw a straight line to the right of your vertical line.

Picture 7.6: Curve lines are added to the circle, left and right
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Step 8:	 Fill tool.

	· Now, go ahead and fill the white canvas with a different colour.
	· The Fill with colour tool will flood a connected area with the 

colour you choose.
	· The final product should look something like this: 

Picture 7.7: A background is added using Fill with colour tool

Step 9:	 Save your work.

	· From File menu, choose Save as.
	· From a dialog box, choose BMP picture.

Picture 7.8: Saving MS Paint file

	· Choose the location where you want to save.
	· Type the name you wish to use (ball) make sure it will be saved 

as a 24 bit Bitmap – this will add .bmp to the filename for 
example: ball.bmp. We shall use this file later on.
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7.7	 Graphic features
In order to use graphics features well, you should learn to select images 
or parts of the image to be affected/changed by the graphic feature. 
To select is to choose an option from two or more available options. 
Practice selecting image parts you may need to cut, copy or fill with 
colour.

7.7.1	 Selection tools
There are two different tools you can use to select parts of your image: 

	࿤ Rectangular Selection (a dotted outline of a rectangle). 
	࿤ Freeform Selection (a dotted outline of oval shape).

Free-form selection allows you to draw your own freehand selection 
line around an image, while the rectangular selection tool lets you 
draw a rectangle around an image.

Steps to select an image
Step 1: 	 Click the arrow beneath the “Select” button.

Step 2: 	 Choose “Rectangular” or “Freeform.” See picture 7.9(a).

Picture 7.9(a): Selection tools

Step 3:	 To use either tool selected, start by clicking at the top left 
corner of your image, then hold down the mouse button 
as you trace your way around the image. Then release the 
mouse.

7.7.2	 Copy and paste (a selected image)
Follow the steps given below to copy your image:
Step 1:	 Select Image and make sure the image is highlighted with 

dotted rectangle.
Step 2:	 Copy the selected area by pressing Ctrl+C or click Copy 

command from the Home tab.
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Step 3:	 Paste the image using Ctrl+V or Paste command on the 
Home tab.

Note: You can paste the copied selection in the same file in Paint 
or in other compatible programs, like Microsoft Word or Microsoft 
PowerPoint.

If the image you want to copy has a background colour that you 
don’t want to be a part of your selection, then: 

	࿤ Check “Transparent Selection” in the Select menu.
	࿤ And to disable this later, click back to the top selection icon.

Let us draw an image of a basketball net as shown below.  By so doing 
we are to learn the following tools; copy and paste, move, resize, flip, 
skew, rotate, cutout, trim. These actions are repeated in this unit for 
purposes of learning more about paint in respective sections.

Picture 7.9(b): Image of a basketball net drawn
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Copy and paste
Follow steps 1 to 3 in section 7.7.2 to copy and paste the image. 
The results may appear as shown in picture 7.9(c).

When you copy and paste an image, 
copies are pasted in this position 

(upper left hand corner)

Picture 7.9(c): An image has been copied and pasted in Paint

7.7.3	 To move an image
Step 1:	 Select the image to be moved.

Step 2:	 Click on the selection and drag to a new position. See 
picture 7.9(d), the pasted copy has been moved to lower 
left corner.
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Picture 7.9(d): The pasted copy of the original image has been moved to the lower 
left corner of the canvas

7.7.4	 To resize an image 

We are going to use original image and we resize it manually.
Use the following steps to resize an image:

Step 1:	 Select the image

Step 2:	 Click in any of the selection boxes and drag inwards (to 
reduce size) or drag outwards (to enlarge its size). See 
picture 7.9(e).
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Selection boxes

Picture 7.9(e): Original image has been resized manually

Note: You can also resize the image using the resize tool in the 
image group. This is covered later on in this unit.

7.7.5	 To flip an image  
Flipping an image is to change its direction. Use the following steps 
to flip an image:

Step 1:	 Select the image to be flipped.
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Step 2:	 In the Image group click Rotate tool and then select Flip 
vertical or Flip horizontal. See picture 7.9(f), how the 
resized image is flipped horizontally.

An image flipped 
horizontally

Select a flipping option (2)

Select 
image (1)

Picture 7.9(f): The resized image has been flipped horizontally

7.7.6	 To rotate the image
Steps:	 Repeat steps 1 and 2 of part (d) above but instead of 

selecting a flipping option, select a rotate option e.g. 
Rotate right 900. This task is repeated in other activities 
later in this book.
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An image rotated 
right at angle 900

Picture 7.9(g):  The selected image is rotated right at angle 900

7.7.7	 To skew an image
Step 1:	 Select an image.

Step 2:	 Click Resize tool in the Image group.

Step 3:	 In the Resize and Skew dialog box, use section down for 
skew and type in Degrees for skewing the image. 

7.7.8	 Cut-out or trim an image
Step 1:	 Select a part of the image you want to cut-out or trim.

Step 2:	 Press delete key on keyboard.

Activity 7.3(a)

a)	 Draw the shape of a heart and fill it with red colour. 
b)	 Move the shape to the left side on the page. 
c)	 Copy and paste any half of the shape and move the pasted copy 

on the right side of the page. 
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d)	 Type a Green bold text of font size 26 in the pasted copy as 
“Divided heart” and “One Heart” text in the original image.  

e)	 Erase a small part of the original shape that you want. 
f)	 Apply a suitable background to the shapes and save your file 

as ‘Our Hearts’.

Follow the steps given below to perform this activity
	࿤ Open MS Paint.
	࿤ Pick the Heart shape and draw it in an appropriate size. Use 

rectangular selection and move the shape towards the left margin.
	࿤ Select Red colour from the Colours group – Home group or colour 

palette.
	࿤ Select Fill with colour button from Tools group – Home tab.
	࿤ Use Rectangular Selection option on Select menu and draw a 

rectangle covering half of the heart.
	࿤ On the Home tab, click Copy.
	࿤ Click Paste button.
	࿤ Click the pasted copy and drag to a new position you want towards 

the right margin.
	࿤ Click on the text button and draw a textbox over the pasted copy 

and type your text. Repeat the same action and type text in the 
original image as required.

	࿤ Pick Eraser tool and remove any small part of the original heart.
	࿤ Pick green colour and select Fill with colour button. Then click any 

part outside the shapes.
	࿤ Save your file with a name. (See results of this activity in picture 

7.12).

7.7.9	 Add text
To add text, follow the steps given below:

	࿤ Select the Text tool, which is signified by the letter “A,” then,
	࿤ Double-click somewhere on the canvas to start typing.

Picture 7.10: Add text button highlighted
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	࿤ Make sure the text in the textbox is exactly the way you want it 
before switching to another tool (you will be unable to edit text after 
closing the textbox).

	࿤ To increase the textbox size (which will give you more room to 
type). Hold the mouse over one of the square corners until the 
cursor turns to an arrow, then drag the box to a larger size.

	࿤ Choose a font face and size from the top of the screen and begin 
typing. 

	࿤ To change the colour, size or face of the text after you type, highlight 
the text, then choose the new colour, size, etc. When you are typing, 
click somewhere outside of the textbox to leave the tool.

Picture 7.11: Add Text tool used to draw a Textbox as shown

7.7.10	 To erase something you have drawn with Eraser 
tool

Follow the steps given below;

	࿤ Click the Eraser icon (see picture 7.12(a))
	࿤ Drag over the area you would like to disappear several times until 

it disappears.

Note: Like other tools, you can adjust the width of the eraser 
with the Size menu.
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Picture 7.12(a): Paint window showing possible results of Activity 3

7.7.11	 Vector Graphics 
To create and edit or reshape vector graphics suitably requires you 
to use a vector graphics software such as Adobe Illustrator, Adobe 
Freehand or CorelDraw. You can also introduce a Raster graphic into 
a vector graphics software and edit by converting it to vector graphic. 
For our case we use Adobe Illustrator. With Adobe Illustrator, you can 
design logos, T-shirt design, posters and flyers as vector graphics. 

Activity 7.3 (b)

a)	 Using Adobe Illustrator, create the following vector graphics or 
shapes as they appear and save the project as Better shapes.
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b)	 Reshape or edit the graphics drawn in (a) above to appear as 
shown below.

Follow the steps given below to perform this activity.

Step 1:	 Open Adobe Illustrator, a vector graphics software. The 
window for Adobe Illustrator appears below.

Click on New 
to create a new 

document

Picture 7.12 (b): Adobe Illustrator (CS6 version) window appears black
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Step 2:	 Click on File menu and select ‘New’ button to get a new 
document dialog box (shown below). Name your file as My 
Shapes. 

Type in file 
name (1)

You can 
take 

options 
here as  

you wish  
or ignore 

this 
(optional)

Click OK 
to open the 
file as shown 

below (2)

Picture 7.12 (c): New document dialog box

Zoom tool
Colour button

Gradient tool

Select colour from  
CMYK spectrum 

Select colour  
for drawn shapeDirect Selection Tool

Type tool

Rectangle 
tool

Picture7.12 (d): New blank file in Adobe Illustrator

Step 3:	 Start creating the shapes using various tools

To create the square: click the Rectangle Tool on the toolbox 
and then drag in the white background to draw the square.  
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To draw other shapes, click on white graphic near the 
rectangle tool to display other shape tools. Then click on the 
ellipse tool to draw the circle/oval shape and afterwards click 
on the rounded rectangle tool to draw the rounded rectangle. 

Select alternative colour for your shape

Selection Tool (V)

Press and hold left mouse 
button on this tool until 

other tools show

Other shape tools

Picture 7.12 (e): Illustrator window showing newly created shapes

Step 4:	 Fill the square with green; the circle with gradient fill and 
rounded rectangle with brown colour and increase on its 
shape outline. 

To fill green colour in the square, select the square using the 
selection tool, click where there is green colour on the CMYK 
spectrum on the right of the window (or from alternative 
colour button on toolbar).

To fill gradient in the circle/oval, select the circle and then 
click on the gradient button.

To fill the rounded rectangle with brown colour, select it first, 
then click on the alternative colour button on the toolbar. 
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Increase the outline of the rectangle by increasing points in 
the shape outline size.

Selected colour

Zoom tool

Blob brush tool 

Eraser tool

Paintbrush tool

Alternative 
colour

Increase shape outline 
size (for rounded 

rectangle)

Alternative line colour

Picture 7.12 (f): Illustrator window showing shapes that have been formatted

b)	 To reshape or edit the graphics
Step 1:	 To reshape or edit the square: Select the square, click on 

Effect menu and on the menu click Distort & Transform and 
then select the zig zag… effect. In the Zig Zag dialog box, 
adjust the size to be 12 pts and ridges to be 5. Then click 
OK.
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Picture: 7.12 (g): Effect menu 
showing Distort and Transform effect

Picture 7.12 (h): Zig Zag dialog box

To insert text in the square; select Type Tool on the toolbox 
and draw a box in shape where you can type text. Type in the 
text in the shape. Change font size to 24pt, Book Antiqua; 
using the Character button on the upper toolbar. See picture 
7.12(i).

Character button

Character options

Picture 7.12 (i): Character options

To change text colour, select typed text and click on red 
colour from the CMYK spectrum colours on the right of the 
window or using alternative option on the upper toolbar. 
Lastly click the center button on the upper toolbar.
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Center button

The new 
square

Selected text

Picture 7.12 (j): Edited or reshaped square graphic

Step 2:	 To edit circle oval; select it and on the effect menu click 
Texture and then Traquelure. See picture 7.12 (k). In the 
Traquelure dialog box that displays, (you can adjust the crack 
spacing depth and brightness as you like), click OK. Select 
radial gradient on the right.

Selected 
graphic

Select radial 
gradient

Picture 7.12 (k): Adobe Illustrator window showing how to access texture effects
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The Traquelure dialog is shown below

Adjust  
these 

options as 
you wish 
and click 

OK

Picture 7.12 (l): Traquelure dialog box

Step 3:	 To reshape the rounded rectangle, select it and click Effects 
menu. On the menu, click Warp and select Shell lower in the 
sub menu.  

Picture 7.12 (m): Effect menu displaying Warp effects
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To add special fill effects, click Pixelate on the effects menu 
and then select Mezzotint.

Pick a 
different 

option and 
click OK

Picture 7.12 (n): Mezzotint dialog 
box	

Picture 7.12 (o): Location of Pixelate 
effects on the menu

To add text to the rounded rectangle, repeat as done in step 
1 above.

The suggested answers for the activity are shown in picture 
below.

Picture 7.12 (p): Adobe Illustrator window showing edited/reshaped graphics
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Saving a project
Click on File menu and select Save As. The Illustrator options dialog 
box displays as shown below. Click OK. The Save dialog box displays. 
Type in the file name and click on ‘Save’ button.

Picture 7.12 (q): The Illustrator options dialog box

Type in file 
name and 
click Save

Picture 7.12 (r): The Save as dialog box in Illustrator
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7.7.12	 Manipulate nodes and control points
These are the selection boxes and circles that appear when you select 
an image for reshaping. Point on one of the node or point until the 
pointer changes shape of double pointed arrow. Then click and drag 
inwards or outwards to reduce size or enlarge its size respectively.

Selection boxes. Pointing 
to one of the box makes 
the pointer to be double 
pointed arrow like this  

one

Selected image in 
Adobe Illustrator

Selected 
image in 

Paint 

Picture 7.12 (s): Selected image showing selection boxes around it

7.8	 Graphics formatting

Activity 7.4

a)	 Create a new Paint file and draw a star object (another object 
of your choice). 

b)	 Fill the object outline to colour red and fill colour to green (or 
light green).

c)	 Insert text as “Star” in the Star shape. Adjust the font size to a 
suitable size.

d)	 Save the file as ‘Green star’.
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Follow the guidelines given below

7.8.1	 Colours for the outlines and fill of objects
	࿤ Select a pencil or a shape to use.
	࿤ Click the Outline button from Shapes, select the option you want 

eg. (no fill, marker, crayon,..). 
	࿤ click the desired colour.
	࿤ Drag the mouse to draw the object, then resize the object.

a b

Red colour selected

Picture 7.13: Star shape drawn with black outline (a) and the outline colour is 
changed to red (b)

7.8.2	 Create shading and fill objects with patterns and 
textures

	࿤ Click on Fill With colour tool, then choose the desired colour.
	࿤ Click inside the object.

Picture 7.14: Star shape is filled with green colour
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	࿤ Fonts as part of the graphic design.

Picture 7.15: A Textbox is drawn inside the shape. Text is typed in the textbox

7.9	 Edit image
To edit image means to make changes that make an object more 
meaningful. You can edit a newly created image or an existing image.

	࿤ Opening an image file
Paint can open up many different image types, including *.bmp, .gif, 
.jpg/.jpeg, .tif/.tiff, and .png. To open a file in Paint, 

	࿤ Click “File,” then “Open.”
	࿤ Navigate to the folder where your image file is stored and click 

“Open.”

Activity 7.5

a)	 Open Microsoft Paint and add an image of a bird from your 
computer or from Internet (you may also opt to use any other 
image you already have).

b)	 Crop part of the image and save it as ‘cropped’.
c)	 Resize the image by 150% horizontally and vertically.
d)	 Rotate the original image by ‘Flip Horizontally’.
e)	 Using rotated image, zoom into the eye of the bird. Afterwards 

you can zoom out.



233

Introduction to Computer graphics

7.9.1	 Crop an image
With an image open in Paint, 
	· Click the “Select” tool at the top of the screen. 
	· Highlight the area you want to crop by clicking and dragging 

with the cursor. Everything inside the dotted lines is your new 
image, that you can save or transfer to another location in the 
document.

Picture 7.16: Select tool used to mark part of the image to be cropped

	· Click “Crop”.

Picture 7.17: Cropped picture
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	· You will remain only with the selected part.

7.9.2	 Resize an image
	· Click “Image,” then select “Resize”.
	· Type a new size (in pixels, or by percent, as you did when 

creating the canvas) to increase or decrease the image size.

Resize and Skew
dialog box

Picture 7.18: Changing size of the image using percentage resize

7.9.3	 Rotate an image
To flip an image upside down (or some other direction), use the Flip 
and Rotate tools. 

	· On the toolbar, click “Rotate” and choose a direction in the 
menu.

Picture 7.19: Rotated image



235

Introduction to Computer graphics

7.9.4	 Magnify an area of a picture/Zoom
	· Click the magnifying glass icon to enable the Zoom tool. 
	· To zoom in, click anywhere on your image with the left mouse 

button. 
	· To zoom out, click with the right mouse button. 

Alternatively, 

	· Use the keyboard shortcuts Ctrl+ PgUp to zoom in and  
Ctrl+ PgDn to zoom out.

7.9.5	 Stretch or skew an image
You can distort an image with the “skew” feature. 

	· Click “Image,” then select “Resize/Skew”. 
	· To stretch/distort the image by degree, type a number (in 

degrees) in the boxes marked “horizontal” and “vertical”, in the 
Resize and Skew dialog box.

	· Given that you earlier used a different image like this in 7.20 
(a) below, you would skew it by 20 degrees and it changes as 
shown in 7.20(b).

a b

Picture 7.20: (a) Before Skew, (b) After Skew

7.9.6	 Changing pixels
If you want to resize the image, and you don’t care if it gets a bit 
stretched, then:
	· Select Pixels.
	· Uncheck the Maintain aspect ratio checkbox.
	· Enter a width (Horizontal) and a height (Vertical) in Pixels.
	· Click OK.



236

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

Picture 7.21: Resizing an image using Resize and Skew dialog box

7.9.7	 The Colour Picker
The small eyedropper icon represents the Colour Picker tool. 

	· Click this tool, then 
	· Click somewhere in your drawing. The area you click will now 

become the foreground colour for your next tool of choice.

Picture 7.22: Eye dropper button highlighted

7.9.8	 Change colour 
You can edit any of the colours by adjusting their hue, brightness 
and other options in the Paint colour mixer. 

	· Click “Edit colours” or “Define Custom Colours” to enter the 
colour mixer. 

	· After you have decided on a colour you like, click “Add to 
Custom Colours.”



237

Introduction to Computer graphics

Picture 7.23 (a): Edit Colours dialog box for changing colour combination

7.9.9	 Brushing Tools
MS Paint has several brushing tools you can use to make your image 
artistic in appearance. Below is an image showing collection of all the 
brushes in paint.

Calligraphy brush 1 

Calligraphy brush 2 

Airbrush 

Natural pencil Brush 

Oil Brush 

Watercolour brush Marker  Crayon  

Picture 7.23 (b): MS Paint brushing tools
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Here below is a table showing the effect of each of the brushes.

Brushing tool Brushing tool effect 

Brush

Oil brush 

Water brush

Crayon 

Marker 

Natural pencil 

Airbrush 

Calligraphy brush 1 

Calligraphy brush 2

Table 7.1: Brushing tools and their drawing effects

Note: apply these brush effects on your pictures the way you like.

Activity 7.6

Editing image
	࿤ Open ball.bmp file that you created earlier when saving files.
	࿤ Crop the upper part of the ball and paste it at the right of the 

entire ball.
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	࿤ Use eraser and fill with colour tools to come up to the following 
result.

Picture 7.24: Cropped ball-part pasted on the right and erazed

Activity 7.7

Drawing a flower
1.	 Open up Microsoft Paint from the Accessories folder in your 

Start Menu.
2.	 Drawing the stem using the wavy line tool, draw a curved and 

dark green line of medium-thick thickness in a position like in 
the picture. In order to curve the line, draw a straight line and 
then click and drag where you want to curve it. You can curve 
each line twice.
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	· Click Fill with colour tool,  choose yellow from colours group.

Curve

Picture 7.25: Green curved line drawn as stem

3.	 Choose the circle tool with a light yellow outline and a light 
yellow fill to draw a petal.
	· Choose circle, then from outline choose mark then you click 

light yellow.
	· Make an appropriately sized oval in the top left corner. 
	· Then fill the circle.

Circle Selected colour

Picture 7.26: Oval shaped circle, filled with yellow colour is added as the petal
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4.	 Select the petal, copy it and then paste in another petal.

Select tool

Copy button

Picture 7.27: Duplicate copy of the petal is added using copy and paste tools

5.	 Drag the petal down to the end of the stem.

Picture 7.28: The petals are dragged towards the stem
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6.	 Re-select the other petal using the box tool and then drag the 
petal down to the left side of the stem. Make sure that the 
second option is selected on the sidebar under the main tools 
as it will make sure not to overlap any of your previous work.

Picture 7.29: The duplicate petal placed on the left of the stem

7.	 Hit Ctrl-v to create another petal.

Picture 7.30: Another duplicate petal is pasted
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8.	 Click Rotate, then choose Rotate right 90º.

Picture 7.31: The petal is rotated vertically (Right 90o)

9.	 Move the petal down onto the flower. 

Picture 7.32: The petal is moved to build a flower
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10.	 Copy and paste the vertical petal, then drag it and draw a 
circle and fill light yellow as shown in picture 7.33.

Picture 7.33: The vertical petal is copied, pasted and dragged below the 
flowers

11.	 Use curve line to add small petals and fill with yellow.

Picture 7.34: Well drawn flower
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12.	 Starting at the base of the stem, draw the leaves on both 
sides.
	· Use a pencil to draw leaves and fill them with green colour.

Picture 7.35: Flower with base drawn as leaves on both sides

13.	 Use Pencil tool to add in some veins and make the leaves look 
more realistic.

Picture 7.36: Pencil is used to add some veins to leaves on flower
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7.9.10	 Working with layers in MS Paint

Steps for working with layers in Paint
Step 1:	 Draw an image (initial sketch) you want using a colour you 

do not want to be its final. In our case we are going to draw 
a book. Let us use Indigo colour pencil. 

Note: Make sure the colour you make your sketch is not the 
same colour you want your final drawing to be.

Picture 7.37:  A sketch of a book drawn in MS Paint using indigo colour 

Step 2:	 Select your final line-art colour you want and put it in the 
Colour 1 slot, leaving Colour 2 slot with white colour. In our 
case let us use red colour. Trace over your sketch using colour 
1 slot. Save your file as book. The sketch may appear as 
shown in picture 7.38.
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Picture 7.38: A sketch of a book redrawn using our favourite colour red by tracing 
over original image

Step 3:	 Put your initial sketch colour(Indigo) in Colour 1 slot, leaving 
colour 2 slot white. Click on the Eraser button and then 
RIGHT-CLICK while erasing your drawing. This action will 
remove the original colour.
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Picture 7.39: An image of a book where the original layer of line-art is erased

Step 4:	 Repeat step 2 and step 3 to get many different versions of 
the book. Save each different version you create and compare 
later. You can also fill in colours. 

7.9.11	 Microsoft Paint 3D
Microsoft Paint 3D is a new application (app) in Windows 10 Creators 
Update, designed for working with 3D graphics. It replaces the old 
Microsoft Paint program that allows users to sketch objects in 2D. It 
is a new version of MS Paint. MS Paint 3D comes with newer versions 
Windows 10 and it is meant to make 3D scenes, cartoony 3D objects 
much of fun. 

You still have the opportunity to use both Paint and Paint 3D on your 
computer. You can use Paint 3D to turn photos into 3D models, add 
colours and textures to models you make from 3D.
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Starting Paint 3D
Click Start and type paint in the search box. Paint 3D is one of the 
items listed, click on it to open. See picture 7.10. Eventually paint 3D 
opens with a welcome screen. 

Click Paint 3D (2)

Type paint on start- search  
box (1)

Picture 7.40: Launching Paint on the Start –search box
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Select one 
option here  

and then begin 
to use  

paint 3D

Picture 7.41 (a): The welcome screen for Paint 3D where you can select option to 
have a New file, open existing file or paste an object.

Active 
colour

Tools pane

Paste 

Toolbar

Maximize windowEffects Text Stickers 

Tools

3D objects Canvas 

Brushes  
e.g. Matte 

Expand menu

Adjust Zoom level here

Picture 7.41 (b): Paint 3D new blank document (untitled)



251

Introduction to Computer graphics

Paint 3D interface has the canvas, a flat, 2D digital backdrop for your 
scene. The canvass is an empty white background and appears behind 
your 3D image.  See picture 7.40.

 

Activity 7.8 (a)

Using MS Paint 3D, create the dog as shown below.  Then apply 
changes that will make dog A appear as shown by dog B. Use 
orange, green and dark grey colour plus a polished metal brush. 
Apply a spearmint effect, type the text “My dog is nice” on your 
model and save it as my dog.

Dog A	 Dog B

Use the following steps to perform activity 7.8 (a).

Step 1:	 Click on 3D objects on toolbar. On the Tools pane, select dog 
button and drag in the canvas to draw the dog. See picture 
7.41 (c).
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Click on 3D objects (1)

Click the 
dog (2)

You can draw 
shapes and 

display them 
in 3D

Use Doodle to 
quickly create a 3D

Picture 7.41 (c): A dog drawn as 3D model

Step 2:	 Click Tools on the toolbar and select a desired tool. In this 
case will select spray can tool and then select orange colour. 
Click on the parts of the dog to fill them. Rotate the dog using 
the floating rotate tool and apply orange colour. 

Select gray colour and apply on tail, legs and mouth parts. 
Select water colour and green colour and apply on neck parts 
of the dog. See picture 7.41 (d).

Experiment with 
these tools  

using different 
colours and  

see the effects

 Selected brush 

Watercolour tool 

Spray  
can tool

Rotate tool3D modal dog

Picture 7.41 (d): A dog covered with new effects
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Step 3:	 Click on the Effects button on the toolbar and select the 
spearmint effect in the tools pane. The results appear as 
shown in picture 7.41 (e).

Green colour effect

Picture 7.41 (e): Paint 3D showing spearmint effect on the 3D graphic

Step 4:	 Type text “My dog is nice”. Select the text tool on the toolbar 
and draw a box where you want in the canvas and then type 
the desired text.

Step 5:	 Save your file as a project. Procedure for saving Paint 3D 
project:

Click on the Expand menu button and then select Save As. 
See picture 7.41 (f).
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Click Expand button (1)

Click Save AS (2)

Selected effect

View 3D

Picture 7.41 (f): Accessing the Save options in MS Paint 3D

The complete project in 3D will appear as shown in picture 
7.41 (g).

Picture 7.41 (g): Completed 3D graphic in paint 3D
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Activity 7.8 (b)

1.	 Draw the following pictures in Microsoft Paint and save the files 
as their names shown.
a)	 House	 b)	 A pumpkin

2.	 Imagine and draw a picture of a learner seated attentively in a 
classroom lesson using graphics software of your choice. 

7.10	Using Photoshop
At the start when you open Photoshop it displays a dark interface as 
shown below in picture 7.42.

7.10.1	 Create a new Photoshop file
Step 1: 	 When Photoshop opens, click on File menu and select New.

In the new document screen that appears, select a category 
of orientation for your document; then type in the file name 
in the PRESETS DETAILS pane. 

Click OK at the bottom. The new named document will 
display with a white background as shown in picture 7.42.

Picture 7.42: New Document screen



256

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

Picture 7.43: A new Photoshop Document

Activity 7.9

Use the available digital camera and take desired photos as you 
master how to use it. Pick a suitable rough photo from your camera 
or open an existing rough photo in Photoshop . Edit the photo by : 

a)	 Adjust image size to a suitable size.
b)	 Reduce the roughness of the background or skin.
c)	 Apply desired text depending on the image applied in the upper 

right hand corner.
d)	 Crop part of the image and discard the rest. Save changes.
e)	 Rotate the cropped image by 180 degrees.

Follow procedure below

7.10.2	 Open an image
Step 1: 	 Open or Add an image: In a new file select Open on file 

menu.

Step 2: 	 Select an image you want. The image I have chosen here 
below is an elephant:
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Picture 7.44: Save As option

Picture 7.45: A new image in a new file

7.10.3	 Resize image
Step 3: 	 Adjust Image Size: Use Image menu and adjust image to the 

size you want. Click Image Size on the Image menu

Make other adjustments using Image menu. See picture 
7.46.

Note: In case of a mistake you make in using Tools, 
press CTRL+Z (Un Do) but if there are several mistakes, 
then press ALT+CTR+Z to reverse those actions.
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Picture 7.46: A Resized image

Click Image Size  
(or use button)

Picture 7.47: Options for adjusting images and making adjustments

7.10.4	 Use brushing tools
Step 4: 	 Remove some rough elements on the animal skin. Use the 

Spot Healing Brush and Blur Tool. Afterwards apply some 
light on parts using Dodge Tool.
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7.10.5	 Add text to photo
Step 5: 	 Add text to the upper right hand corner as “African Elephant”. 

Use the ‘Horizontal Type Tool’ and draw a textbox in required 
position. Type the text. You can format the text using menu 
items below the menu bar. The text may appear as shown in 
picture 7.48.

Crop tool

Spot Healing brush

Blur tool

Horizontal 
Type tool

Picture 7.48:  Text is added to image and rough spots removed

7.10.6	 Crop an image
Step 5: 	 To Crop an image. Select the Crop Tool from image menu or 

from Toolbox and then select part of the picture you want to 
crop. You can press the check button on toolbar.
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7.10.7	 Rotate an image
Step 6: 	 Using the Image menu, on Image Rotation menu select 

1800. You can use a different option. 

Picture 7.49: Cropped and rotated image

Note: Photoshop generates better picture because many actions 
are done in a much professional way using advanced tools. 
Practice editing images using all the tools available in Photoshop 
to build your skill. If you need to draw lines and shapes within your 
image, you can use Pen tool.

Keyboard shortcuts 
Keyboard shortcuts can greatly increase your productivity. Here are 
some of the more common ones: 

	࿤ New Canvas: Ctrl+N 
	࿤ Cut: Ctrl+X 
	࿤ Paste: Ctrl+V 
	࿤ Copy: Ctrl+C 
	࿤ Save: Ctrl+S 
	࿤ Delete: Del 
	࿤ Print: Ctrl+P 
	࿤ Undo: Ctrl+Z 
	࿤ Highlight All: Ctrl+A 
	࿤ Open: Ctrl+O 
	࿤ Redo: Ctrl+Y 
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	࿤ Hide Toolbar: Ctrl+T 
	࿤ Open Attributes: Ctrl+E 
	࿤ Stretch And Skew: Ctrl+W

End of Unit 7 Assessment

Multiple choice questions
1.	 Which of the following will you use to select any irregularly 

shaped part of the picture?
A.	 Free-Form Select	 B.	 Select		
C.	 Eraser 	 D.	 Fill with Colour

2.	 Which of the following indicates the current foreground and 
background colours?
A.	 Free-Form	 B.	 Eraser
C.	 Colour box	 D.	 Select

3.	 Which of the toolbox is used to erase areas of your picture?
A.	 Free-Form	 B.	 Eraser
C.	 Magnifier	 D.	 Brush

4.	 Which of the following will you use to fill the entire picture or an 
enclosed shape with colour?
A.	 Airbrush 	 B.	 Fill With Colour	
C.	 Pencil	 D.	 Colour box

5.	 To zoom in on a section of your picture, you should use;
A.	 Magnifier 	 B.	 Free-Form	
C.	 Brush	 D.	 Eraser 

6.	 To select any square or rectangular part of the picture, which 
toolbox will you use?
A.	 Line	 B.	 Fill with colour
C.	 Free-form select	 D.	 Select

7.	 Which of the following is used to set the current foreground or 
background colour of a canvas?
A.	 Airbrush	 B.	 Brush
C.	 Pick colour	 D.	 Text

8.	 A toolbox used to draw thin, free form lines or curves.
A.	 Pencil	 B.	 Airbrush	
C.	 Brush	 D.	 Text
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Practical work
1.	 Create a simple image using some of the drawing tools in Paint 

(Pencil, Brush, Airbrush and Filled shapes).
a)	 Selecting and moving part of an image.
b)	 Selecting and copying part of an image.
c)	 Storing an image in a file Bmp as a large uncompressed 

file and Jpg as a smaller compressed file.
d)	 Using the image in a Word document.

2.	 Use Paint to create the following effects:
Draw a picture of some people stick figures. Be creative! The 
Figure below is an example.

3.	 Draw the following

Picture 7.50: Mountain drawn with MS Paint
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4.	 Using Ms paint, draw a flag of Rwanda as shown below.

Picture 7.51: National flag of Rwanda

a)	 Create a folder named ‘lab2’. Create an image using 
Microsoft Paint, and save as a 24 bit .bmp file Start with 
a good size canvas, use lots of colours: DO something 
interesting! Include many different colours, lines, circles, 
etc. Save as a 24 bit .bmp file called 24bit.bmp.

Picture 7.52: Save As dialog box in MS Paint displaying file types

b)	 •	 Save as a 256 colour.bmp file called 8bit.bmp. 
•	 Save as a 16 colour .bmp file called 4bit.bmp. 
•	 Save as a monochrome .bmp file called 2bit.bmp. 
•	 Close Paint.
•	 Start a new Paint session, and open 24bit.bmp.
•	 Save as a tiff file called 24bit.tif.
•	 Close Paint.



264

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

•	 Start a new Paint session, and open 24bit.bmp. 
•	 Save as a gif file called 24bit.gif (will warn about 

colour loss).
•	 Close Paint.
•	 Browse to your lab2 folder, and compare file size. 
•	 Right click each image, and choose Preview to 

compare how the images look.
5.	 Take a picture of yourself using a digital camera and edit the 

photo in a way you wish using various tools on the Toolbox and 
menu. In case of absence of a camera, use any available photo 
on your computer and perform editing functioning to crop, 
resize, flip, rotate and magnify parts of the picture.

6.	 Scan or search from Internet for these pictures below and 
introduce them into Photoshop. Edit the pictures by adjusting 
their brightness or contrast, resize and change their colour 
or add a different background. Save the changes. Use other 
pictures provided by the teacher and edit them accordingly.

	
Picture 7.53: Small car (a) and Cubs walking (b)

7.	 Create a line, a curve, polygon, a circle and a square using 
Photoshop. Make the shape outlines coloured and filled with 
colour effects where possible. Apply accompanying text. Save 
the file as Super shapes.
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8.	 Draw the pictures below using MS Paint and then MS Paint 
3D.

	 a)	 Cube	 b)	 Hut

	



APPLICATION SOFTWARE
Graphics and Multimedia
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Unit
88

Introduction to Multimedia

Key unit competence

Explain the different uses of multimedia and interactive multimedia 
applications. Use multimedia software to create a video.

8.1	 Introduction
Multimedia has become familiar in our life, it can be found in different 
areas of life such as in education, business, wedding ceremony and 
others. In these days, with the evolution of the use of computer, 
the demand of multimedia contents has also increased, multimedia 
content can be: movies, power-point presentation and audio sounds.

8.2	 Definition
Multimedia is the collection of  medias that use multiple  forms  of  
information content  and  information processing to inform or entertain 
the user.

Examples of multimedia contents are; text, audio, graphics, animation, 
and video.

Multimedia also refers to the use of electronic media to store and 
experience multimedia content. 

Multimedia information can be represented in form of audio file, 
graphical file, image file, video file and animation file.  
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8.3	 Categories of multimedia
Multimedia may be broadly divided into linear and non-linear 
categories.

	࿤ Linear multimedia; active content progresses without any navigation 
control for the viewer/user. 
Examples:  Movies, video clips and songs.

	࿤ Non- linear multimedia content offers the ability to control the 
content interactivity with the user/viewer.
Examples: Computer games, assimilation software used in self 
computer based trainings.

Multimedia presentations can be live or can be recorded. 
	࿤ A recorded presentation is a presentation which has been recorded 

and edited, after all processing stages.
Example: TV programme. 

	࿤ A live multimedia presentation occurs when things are happening 
at that moment.
Examples: News on television and Football game.

8.4	 Features of multimedia
	࿤ Presentations may be viewed in person on stage, projected, 

transmitted, and played locally with a media player. 
Examples: Power point presentation and cinema presentation.

	࿤ Games and simulations may be used in a physical environment 
with special effects, played /used by multiple users on the computer 
network and locally with an offline computer, game system,  
simulator.
Examples: Online games and game on mobile telephone. 

8.5	 Types of multimedia
	࿤ Text: It is used as the basic element for all multimedia applications. 

It is directly used to inform users about the information that it 
wishes to communicate.

	࿤ Graphics: It uses pictures as visuals in digital form used in 
multimedia presentations. 
There are two types of graphics:
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(i)	 Bitmap Graphics (Image Raster): Formed by pixels arranged 
in specific ways in a matrix form.

(ii)	 Vector Graphics: Formed by lines that follow mathematical 
equations called vector.

	࿤ Animation: It is the process of adding movements to static images 
or picture through using various computing methods.

	࿤ Audio: It is the sound in digital form used in multimedia 
presentations.

	࿤ Video: Moving pictures in digital form in multimedia presentations.

Activity 8.1

Use internet or school library textbooks to make research and 
answer the following questions.

1.	 Explain the term multimedia.
2.	 Describe different types of multimedia.
3.	 Explain features of multimedia.
4.	 Using examples, describe categories of multimedia. 

You can share your opinions to the rest of the class.

8.6	 Applications of multimedia
The application of multimedia is found in various areas including:  
advertisements, art, education, entertainment, engineering, medicine, 
mathematics, business, scientific research and spatial. A few of 
application areas of multimedia are discussed below:

1.	 Commercial
Most of the electronic media used in commercial advertisement 
fall in multimedia. In most Rwandan cities, there is exciting 
presentations that are used to take and keep attention of people 
with the interest of advertising. 

2.	 Entertainment 
Multimedia is heavily used in the entertainment industry. It is 
especially used to develop special effects in movies and video games.

3.	 Education
In Education, multimedia is used to produce computer-based 
training courses  and reference books. 
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4.	 Industry
In the Industrial sector, multimedia is used as a way to help present 
information to shareholders, superiors and coworkers. Multimedia 
is also helpful for providing employee training, advertising and 
selling products all over the world via virtually unlimited web-based 
technologies.

5.	 Medicine
In Medicine, doctors can be trained to do human surgery and they 
can simulate how the human body is affected by disease viruses 
and how bacteria spread, using multimedia tools and then develop 
techniques to prevent it.

6.	 Multimedia in public places
In hotels, airports, shopping malls, museums, and grocery stores 
multimedia tools are available to help people/tourists to give 
information, they need.

Example: In airport, there is no need to ask plane information to the 
personnel of the airport; notice board is there to inform passengers. 

Activity 8.2

Using your school internet facilities
1.	 Search for multimedia application and compare your results.
2.	 Discuss the applications of multimedia in your local community. 
3.	 Compare what is happening in other communities and what 

you have found in your community. 

8.7	 Hardware and software in the 
multimedia requirement

8.7.1	 Multimedia hardware
Below are some of the hardware that can be used in multimedia :

	࿤ Computer.
	࿤ Digital camera.
	࿤ Microphone.
	࿤ Scanner.
	࿤ Speaker /headphone.
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Camera Head phone

Digital camera Computer

TV (screen) Scanner

Speaker Microphone CD/DVD

Picture 8.1: Different categories of multimedia hardware



272

Information and Communication Technology (ICT) for Rwanda Schools Learner's Book 3

8.7.2	 Multimedia software

Software Description

Adobe Acrobat Pro Protect  documents  and  accelerate  information 
exchange with PDF.

Adobe	 Creative	Suite 
Master Collection

Contribute, Dreamweaver, Fireworks, Flash Pro, 
Illustrator, InDesign, Photoshop, Premier Pro, and 
supporting applications.

Facetime Make video calls.

Final Cut Studio Pro Video Editing. Package includes Soundtrack Pro, 
Cinema Tools, and DVD Studio.

HandBrake Video encoder.

iCal Personal calendar application.

Image Capture Upload pictures from digital cameras or scanners.

iTunes Download media for Mac, PC, iPod and iPhone.

Microsoft Office Suite PowerPoint.

PhotoBooth Take photos and videos with an iSight camera.

Table 8.1: Multimedia software

These hardware and software are used together to make up the 
multimedia system which can capture, digitise, compress, decompress, 
retrieve multimedia data and show it on the output device like computer 
monitor and multimedia projectors.

Activity 8.3

1.	 Discuss other multimedia hardware and software which are 
not discussed in here. Use the facilities available within your 
school.

2.	 Identify multimedia hardware which are used in your school.
3.	 List multimedia software that are installed in school computer 

lab.
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8.8	 Interactive multimedia

8.8.1	 Create hyperlinks to link to a slide in the current 
presentation.

A hyperlink is a logical link that creates a connection between files. 
You already know how to use MS PowerPoint presentation. Now open 
the program and perform the following actions. You should use an 
existing file.

Step 1:	 In Normal view, select the text, shape, or picture that you 
want to use as a hyperlink.

Step 2:	 On the Insert tab, in the Links group, click Hyperlink.

Select Insert (1) Click here (2)

Picture 8.2: Hyperlink button on Insert tab

Step 3:	 In the Insert Hyperlink dialog box, under Link to, click Place 
in this Document.

Choose the slide you want to link

Select this option

Picture 8.3: Insert Hyperlink dialog box. Current presentation is used
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Activity 8.4

Create a PowerPoint presentation “Rwanda Nziza”. This presentation 
has the following slides:
	· Slide 1: Province.
	· Slide 2: Northern Province.
	· Slide 3: Eastern Province.
	· Slide 4: Southern Province.
	· Slide 5: Western Province.
	· Slide 6: City of Kigali.

Link slide 1 to other remaining slides in any way that you can jump 
from slide1 to any other of these slides.

Step 4:	 Select “First slide, Next slide, Previous slide or Last slide”. 
You can use slide titles.

Step 5:	 Click Ok.

8.8.2	 Create hyperlinks to link to a slide in a different 
presentation

Use the following steps to link a slide in a different file.

Step 1:	 In Normal view, select the text, shape, or picture that you 
want to use as a hyperlink.

Step 2:	 On the Insert tab, in the Links group, click Hyperlink.

Click on Insert Click Here

Picture 8.4: Hyperlink command on Insert tab

Step 3:	 Under Link to, click Existing File or Web Page.

Step 4:	 Locate and select the presentation file that contains the slide 
that you want to link to.

Step 5:	 Click Bookmark and then click the title of the slide that you 
want to link to. Click Ok and then Ok.
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Click here, computer will 
remember the slide in different 

presentation

Click here to browse 
the existing file

Picture 8.5: Insert Hyperlink dialog box. An existing file is used.

Activity 8.5

Create a PowerPoint presentation “My school” and connect it to the 
previous presentation “Rwanda Nziza”. “My school” presentation 
should contain the slides about your school as follows:

Slide 1:	 Name of your school and school motto.

Slide 2:	 Location of your school, addresses or contacts. 
Headmaster’s name.

Slide 3:	 5 male and 5 female teachers in your school.

Slide 4:	 Sports activities in your school.

Slide 5:	 Co-curricular activities in your school.

Slide 6:	 Subjects taught in your school.

8.8.3	 Create hyperlinks to link to an e-mail address
Step 1:	 In Normal view, select the text, shape, or picture that you 

want to use as a hyperlink.

Step 2:	 On the Insert tab, in the Links group, click Hyperlink.
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Select Insert Click Here

Picture 8.6: Ribbon with Hyperlink highlighted on Insert tab

Step 3:	 Under Link to, click E-mail Address.

Step 4:	 In the E-mail address box, type the e-mail address that you 
want to link to, or in the Recently used e-mail addresses box, 
click an e-mail address.

Step 5:	 In the Subject box, type the subject of the e-mail message.

Type here  the  email you want to linkClick here to link an email

Picture 8.7: Insert Hyperlink dialog box. Email address is used.

Activity 8.6

Open a PowerPoint presentation “My school” and connect it to the 
class email “classsenior3@gmail.com”.
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8.8.4	 Create hyperlinks to link to a new file
Follow the steps below to create a link between my school and 
classroom3@gmail.com.

Step 1:	 In Normal view, select the text, shape, or picture that you 
want to use as a hyperlink.

Step 2:	 On the Insert tab, in the Links group, click Hyperlink.

Click HereSelect Insert

Picture 8.8: Hyperlink button highlighted on Insert tab

Step 3:	 Under Link to, click Create New Document.

Step 4:	 In the Name of new document box, type the name of the file 
that you want to create and link to.

Note: If you want to create a document in a different 
location, under Full path, click Change, browse to the 
location where you want to create the file, and then click 
OK.

Step 5:	 Under When to edit, click whether you want to Edit the new 
document later or Edit the new document now.
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Click here Type the Full path of where you are going to save

Picture 8.9: Insert Hyperlink dialog box. New document is used

Activity 8.7

Open presentation “My school” and connect it to the new 
presentation you are going to create “My Class”.

“My class” presentation should contain the following information:

Slide 1:	 Name of your class e.g. S.3.A.

Slide 2:	 List of 10 girls in your class.

Slide 3:	 List of 10 boys in your class.

Slide 4:	 Reasons why learners like ICT.

Slide 5:	 Disadvantages of ICT to learners.

8.9	 Create action buttons
An action button is a shape used to perform a certain action like going 
to the next or previous slide, play or pause,...

8.9.1	 Add commands to your presentation with action 
buttons

Follow the steps given below to use Action buttons. Step 1:	 O n 
the Insert tab, in the Illustrations group, click Shapes, and 
then under Action Buttons, click the button shape that you 
want to add.
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Choose Action 
Buttons here

Picture 8.10: Collections of shape categories on Insert tab

TIP: Action buttons provide great visual cues to the action it 
launches, but you can also assign actions to other objects, 
such as clip art, pictures, general shapes, or to the text in 
a SmartArt graphic. Use the procedure below to add an 
action to those objects as well.

Step 2:	 Click a location on the slide, and then drag to draw the shape 
for the button.

Step 3:	 In the Action Settings dialog box, do one of the following:

•	 To choose the behaviour of the action button when you 
click it in Slide Show view, click the Mouse Click tab of 
Action setting dialog box.

•	 To choose the behaviour of the action button when you 
move the pointer over it in Slide Show view, click the 
Mouse Over tab.
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Picture 8.11: Action button is added to link to last slide

Add a button shape, and then assign an action (in this case, 
a hyperlink).

Step 4:	 To choose the action that will take place when you click 
or move the pointer over the action button, do one of the 
following:

TIP:  To play a sound, select the Play sound check box, 
and then select the sound that you want to play.

Step 5:	 When you’ve finished choosing your action, click OK.

Activity 8.8

Insert in each slide play buttons and stop buttons on the last slide 
in “my class presentation”.
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8.9.2	 Insert an MP3 audio file into a presentation

Activity 8.9

You are provided with an audio file which has mp3 file extension.  
Insert the audio file into “my class presentation” in the 3rd slide.

Step 1:	 Click on Insert tab of menu bar, then in Media group click on 
the Down arrow of the Audio icon. On the drop down list click 
on Audio on My PC.

Picture 8.12: Audio on My PC is selected under Audio button on Insert tab

Step 2:	 Locate and select the desired audio file, then click Insert.

Click on Insert 

Select Audio file

Picture 8.13: Insert Audio dialog box
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Step 3:	 The audio file will be added to the slide.

8.9.3	 Insert a video file into a presentation

Activity 8.10

You are provided with a video file.  Insert the video file into “my 
class presentation” in the 4th  slide.

Step 1:	 From the Insert tab, click the video drop-down arrow, and 
then select a video by clicking on Video on My PC.

Select Video on my PC

Picture 8.14: Video on My PC is selected from Audio button under Insert tab

Step 2:	 Locate and select the desired audio file, then click Insert.

Click on Insert 

Select a Video file

Picture 8.15: Insert Video dialog box
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8.9.4	 Insert a CD audio track in the presentation

Activity 8.11

You are provided a CD audio track.  Insert the CD audio track into 
“my class presentation” in the 5th slide.

If you want to add the Play CD Audio Track command back to 
the Insert tab, you must create a custom group and then add the 
command to the new group. To do this, follow these steps:

Step 1:	 Click the File tab, and then click Options in the navigation 
pane.

Step 2:	 In the navigation pane of the PowerPoint Options window, 
click Customise Ribbon.

Step 1

Step 2

Picture 8.16: Backstage view and General Powerpoint options. Click Customise 
Ribbon
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Step 3:	 In the Customise ribbon column, in the Main Tabs list, 
expand Insert, and then select Media.

Step 3

Step 4

Picture 8.17: Customise Ribbon options
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Step 4:	 Under the Main Tabs list, click New Group. The new 
group named New Group (Custom) is inserted under the 
Media group.

Step 5:	 Click Rename, type CD audio, and then click OK.

Step 6

Step 5

Picture 8.18: Main Tabs Sections in the Customise Ribbon screen. New media 
group is created
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Step 7

Picture 8.19(a): Rename dialog box on top of Powerpoint options window

Step 6:	 In the Choose commands from drop-down list, select All 
commands.

Step 7:	 Locate and then select the Play CD Audio Track command, 
and then click the Add button. The command appears 
under the new CD Audio group.

Step 8:	 Click OK.
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Select “Play CD…..” (2)

Click 
Add (3)

Select All Commands (1)

Picture 8.19 (b): PowerPoint Options dialog box- for customising Ribbon

Step 9:	 Return to Insert tab and click play CD Audio Track from 
CD Audio group (new group created). This will work as 
long as you have the CD inserted in computer.

8.10	Create digital image, audio and video 
file 

Activity 8.12

You are provided with a digital camera or smart phone elaborate 
on:

1.	 How to capture a video  using a digital camera / Smartphone. 
2.	 How to take a picture using a digital camera / Smartphone.

After the  teacher has demonstrated on how to do the activity, 
take a video of 4 minutes and 6 pictures to be presented in 
class.
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Step 1:	 Open and switch on digital camera.

Step 2:	 Click the Video Capture button.

Click on the Capture button

Picture 8.20: Part of digital camera with Video Capture button

8.10.1	Manipulate an image

Activity 8.13

In reference to Activity 8.12, open GIMP software and use the 6 
pictures you have taken and do the followings:

1.	 Crop the pictures.
2.	 Rotate to 128 degrees.
3.	 Save the pictures on the desktop.

We are going to use GIMP (GNU Image Manipulation Program). It is 
free software and it is a powerful application that can alter, manipulate, 
enhance, and create digital image files. This software should be 
downloaded and installed on your computer.

Saving an image
To save an image file;

Step 1:	 Right-click on the image, follow the steps below;

Step 2:	 Choose File.

Step 3:	 Select either Save or Save As. 

Step 4:	 The Save Image window opens. 
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Create a new image
Step 1:	 Click File then New.

Click on this 
option

Picture 8.21: File menu for Gimp Software
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Step 2:	 Enter the image size, image type, and fill type of the file.

Picture 8.22: Create a New Image dialog box for Gimp Software

Step 4:	 Click the OK button.

Step 5:	 Edit and manipulate the image with the GIMP’s various tools.

Step 6:	 Save your file.

Editing an image

Steps to crop an image
Step 1:	 Open the image.

Picture 8.23: File menu with open button highlighted in Gimp Software
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Step 2:	 Browse your picture from the computer.

Step 3:	 Right click on the image and select  Tools  =>  Transform 
Tools => Crop.

C
lic

k 
he

re

Picture 8.24: Displayed image is right clicked to access needed commands and 
Tools

Step 4:	 Left-click and drag the mouse pointer to create a frame that 
fits the part of the image to keep.

Step 5:	 Click the Crop button in the window that opens as you drag 
the frame across the image.

Step 6:	 If you are unhappy with the cropped image, press [Ctrl]-[Z].

To Rotate an image
Step 1:	 Open the image.

Step 2:	 Right-click on the image and in drop down list select Image. 
In the drop down list that appears  click on Tool then 
from the list click on transform. From the new list click on 
Flip or Rotate.
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Picture 8.25: Image in window is right clicked to access Rotate Command

Step 3:	 If you are unhappy with the changes, press [Ctrl]-[Z].

Activity 8.14

Record audio file (on your computer)
Follow these steps to create or record an audio file on your computer

1.	 Connect a microphone on your computer. A microphone can 
connect through USB port (USB microphone) or input jack- 
(audio port) for microphone. Some computers come with built-
in microphone. If you don’t have microphone, use headphones.

2.	 Open Windows Voice Recorder. Follow procedure given below: 
	· Click Start
	· Click All Apps
	· Select Voice Recorder

Alternatively, you click in the Search box near the Start button 
and type Voice and then click Voice Recorder.
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Note: Voice Recorder is a small application in Windows 
OS having the capability to make sounds louder, quieter, 
faster or slower.

3.	 In the Voice Recorder window, click Record button to record 
your message. When you click Record button, wait for 3 
seconds and then start to speak or sing. When you have finished 
speaking or singing, wait for 3 seconds and then click on Stop 
recording button. This will prevent the recording to start or stop 
abruptly. See the picture below.

Stop recording

Pause/Resume recording

Add a marker

Picture 8.26: Voice Recorder window
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4.	 Click Play to hear your message or song. (See picture below)

Selected recording
(You can share, delete or 
rename by right-clicking)

Play 

Delete Rename

Share 

Record

Picture 8.27: Voice Recorder showing recorded files you can play

Note: When you are not pleased with your recording, you 
can delete it and then record again or record new files for 
comparison.

When audio file (s) is named and played, may appear as shown.
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Renamed file

Pause 

Picture 8.28: Voice Recorder showing renamed audio files

Create/record video
There are two main ways you can use to create video on your computer 
i.e. using Microsoft PowerPoint and using Windows Movie Maker. 

Method 1: To create/record a video file (with PowerPoint) follow 
steps below:
1.	 Create a PowerPoint presentation and save it. You can also open 

an existing presentation. In this activity, let us open Nature-protect 
presentation we created in unit 6. 

2.	 Add transitions and animations to your PowerPoint presentation 
in case they are missing (follow steps for adding animation and 
transitions in Unit 6)

3.	 Add audio to your presentation: on Insert tab, in the Media group, 
click Audio. On the Audio menu, select Audio on My PC… See 
picture below.

Audio 

Picture 8.29: The PowerPoint Insert tab showing the Audio button (highlighted)
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After the audio  has been inserted you will need to edit it by selecting 
it then click on playback tab on the menu bar. You will get a ribbon for 
audio tool editor as shown below:

Click to trim audio Click to adjust volume

Click Play in 
background

Picture 8.30: The PowerPoint Ribbon showing Audio Tools on Playback tab

4.	 Record narration and add timings to the slide show

Record a narration during a presentation
	· In Normal view, select the slide that you want to start the 

recording on.
	· On the Slide Show tab, in the Set Up group, click Record Slide 

Show.

Click Start recording 
to begin running 

the presentation as 
set either manually 

using mouse or 
automatically using 

timings set.

Picture 8.31: The Record Slide Show window from the Record Slide show button

	· In the Record Slide Show box that displays, click Start Recording 

5.	 Export (save) your PowerPoint presentation as a video by;

Click File tab, select Export and then click Create Video. On the 
recording tab of the ribbon, click on Export to Video.
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Select Video quality you 
need. The higher the video 
quality the larger the file 

size (3)

Click Create a Video (2)

Click Create 
Video (6)

Select appropriate 
option (4)Adjust timing 

in seconds to 
spend on each 
slide box (5)

Click Export (1)

Picture 8.32: The Backstage screen for Exporting PowerPoint file (Create a Video)

6.	 Click Create a Video

Select 
MPEG-

Video or 
Windows 

Media 
Video 

(Optional)

Type/edit file name (2)

Click Save (3)

Browse for the 
folder to contain 

this file (1)

Picture 8.33: Save As dialog box for saving a PowerPoint file in a video format

Track the progress of the video creation by looking at the status bar at 
the bottom of your screen. See picture 8.34 for status bar.
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Progress bar

Picture 8.34: A PowerPoint file being converted into a video as depicted by status 
bar.

Note: The video creation process can take many hours 
depending on the length of the video and the complexity of 
the presentation. If the video is long, you can set it up to be 
created overnight. By morning time, it will be ready. 

To play your newly-created video, go to the folder location, 
and then double-click the file.

Activity 8.15

Create or open any presentation file you have on a computer and 
use it to make a video file.
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Method 2: To create video (movie) file - using Windows Movie 
Maker
Start Windows Movie maker 

Note: Users of Windows 10 must have to download Movie 
Maker and install it on their computers. When Windows Movie 
Maker is ready, then:

First add videos and photos to Movie Maker following the 
procedure below:

(i)	 In Movie Maker, on the Home tab, in the Add 
group, select Add Videos and Photos. 

(ii)	 In the Add Videos and Photos dialog box, open the 
folder that contains the photos or videos that you 
want to add, select the video files and photos, and 
then select Open. 

Click Add Videos 
and Photos for 

creating your Movie

Picture 8.35: Movie Maker Window (with blank file)
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Select a location containing 
your videos or photos you 

need (1)

Select a photo/
video you want 

(2)

Click Open to 
open selected 

item (3)

Picture 8.36: Add Videos and Photos dialog box

To select multiple photos or videos, press and hold the Ctrl key, and 
then select each photo and video you want. 

Note: You can import photos and videos from many different 
kinds of cameras and devices to your PC using Movie Maker. 
For example, a webcam built into your PC, a data CD/DVD, 
digital camera, flash disk, or Secure Digital card (SD card) in 
a card reader. With your webcam you can record a live video 
and add to Movie Maker.
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Music added

Click to add 
music to your 

movie

Add title, 
Caption and 
Credits to 
your movie 

items

Play button

Picture 8.37: Movie Maker window with pictures added for making a movie

Add and edit audio - in Movie Maker
Your movie requires you to add a soundtrack to feel professional. Later 
you can use editing tools to adjust the volume, fade music in or out. 

To add music
1.	 On the Home tab, in the Add group, select Add music. 

Click Add music button (1)

Click Add music (2)

Picture 8.38: The Add music menu on the Home tab of Movie maker

2.	 Select the music file you want to use, and then select Open.
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Select 
location 
music file

Select 
music file 
you want 

-2

Picture 8.39: Add Music dialog box

To fade music in or out
Fade in is the progressive increase of volume as the audio is being 
played while fade out is the decrease of the volume.

1.	 Select the music you want to fade in and or out.
2.	 Under Music Tools, in the Options tab, in the Audio group, do 

either and or:
	· Select the Fade in list, and then select the speed for the music 

to fade in.
	· Select the Fade out list, and then select the speed for the music 

to fade out. See picture below.

Adjust volume with 
“Music Volume”

Fade tools

Picture 8.40(a): Movie maker Music tools on the Ribbon 
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To change the start or end point of the music
Use picture above and follow steps given below:

1.	 Select the music.
2.	 Drag the playback indicator on the storyboard to the point in the 

music where you want it to start or stop playing in your movie. 
Then do one of the following:
	· To set a new start point for the music to start playing at the 

current point, under Music Tools, on the Options tab, in the 
Editing group, select Set start point.

	· To set a new end point so the music stops playing at the current 
point, under Music Tools, on the Options tab, in the Editing 
group, select Set end point.

To change the audio volume of a music item
1.	 Select the music.
2.	 Under Music Tools, on the Options tab, in the Audio group, select 

Music volume, and then move the slider left to lower the volume 
or right to increase it.

Edit video (Movie Maker)
There are several applications used today to edit videos/movies and 
movie maker is one them. You can use it to make your video/movie 
look the way you want it to be. One way of editing video is to trim it as 
described below. See edit video tools in picture 8.41.

Trim your video (see picture 8.41 and 8.42)
You can trim the beginning and the end of a video such that the video 
shows only the part you want. For example, if you have a video with 
black frames at the beginning, you could trim the beginning of the video 
so the black frames don’t appear in your final saved movie, however 
this does not affect the original video file.
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To trim a video in Movie Maker 
1.	 On the Home tab, in the Add group, select Add videos and photos.

Click Add videos and photos button

Picture 8.40 (b): Some of the commands on the Home ta of Moviemaker 

2.	 In the Add Videos and Photos dialog box, open the folder that 
contains the photos or videos you want to add, select the video file 
or photo, and then select Open. See picture 8.40 (c).

3.	 Select the video that you want to trim.

Select video (1)

Click Open (2)

Picture 8.40 (c): Add Videos and Photos dialog box

4.	 Under Video Tools, on the Edit tab, in the Editing group, click on 
Trim tool, either set start point or set the end point.   
	· Move the slider underneath the preview monitor to the point 

that you want the video to start, and then select Set start point. 
See picture 8.41 and 8.42. 

	· Move the slider underneath the preview monitor to the point 
that you want the video to stop playing, and then select Set end 
point. See pictures 8.41 and 8.42.
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Click Split to divide your video into two parts

Click Trim tool to trim your videoAdjust speed

Picture 8.41: Video tools

Click to save 
trimmed video

End pointStart point

Picture 8.42: Movie Maker showing a trimmed video

Note: To remove the start and end points and allow the whole 
video to play, repeat 1 – 3 above. Move the start trim handle 
to the beginning of the video and end trim handle to the end 
of the video (in their original locations). Afterwards click Save 
trim to save the changes. 
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Split a video

You can split a video into two smaller items and then continue editing.

To split a video into two items
1.	 Select  your video, and drag the playback indicator to the point 

where you want to split the video.
2.	 Under Video Tools, on the Edit tab, in the Editing group, select 

Split  (see picture 8.41). 

Speed up or slow down a video

Change the speed of your video in Movie Maker to make it play faster 
or slower by:

	࿤ Selecting  the video, and under Video Tools, on the Edit tab, in 
the Adjust group, select the Speed list, and then select a speed 
(depending on how much you want to speed the video up or slow 
it down). See picture 8.41.

Activity 8.16

Use a digital camera to capture video (s) about different activities 
different learners do during either break or lunch time. Use this 
video in windows Movie Maker and trim as you may like. Split the 
video into two parts and burn each part on a separate compact 
disk.

End of Unit 8 Assessment

1.	 List at least 5 multimedia tools used in your community (Village, 
Town, Home, and School).

2.	 In which area are these multimedia tools being used?
3.	 Open MS PowerPoint and create the following presentation:

a)	 Geography of Rwanda , it must have 8 slides
b)	 Cities of Rwanda , it must have 6 slides
c)	 Gender in Rwanda, it must have 5 slides

Therefore create the following hyperlinks:

(i)	 In geography of Rwanda presentation , link the 
second slide and the last slide.
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(ii)	 Link together cities of Rwanda and geography of 
Rwanda presentation in the third slide of cities of 
Rwanda presentation.

(iii)	 Link gender in  Rwanda to your class email. Save 
the presentation as “Beauty of Rwanda”.

4.	 Use a digital camera and do the following:
a)	 Take 20 pictures which show learners doing different 

activities. 
b)	 Record a video in your school where learners are in 

extra-curriculum activity (learners in sport, different club 
and other activities).

5.	 Explain 5 ways in which you can use pictures captured by 
digital camera on different school activities.

6.	 Open voice recorder on your computer and record yourself 
singing the:
a)	 National anthem
b)	 School anthem
c)	 East African anthem

7.	 Introduce one audio track in Powerpoint and edit it by trimming 
parts you do not want at the beginning or at the end of the 
track.

8.	 Take a video about learners playing football or netball using 
digital cameras. Introduce the video into Windows Movie maker 
and edit the video by splitting it into two parts.



COMPUTER NETWORK AND 
DATA COMMUNICATION
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Unit
99

Network Security

Key Unit Competence

Explain network security and apply basic security measures.

9.1	 Introduction to Network security
Network security consists of policies implemented to prevent and 
monitor unauthorised access, misuse, modification, or denial of a 
computer network and network-accessible resources. 

It includes all technologies designed to protect the usability and 
integrity of computer network and information.

Implementing network security can save a business from malicious 
hacking and virus attacks that could cause a great data loss.

Network security and privacy are major issues in data communications. 
To deal with internal and external security threats, networks need to 
be safeguarded with antivirus and firewall solutions.  Good computer 
networks must meet performance levels expected. Good networks 
should also be reliable, consistent, and meet recovery procedures and 
security criteria to maintain smooth flow of data in an organisation.
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Activity 9.1

Research on the internet or library books and answer the following 
questions.
1.	 Explain the meaning of the term network security.
2.	 Distinguish between the terms security and threat.
3.	 Identify security threats that are common with computer 

networks today.
4.	 Suggest solutions that can be used to safeguard a computer 

network. 
5.	 What are computer viruses? What risks are involved when a 

computer virus attacks your system?
6.	 How do you get to know that your computer is having a virus?
7.	 Explain what you can do to protect computer system from 

viruses.

Practical 
8.	 Scan your computer with installed antivirus.  If viruses are 

found, delete them. Turn on your internet connection and 
allow the antivirus to auto update itself (or if it requests for 
permission to do so allow it). Scan any available external 
disk e.g. flash drive before use.

9.2	 Definitions of terms
	࿤ Security: This is a state of feeling safe and protected. Something 

that provides a sense of protection against attack, harm or loss is 
security.
	· Computer security means techniques developed to safeguard 

information stored on computer network.
	࿤ Threat: This is a possible danger that might exploit a vulnerability 

to breach/break security and therefore can cause damage, pain 
and loss. Vulnerability is a weakness in a system which allows an 
attacker to reduce system’s information assurance. 

	࿤ Authentication: This is a process used to identify individuals based 
on username and password. This process establishes whether;
	· Someone or something is in fact who or what is declared to be. 
	· Authentication ensures that the individual is who he or she 

claims to be but nothing about access rights of an individual. 
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	· Authentication proves that somebody or something is genuine 
or valid. Authentication is a security measure and uses data 
encryption to identify the user and verify that the message was 
not tampered with. 

	࿤ Authorisation: This is permission to perform action. 
	࿤ Encryption: This is the process of encoding messages between 

two or more parties information such that hackers cannot read the 
message/information except the authorised parties. 

Restricted/sensitive information include: 

	࿤ Identity information such as social security numbers, identification 
card numbers, driving license numbers, etc. 

	࿤ Financial account information i.e. saving and credit card numbers, 
etc.

	࿤ Student record information e.g. learner’s grades, financial aid 
information, etc.

	࿤ Medical record information e.g. diagnoses, treatment information, 
etc.

Note: If your computer is lost or stolen and you have encryption 
activated, people who try to access information on the computer 
won’t be able to read it.

Note: Encoding is a method designed to protect the integrity 
of data as it crosses networks and systems i.e. to keep original 
message upon arriving at destination.

Importance of encryption
1.	 Encryption protects data in transit i.e. via computer networks like 

internet, e-commerce, mobile phones, wireless microphones, blue 
tooth devices and Automated Teller machines.

2.	 It is used today to protect information on computers and storage 
devices such as flash drives belonging to civilians.

3.	 It is used by governments and in the military to facilitate secret 
communication.

Decryption: This is the process of decoding messages information 
such that authorised parties can read them.

Sensitive information stored on computer must be encrypted (using 
encryption key) so that it cannot be understood if it is accessed without 
using a (decryption key) to decrypt the information. 
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Encoded or encrypted 
plan text (3)

Message

1

2 4

5

Message

Picture 9.1: How Encryption and Decryption work

Additional information for Picture 9.1. above
Elements of communicating data on a network include:

(i)	 Sender: This is a computer where message has been created 
by the user.

(ii)	 Encryption: This is the process of converting/encoding the 
message. The message is encrypted into cypher text form 
that cannot easily be understood. 

(iii)	 The information is transmitted into cypher text to the receiver
(iv)	 Decryption: This is the process of decoding or reconverting 

cypher text to original message so that it is easily understood 
by the receiver.

(v)	 Receiver: This is a computer where the reader accesses 
the message.

Firewall: A firewall is a security software designed for preventing/
blocking unauthorised access to data and system software on a 
computer network.

Note: A firewall is a piece of software or hardware. Firewall acts 
as a protection line between your network and the external threats 
from internet or other networks.

The firewall keeps track of every file that enters or leaves the local 
network so as to detect the sources of viruses and other problems that 
might enter the network.
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9.3	 Importance of computer security
Computer security is the protection of computer systems from threat 
that can damage software, hardware, and information and from 
disruption and misdirection of the services they provide. 

The major importance of computer security is:
	࿤ protect the computer
	࿤ protect data
	࿤ protect user’s identification

This is mainly because data present in the computer can be misused 
by unauthorised intrusions. 

Purpose of computer security is to:
	࿤ keep your information on computer protected
	࿤ maintain your computer’s overall health
	࿤ help prevent viruses and malware
	࿤ help programs run more smoothly.

9.4	 Security threats
A security threat is anything that has the potential to cause serious 
harm to a computer system. Threats can lead to attacks on computer 
systems and networks. 

9.4.1	 Origins of threats
Deliberate:	 I.e. aiming at information asset, for instance spying 

and illegal processing of data. Deliberate threat is 
planned intentionally.

Accidental:	 E.g. equipment failure or software failure. This occurs 
unexpectedly.

Negligence: 	 I.e. known but neglected factors that can compromise 
network safety. Negligence comes from paying less 
attention on a serious issue at hand.

Environmental: 	I.e. natural event and loss of power supply. This is 
generated by nature or condition of service.
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9.4.2	 Threats can be classified into two main categories
Intended threats:	 Include people within the organisation. This is the 

most dangerous threat.

External threat:	 Include people outside the organisation such as 
thieves, hackers.

The following are the threats in general that commonly affect 
systems:

	࿤ Physical damage such as fire, water, and pollution.
	࿤ Natural disasters such as volcanic eruptions, climatic changes.
	࿤ Loss of essential services such as electrical power, air conditioning 

and telecommunication.
	࿤ Compromise of information e.g. hacking, theft of media.
	࿤ Technical failures; equipment, software or capacity saturation.
	࿤ Compromise of functions i.e. error in use, abuse of rights and denial 

of actions.

9.4.3	 Computer networks attacks
	࿤ Computer Viruses: Viruses are malicious programs that can corrupt 

your data on hard disk, delete most important operating system 
files, slow your computer operations and can make the system to 
crash. Viruses can also allow hackers to run programs on your 
computer or allow access to your files. 

	࿤ Spyware: A big threat to online computers. Spyware is a software 
code installed on a computer without user’s knowledge to monitor 
or supervise user activities. 

Spyware can do the following: 
	· Gather personal information and can transmit it without your 

knowledge.
	· Change computer settings.
	· Corrupt windows Registry files.
	· Slow down internet connection speeds and the machine itself.
	· Steal your privacy.
	· Take up memory and space on your computer.
	· Can make a computer to malfunction or totally crash.

	࿤ Trojan horse (or Trojan): This is malware (malicious software) that 
is disguised as legitimate software.  In computing, a Trojan is any 
malicious computer program which misrepresents itself as useful, 
routine, or interesting in order to persuade a victim to install it on 
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computer. Trojans do not replicate themselves and appear harmless 
but in fact malicious.

	࿤ Social Engineering: This is a method used by hackers to gain 
access to computer systems by exploiting human behaviour.
In computer networking and security; social engineering is a 
collection of methods used to trick internal computer users to 
carry out specific actions or revealing confidential information thus 
breaking normal security procedures. 

	࿤ Identity Theft: This occurs when personal information is obtained 
by unauthorised individuals who then use the information to 
commit a crime such as fraud or theft.
Everyone is at risk of identity theft. Therefore, be careful managers 
of personal information, identification, and passphrases to help 
minimise your risk.

Risk involved with identity theft include: victims have to spend 
time and money cleaning up their personal and financial records. 
They may be refused loans, housing or cars, or even get arrested 
for crimes they didn’t commit.

	࿤ Sabotage by employees: Sabotage is malicious damage done 
usually by annoyed employees. An employee can intentionally enter 
data incorrectly, destroy hardware or delete sensitive data, changing 
known passwords and disappearing with customer information. 
The major solution is to regularly monitor employees’ activities and 
limit their access to certain sensitive systems or resources.

	࿤ Denial of Services Attack (DoSA): This is a method used by hackers 
to send too many requests to a specific server thereby using all 
available resources. This leads the server to become unavailable 
for internet users or crash down. 
Unauthorised access by intruders or hackers.

Activity 9.2

1.	 Explain the difference between a spyware and a spam. Identify 
risks involved when your computer is infected with spyware.

2.	 Explain the term ‘social engineering’ in regard to computer 
security threats. 

3.	 Explain the term ‘identify theft’. Identify the risks involved with 
identity theft.
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4.	 Describe the concept of firewall as a security solution to network 
threats.

5.	 Explain the difference between encryption and decryption. 
6.	 Identify the kind of information that should be encrypted in your 

school.

Practical
7.	 Start your computer and open a folder where you frequently 

save your files. Do the following tasks:
(i)	 Make two of your files as Read-only files (this will prevent 

other users from modifying contents).
(ii)	 Hide two of your files such that other users do not see 

them even when they open that folder. 
(iii)	 Encrypt any two of your important files.
(iv)	 Unhide the hidden file(s).

To make a file a Read-Only
Step 1:	 Open the folder where you often save your files such as My 

Documents folder.

Step 2:	 Right-click on a file (s) and in the shortcut menu select 
Properties (See picture 9.2)

Step 3:	 In the File Properties dialog box that displays, check Read-
Only Attribute. (See picture 9.3)

Step 4:	 Click on Apply and close the dialog box.
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Click Properties (3)

A file right-clicked (2)

Picture 9.2: A file in Documents folder is right-clicked

Click Advanced to 
encrypt your file

Check this box to hide 
your file

Check this box to make 
the file a Read-only

File location and  
file size

File type and file 
extension- pptx

File name

Picture 9.3: Properties for Nature-protect file
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To hide a file
Step 1:	 Open a folder where your files are stored such as My 

Documents folder.

Step 2:	 Right-click on a file (s) and in the shortcut menu select 
Properties (See picture 9.2)

Step 3:	 In the File Properties dialog box that displays, check Hidden 
Attribute. (See picture 9.3)

Step 4:	 Click on Apply and close the dialog box.

To encrypt a file or folder
Step 1:	 Open a folder where your files are stored such as My 

Documents folder.

Step 2:	 Right-click on the file (s) and in the shortcut menu select 
Properties (See picture 9.2)

Step 3:	 In the File Properties dialog box that displays, click Advanced 
Attribute. (See picture 9.3)

Step 4:	 In the Advanced Attributes dialog box that displays, check 
box for “Encrypt contents to secure data” and then click 
OK.	

Click OK to 
apply changes

Check this 
box to encrypt 

folder/file 
contents

Picture 9.4:  The Advanced Attributes dialog box

Step 4:	 Click on Apply and close the dialog box.
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To unhide hidden file(s)
Step 1:	 Open Control Panel window and display the contents as 

small or large icons

Click on File Explorer 
Options (2)

Click View by 
Large icons 
(or Small 
icons (1)

Picture 9.5: Control Panel Window

Step 2:	 Click on File Explorer Options (See picture 9.5 above).

Step 3:	 In the File Explorer Options dialog box that displays, click on 
View tab. See picture 9.6.
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Step 4:	 Select “Show hidden file, folders and drives”

Click Apply to 
make changes

Check circle for “Show 
hidden….” (2)

Click View (1)

Picture 9.6: File Explorer Options dialog box

9.5	 Security procedures

9.5.1	 Protect physical equipment
	࿤ To protect physical equipment against fire and burglary, put in place 

fire extinguishers against fire, use metallic doors and windows with 
strong padlocks against theft. Security cameras and burglar alarms  
and security guards are used to detect theft.

	࿤ Use UPS (Uninterruptible Power Supply) to protect system failure 
and data loss due to the power failure. A UPS is a power backup 
device. UPS keeps power for about 15 minutes after power loss.

	࿤ Use power surge protector to protect your computer against voltage 
spikes that can harm your system.

9.5.2	 Protect data
Protection of data is aimed at safe gaurding data against loss, damage 
and theft. The procedures include;
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a)	 Data backups
You risk losing your data that could have taken you a lot of time to 
gather if you do not back it up. Your files could disappear due to 
virus, crash, accidental keystroke, theft or disaster. To backup is to 
create a second copy of your important data/files somewhere other 
than your computer’s hard drive.

To be sure and secure, that your data is protected, do the following:

	· Create a duplicate copy of your critical data.
	· Backup critical and essential files on a daily basis.
	· Backup and non-critical files on a weekly or monthly basis. You 

can back up your data to a CD or DVD, to an online backup 
service (for a small monthly fee), flash drive or to a server. 

	· Store your backup media (CD/DVD, external hard disk and 
backup server) in a safe, secure place away from your computer, 
in case of fire or theft.

	· Periodically, test the capability to restore from the backup 
media. An unreadable backup is not worth keeping. To ensure 
that your backup files are reliable, simply upload the files to 
your computer.

b)	 Regularly update antivirus software.
c)	 Scan your computer data and programs regularly.
d)	 Update your operating system regularly with the latest security 

patches and service packs.
e)	 Have a strong password and change it frequently.
f)	 Install and configure a firewall.
g)	 Don’t download information from the insecure websites.
h)	 Don’t open email attachments from unknown sources. 
i)	 Scan every external disk memory attached to your computer to 

protect from malware.
j)	 Scan all shareware and freeware before installing them on your 

computer.
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Activity 9.3

1.	 Describe security risks to computers in your school computer 
laboratory. Suggest solutions that can be used to protect school 
computers and information stored therein.

2.	 Discuss the concept of ‘backup’ in regard to security procedures 
on computer.

3.	 Explain security procedures that can be used to protect physical 
equipment of computers.

Practical Numbers
4.	 Create a backup of all your important files existing on the 

computer to a Flash disk or a DVD. (Simply save the files on 
the disk and keep this disk in a safe place for future use).

Note: In case school computers are serviced, all the 
files and programs may be deleted, so backing your 
files can help store your files safely for longer periods 
without getting lost.

5.	 a)	 Start your computer and then use Administrator Account 
to create a User Account with a strong password (8 
characters and above).

b)	 Exchange computers with a friend. Give your password to 
that friend to allow him use your account for 10 minutes. 
Return back to your computer and log on by typing 
your password. Change your password to become even 
stronger (12 characters and above).

Note: Each time you are prompted to give someone your 
password, make sure when you return to the computer you 
change it immediately. 

6.	 Collect all rubbish and papers (as heap) from your class and 
place them in a particular location outside the computer lab.  
Light fire on the rubbish and papers. Quickly pick the Fire 
Extinguishers to extinguish that fire and avoid its spread.

Note: Ensure you learn properly how to use a fire 
extinguisher so that in case of fire outbreak on Network 
devices, you can contain it. 
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7.	 Disconnect your UPS from the computer. Connect your computer 
directly to power source such as Power socket. Start your 
computer and begin working by typing a brief background about 
your school. One learner shall switch the main power source 
without your consent. When you switch back your computer, 
determine how much data you have lost without using a UPS.

8.	 Download Nero burning software and attempt to install it using 
your limited account.

Note: If you don’t have administration password, you 
cannot install programs.

9.6	 Basic security precautions
Security precautions are guidelines you need to follow in order to 
use a system when you are protected on a network. You need these 
guidelines on both wireless and wired network.

9.6.1	 Wireless networks
A wireless computer network can be protected from the internal and 
external security threats by implementing the following techniques:

	࿤ Control access rights. Unauthorised access must be stopped 
immediately.

	࿤ Don’t expose your SSID server password for your wireless network 
or login password to wired network.

	࿤ Encrypt your Wi-Fi network. 
	࿤ Use encryption method i.e. converting data into unreadable format 

during transmission using an encryption algorithm and encryption 
key.

	࿤ Disconnect your PC from the network when you are not using it. 
	࿤ Enable firewall and the antivirus software on each computer.

9.6.2	 Wired networks
The following techniques are necessary to protect wired networks:

	࿤ Control direct physical access to network devices and avoid 
unauthorised access.

	࿤ Use strong passwords that must be regularly changed.
	࿤ Disconnect your PC from the network when it is not in use.
	࿤ Use hardware firewall for access to external network and internet.
	࿤ Secure loose cables.
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End of Unit 9 Assessment

1.	 Describe the kind of data security that can be implemented on 
a wireless computer network.

2.	 Explain how you can protect computer information in relation 
to data backups.

3.	 Explain the meaning of the following terms:
a)	 Denial of Service Attack
b)	 Trojan horse
c)	 Hacking

4.	 Describe solutions designed for the following Network attacks:
a)	 Spam
b)	 Sabotage by annoyed employees
c)	 Spyware
d)	 Denial of service

5.	 Your teacher has instructed you to clean your computer 
laboratory, describe the precaution you should undertake to;
a)	 protect computers and network devices
b)	 protect other users (fellow learners)

Practical Numbers
6.	 a)	 Backup all your important files on your computer to a 

flash drive.
b)	 Delete all files on the computer that you have backed. 

Perform the process to restore these important files on 
the computer.

Follow the procedure below 
a)	 Steps to set up your backup on the computer

Step 1:	 Click Start button, Select Settings.
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Step 2:	 Click Update & Security (See picture 9.7 below)

Click Update & security

Picture 9.7: Settings options

Step 3:	 In the Update & Security screen that appears, select 
Backup tab on the left and then click Add a drive on 
the right. (see picture 9.8 below). In the screen that 
displays, select an external drive or network location 
for your backups. 

Click Backup (1)

Click Add a  
drive (2)

Click More options  
to select which files  

to backup and  
how often

Picture 9.8: Update & Security settings
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Note: Determine which files to backup and how often to 
backups happen click More Options

Click Back up now

You can change options to 
your current preferences

Picture 9.9: Back options

b)	 Steps for Restoring your files
Step 1:	 Type Restore files in the search box on the taskbar, 

and then select Restore your files with File History.
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Picture 9.10: The search word on the Search box on Start

Step 2:	 Look for the file (or folder) you need, then use the 
arrows to see all its versions.

Note: You must connect the Restore source or backup 
device.

Step 3:	 When you find the version you want, select Restore to 
save it in its original location. To save it in a different 
place, press and hold (or right-click) Restore, select 
Restore to, and then choose a new location. 
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Select the 
required  

file(s)  
or  

folder (1)

Restore to original location (2)

Picture 9.11: Home-File History

7.	 a)	 Start your computer and update your antivirus.
b)	 Carryout a complete scan (to scan all drives and devices 

attached to your computer).
8.	 Download Windows Updates and install them on your computer.
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Unit
10

Platform Game Programming

Key unit competence

To be able to use complex expressions, operators and controls to 
design platforms. 

10.1	Concepts of platform and its usage
A platform sprite is an immobile sprite usually a stage background and 
can interact with other sprites on stage. Most platforms are located at 
the bottom of the stage and appear as either ground, wall, grass field, 
brick pavement, etc. A game where there is no platform, the player 
cannot jump, swing, or bounce; the actions that are characteristics of 
a game.

The platform sprite is the avatar controlled by the player.  Its appearance 
can affect gameplay slightly, depending on the angles and size of its 
costume(s).

An avatar is usually a picture representing a particular person or 
something in a game or forum.

10.1.1	Create platform sprites
Before you create a platform sprite, you must know what type of the 
game you want the platform to work for, the level of the game, etc. 
Learn more about creating platform sprites in section 10.2.
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10.1.2	Interact with platform sprites
Two or more sprites may interact with each other when they touch 
each other, or touches certain specified colours, moves in certain 
direction, etc. The scratch player can interact with platform depending 
on the type of game and sprites therein designed. Most platforms are 
designed immobile, the main sprite-player must be given commands 
that limits or allows movements and in any form of interaction. 

The scratch window below is showing two sprites. One is Lion and 
another is a parrot. Whenever the lion touches the parrot, the parrot 
runs away. The accompanying sprites are given below. Try using these 
scripts and see how sprites interact. Assume all the white space 
(background) is your area of interaction.

Activity 10.1 (a)

(i)	 Introduce the two sprites as shown in the screen below. You 
can use paint to draw them or at this stage just import them 
into scratch. For more information on how to use scratch paint 
tools, see Activity 10.1 (b).

Picture 10.1: Scratch window showing two sprites introduced from Scratch 
library
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(ii)	 Place these scripts in the scripts area for the lion and for the 
parrot and watch how these sprites interact.

Block 1: Scripts that move the lion Block 2: Scripts that move the parrot

The way sprites interact with others and the platform is covered 
within the games we have developed in this unit.

10.1.3	 Role of platforms in scratch

In a platform, objects i.e. sprites can fall, move, slide, jump, and 
bounce. The platform acts as an area of sprite interactions. The 
platform associates those properties identified into the game in which 
one controls a character to typically move towards a given goal.

10.2	Creating a platform sprite
We need to create a platform and so we think of a game for which to 
create and a suitable platform to use. 

Activity 10.1 (b)

Create a platform sprite for a game named Hard Journey in which 
a sprite named John is to walk to the end in order to win. In this 
platform, John should find items that give him a challenge to pass 
on.
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Use the steps given below to create the platform sprite

Step 1:	 Create a platform sprite as a walk way for John using 
scratch tools. First open Scratch (I am using Scratch 2.0 
the newer software) and then click on Stage1 Backdrop. 
See picture below.

Click Backdrops (2) 
appears here after 

you click 1

Click Stage 1 
backdrop (1)

Picture 10.2: Scratch 2.0 screen at the start

10.2.1	 Pick a colour
Scratch Editor has very many colours to choose from. After you 
have clicked on 1 and 2 as shown in picture 10.2 above, you can 
then make a choice of the colour (s) you want using the mouse and 
design a needed item. See picture 10.3.
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10.2.2	 Design a needed item
Step 2:	 Use scratch Paint tools to design a needed item (platform- 

journey where John is to walk).

It’s better we use two colours. One colour (green) for 
free movement in the journey and another colour (red) 
indicating enemy.

Select 
desired 
tool to 
use (2)

Draw the platform (3)

Rename backdrop1 here (4)

Fill tool is used to fill this 
part with green colour

Pick a colour from here 
e.g. green or red (1)

C
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e 
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to
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r 
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ou
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Determine tool width here

Picture 10.3: Scratch displaying a designed platform named Terrain1in a file 
named Hard Journey

10.2.3 To edit or copy a sprite or an item
To edit a backdrop name, click on it and type a new name. See 
picture above.

To copy a backdrop, right-click on it and select duplicate.

To delete a backdrop, right-click on it and select delete.
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Picture 10.4: When Backdrop is right-clicked you get options for deleting, or 
duplicating it

To edit a sprite’s name, click on default name and type the new 
name in the name box.

To copy a sprite; right-click on the sprite; select duplicate.

To delete a sprite; right-click on the sprite; select delete.

Designing a needed item (Player)
If you had deleted the cat sprite you can now draw a new item 
(John) using scratch paint tools.

Select and duplicate 
(Stamp tool)

Erase tool 

Fill with tool 

Designed sprite 

Line tool 

Brush tool 

Rename costume1 John1

Picture 10.5: Part of scratch window showing a newly drawn sprite to interact 
with platform
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Duplicate John1 costume and then click Flip left-right. 

Do this by right clicking on the John1 costume then select duplicate. 
Afterwards click “Flip left-right” button as shown in the picture 
below.

Click on Flip left-right (2)

Select the sprite and move  
it back to its original 

position using select button 
to prevent recurring  

script (3)

Duplicate (1)

Picture 10.6: Costume2 for John is flipped left-right

10.2.4	 Build a Combo block
A combo block is a combination of scripts that can make a sprite to 
move, jump, walk, make sound, etc. and can also affect the behaviour 
of the background platform. 

Activity 10.2

Create combo blocks that will make John to appear in a specific 
position when the game starts, ready to move and jump.

Solution
To create combo blocks, you must know what each block does 
and we already have this knowledge. Now you give John-sprite the 
following scripts (combo block) to take his initial position, show up 
and get set each time the green flag is clicked.
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Block 3: Gives the sprite ability to appear in a specific location you set

To give John the ability to move forward or backward. Use the 
following scripts below.

The forever loop setup 
gravity and monitors for 
right and left arrows to 
be pressed to change 
the sprite’s horizontal 

movements.

Block 4: The sprite will be able to move left or right with move steps you set

Give John-sprite some movement limits by using the scripts below.

Note: A condition 
is a statement 
which is checked 
for a true or false 
response. In our 
game when the 
sprite checks if it’s 
touching a green 
colour, it’s checking 
a condition, using if 
blocks

Block 5: The sprite will detect colour changes as it moves and changes y 
position accordingly
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With the scripts below, John will be able to jump

Block 6: The sprite shall be able to jump

Activity 10.3

1.	 In groups, discuss how you can associate scratch tools and 
produce a planned platform. Just think of a game and look at 
the tools you may need.

2.	 Discuss the role of platforms in scratch programming language.
3.	 Modify the platform (Stage1 backdrop) we made in Activity 

10.1(b) to appear as shown in the following pictures using 
scratch paint tools.
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Picture 10.7: A modified Stage1 backdrop

4.	 Create the Stage2 backdrop and make it Terrain2 to appear as 
shown below.

Picture 10.8: Terrain 2 (Stage 2 backdrop)
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Use the following steps to create backdrop2
	· Select Stage1 Backdrop and then click on the Backdrops 

tab.
	· Right click on Terrain1 backdrop and select duplicate. This 

will create Terrain2 backdrop.
	· Make changes to the backdrop using scratch paint tools to 

appear as shown in picture 10.8.
5.	 Create stage3 backdrop to appear similar to the following as 

shown in picture 10.9 and call it Terrain3.

Picture 10.9: Stage3 backdrop

To all level backgrounds add the following scripts to enable a 
player move back to level 1 faster if it is required.

Block 7: When you press space bar at any level the background will change to 
terrain1
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10.3	Add Level of a game
You can use colours in a platform to detect the end of a level or 
determine the end using edge of a platform. You can also use an object 
which sends one back to the beginning of the level. 

The character sprite is named John. Green is the colour of the walking 
ground.  Edge has been used such that if one reaches to it; qualifies 
for next level platform.

Activity 10.4

Using the designed backdrops (platform) in Activity 10.3, add 
levels of the game enabling a player to move from one level to 
another. Create a winning costume that will produce a sound and 
a winning message at level 3.

Follow the following steps

Step 1:	 Let us add more scripts to block 4 enabling the sprite 
to move from one platform or backdrop to another. See 
block 8 below (as a result). 

With this part of combo, once 
the sprite reaches the edge 
then it switches to the next 

backdrop and it goes to x -280 
and y -180 of the next level

Block 8: Scripts can make the sprite to switch costume and move to another 
stage
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Step 2:	 In this game, RED objects are used to send the player 
back to the beginning of the level. We can now modify 
block 5 by adding in more scripts as shown below in 
block 9 below (as a result).

John’s enemy 
colour takes him 
back to beginning 

of the level

John’s colour

Block 9: If the sprite’s colour (black) is touching red colour, it goes back to the 
beginning of the level

Step 3:	 Let us add more scripts to block 6 and determine where 
the game ends. See block 10 below as a result.

Pink colour stops John 
and any other sprites 

from running

Block 10: This block not only will help John to jump but also to stop once it 
touches pink colour after 1 second
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Step 4: Create a winning costume for John sprite by giving him a 
different facial colour.

Winning 
costume

To create 
a winning 
costume 
for John, 
duplicate 
costume2 

and use Flip 
left-right 
button. 

Then select 
a colour, 
click Fill 

with colour 
button and 
click in the 

face of John-
sprite

Picture 10.10: Scratch drawing area with a winning costume sprite

Step 5:	 Let’s us add more scripts to make John produce sound 
and a winning message. See block 11 below.

Block 11: These scripts will make John-sprite (after touching pink colour) to 
change costume, produce a message and sound
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Picture 10.11: John has reached the end of Journey and has won the game

Activity 10.5

1.	 Using the Hard Journey game in the previous activity, design 
two more challenging backdrops (add 2 levels) to work for level 
4 and level 5 of the game. Let the backdrops be placed in-
between backdrop 2 and 3.

2.	 Make a variable called Jump and use it to test how John-sprite 
works with gravity while jumping. Use the following scripts.

5

-5

-2

-5

Block 12: Scripts you can use to make John jump with gravity (you free to 
modify them)
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3.	 Use appropriate scripts that could make the blue colour to hide 
John (disappear automatically) such that a player must show 
him in order to play again.

Suggested answers for Activity 5
1.	 New backdrop3 may appear as this one shown in the following 

pictures (a) and (b) but you are free to design a different one. This 
level can later be renamed Terrain3.

Rename this as Terrain 3

Terrain 3 background
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The new backdrop4 which can later be renamed Terrain4 may 
appear as this one below.

Terrain 4 background

2.	 Steps for making a variable are:
	· On the Scripts tab click Data block.
	· Click Make a Variable. In the New Variable dialog box type in 

Jump. Select “For this sprite only” and click OK. 

Type in the 
variable name

Select for this 
sprite only

Click OK

Picture 10.12: New Variable dialog box

	· The resulting blocks appear as shown in picture 10.13 from 
which you can pick what you want.
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Click Scripts (1)

Click Make a Variable (2)

Resulting blocks (3)

Picture 10.13: Scripts are containing jump variable blocks

3.	 The scripts that can make John-sprite hide when touching blue 
colour are in block 13.

	

Block 13: This block can make John-sprite in black colour to hide when touching 
blue colour.

10.4	Commands for sprite manipulations
There are a number of commands in Scratch, which you can use to 
make your game interesting. Most of the commands below have been 
used in our activities. You should learn more of what they exactly do. 
Also practice on locating them quickly when needed.
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1.	 Colour () is Touching ()?: This is a condition for checking if a 
colour (represented by first brackets) on the sprite is touching a 
specific colour (represented by the second brackets).

2.	 Repeat Unitl: This is a loop that will stop once the condition is 
true.

3.	 Change () by (): This script changes the specified variable by the 
amount.

4.	 Key () Pressed?: This is a condition for checking if the specified 
key (represented by brackets) is being pressed.

5.	 Touching ()?: This is a condition for checking if the sprite is 
touching the mouse-pointer or another sprite (represented by the 
brackets).

6.	 Touching Colour ()?: This is a condition for checking if the sprite 
is touching a specific colour represented by brackets. 

7.	 Switch Costume to ():This block changes the sprite’s costume to 
the specified one (represented by brackets). 

8.	 Switch Backdrop to (): This changes the Stage’s  costume/
backdrop to the specified one (represented by brackets).

9.	 Switch Backdrop to () and wait: This block is for stage only, it 
waits until all of the hat blocks triggered by this have completed.

10.	 Next Costume: This block changes the sprite’s costume to the 
next one in the costume list. 

11.	 Next Backdrop: This changes the Stage’s costume/backdrop to 
the next one in the costume list.

10.5	Sample controls
There are a number of controls in Scratch and some of them include 
the following:

1.	 Repeat (): This is a loop that repeats the specified amount of 
times.

2.	 Forever:  This is a loop that will never end.
3.	 If () Then: This block checks the condition so that if the condition 

is true, the blocks inside it (represented by brackets) will activate. 
4.	 If () Then, Else: This block checks the condition so that if the 

condition is true, the blocks inside the first C will activate and if 
the condition is false, the blocks inside the second C will activate.

5.	 Move () Steps: This block moves the sprite forward the amount 
of steps (represented by brackets) in the direction the sprite is 
facing. 
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6.	 Turn () Degrees (Clockwise): This block turns the sprite (clockwise) 
the specified amount (represented by brackets).  

7.	 Turn () Degrees (Counter-clockwise): This block turns the sprite 
(counter-clockwise) the specified amount (typed in brackets).

8.	 Point in Direction (): This block points the sprite in the direction 
you specify.

9.	 Point Towards (): This block points the sprite towards the mouse-
pointer or another sprite.

10.	 Go to X: () Y: (): This sprite moves the sprite to the specified X 
and Y position.

11.	 Go to (): This block moves the sprite to the mouse-pointer or 
another sprite.

12.	 Touching ()?: This is a condition for checking if the sprite is 
touching the mouse-pointer or another sprite.

13.	 Show: Shows the sprite.
14.	 Hide: Hides the sprite.
15.	 Set () to (): Sets the specified variable to the amount.
16.	 Change () by (): Changes the specified variable by the amount.
17.	 Show Variable (): Shows the variable’s Stage Monitor.
18.	 Hide Variable (): Hides the variable’s Stage Monitor.

Note: Try to use most of these block sprites in your games.
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End of Unit 10 Assessment

1.	 Use Internet facility and explore millions of scratch projects 
that other scratch users have shared. Look inside and see how 
they work and then learn from them.

Note: Since playing scratch games is fun, make sure you 
know how the codes used in those projects work and try 
them. Remix projects or borrow scripts and graphics from 
them but ensure to include credits on the projects page if 
you are to use other people’s material.

2.	 a)	 Design a platform stage (background) similar to the one 
shown below as lake waters and sky. In the waters there 
is a shark that eats small fish that you will introduce in 
the water. Name the game file as Danger shark.

Sun

Space/Sky

Water

Picture 10.14: A Water platform where fish sprites will interact from
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b)	 Introduce in a big fish (Shark) with two costumes. 
Costume1 is biting and costume2 is opening mouth. 

c)	 Apply necessary scripts to make the shark, move up, 
down, left and right in the waters so as to catch pray but 
must not move beyond waters upwards.

d)	 Introduce in 2 small (can be similar or different) fish as 
prey for the shark. Use similar scripts on each of them. 
Set score variable and time variable. Set time at 20 such 
that if it elapses, the game is over and the player just 
counts the scores achieved in that time. 

e)	 Design a platform where the game ends (Game over) and 
show its sprite commands.

f)	 Apply sound in your scripts such that each time the shark 
eats a fish it makes sounds.



353

Glossary

Ad blocking:	 This is a software technology, which allows 
for blocking ads before they are loaded by the 
web browser. That means that you are saving 
bandwidth and the page is rendered faster 
within your browser. 

Add ons:	 These are apps that Internet Explorer uses 
to interact with web content like videos and 
games. Toolbars and extensions are also types 
of add-ons. 

App: 	 A program written mainly for mobile operating 
system like iOS or Android. Apps are usually 
games, utilities, or suites. 

Application:	 A program that turns your computer into a 
specific tool, such as a word processor, photo 
editor, or browser.

Axis Title:	 This is text that identifies plotted data on x or 
y- axis.

Browser extension:	 Software that modifies the interface and/or 
behaviour of web browser e.g. add-on. 

Chart Title:	 This is text that identifies the purpose of the 
chart.

Content-control software (content filtering):

	 This is computer software designed to restrict 
or control the content a reader is authorised 
to access, especially when utilised to restrict 
material delivered over the Internet via 
the Web, e-mail, or other means e.g. ad 
blocker. 

Data point:	 This is a value in data series.

Data range:	 This is a block of cells that provides data to be 
used to create a chart/graph.
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Data series:	 This is a range of data that comprises of a bar, 
column, line or pie slice.

Data source:	 This is a named source of data usually a DBMS 
file.

Document Protection:	This is to safeguard or preserve a document 
from damage or misuse. 

Download:	 This means copying files from a remote 
computer to your computer using a modem 
or network connection. For example, you can 
download files from the web to your hard 
disk. 

Downloading:	 This is a process of transferring information 
(copying) from a remote computer to your 
computer. 

File system: 	 This is the overall arrangement in which files are 
named, stored and organised by the operating 
system, for example, Windows 8 uses NTFS 
file system. 

Gridlines:	 These are horizontal and vertical lines that help 
the reader to determine data values in a chart.

Install: 	 This is to copy a program on to your computer 
for use. E.g. you can install operating system on 
your computer and Microsoft office applications 
after and then use them do perform tasks.

Legend:	 This is a feature that connects colours and 
patterns in a chart with the data they represent. 
The legend acts as the key that explains what 
each colour or pattern in the chart means.

Open source operating system: This is an operating system that 
anybody is freely licensed to use, copy, study 
and change e.g. Linux is a Free and Open 
Source Software (FOSS); this means, anybody 
can use Linux operating system in any way 
he/she wants. The source code is openly 
shared such that people are encouraged to 
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voluntarily improve its design. Chrome OS is 
also open source. 

Photography:	 This is the method of producing procedures 
with camera. It is a profession or  hobby of 
taking photographs, developing and printing/
processing the images.

Plug-in (or Add-on) and Add-in: These are simple extensions that 
extend the usability of the program such as 
Internet Explorer or Mozilla Firefox. 

Printing:	 This is the action of producing text or graphics 
on paper or another medium by a Printing 
machine.

Source code:	 This is a computer code used by programmers 
to write a program and it is human readable.

Suite: 	 A collection of applications or utilities sold for a 
single price, and having a single or similar user 
interface. These include both application suites 
(Microsoft Office), and utility suites (Norton 
Internet Security). 

Typography:	 This is the art and craft of designing typefaces 
and organising for display.

Uploading:	 This is the process of sending or transferring 
data or programs, usually from a peripheral 
computer to a central often remote computer.

Utility: 	 A program that either protects the computer or 
makes it faster, more reliable, or easier to use.

Video game accessory: This is a piece of hardware used in conjunction 
with a video game console for playing video 
games. 




